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Part 1
Getting Started

This part of the AdminStudio 9.5 User Guide includes the following chapters:

e AdminStudio 9.5 Help Library
® Using the Process Assistant

e Using the AdminStudio Interface
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AdminStudio 9.5 Help Library

AdminStudio enables systems administrators to
enterprise environment through a structured pro

rapidly prepare error-free applications to deploy into their
cess built on application management best practices.

The AdminStudio Start Page provides quick access to AdminStudio tools, product information, recently opened

files, and InstallShield resources.

The AdminStudio user documentation contains i

nformation about the functionality and features of all of the

components of AdminStudio and is presented in the following sections:

Table 1-1 « AdminStudio Help Library
Topic
Part 1: Getting Started

Using the Process Assistant

Content

Explains how to use the Process Assistant, a procedure-based
alternative interface to the standard AdminStudio interface.

Using the AdminStudio
Interface

Describes the AdminStudio Interface, the central application for
AdminStudio. From it, you can launch the AdminStudio tools,
create workflow templates and projects, use AdminStudio
Enterprise Server tools, and connect to and create Application
Catalogs.

Part 2: Managing Users, Roles, Permissio

ns, Application Catalogs

Managing Users, Directory
Services, and User Logins

Explains how to create an account for each person that you
want to have access to AdminStudio, and how to import users
or groups of users from a directory service. Also explains how
to set up the AdminStudio account, domain account, single
sign-on, and guest account login methods.
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Table 1-1 « AdminStudio Help Library (cont.)

-

R

Topic

Managing Roles and
Permissions

Managing Application Catalog
Databases

Content

Explains how to create and edit roles to manage access to
AdminStudio functionality.

Explains how to use Application Manager to import
applications into the Application Catalog, organize them, and
set up automatic import. It also explains how to share
Application Catalog data in your enterprise.

Part 3: Repackaging and Customizing Installations

(.:

(.:

Repackaging Legacy
Installations Using the
Repackaging Wizard

Converting Legacy
Installations Using the
Repackager Interface

Converting Windows Installer
Packages to Virtual
Applications

Creating Customized Virtual
Applications

Customizing and Authoring
Installations Using
InstaliShield

Explains how to use Repackager’s Repackaging Wizard to
convert existing legacy installations into Windows Installer
(MSI) packages.

Explains how to use the Repackager interface to create and
modify Repackager project files, and how to build those files
into InstallShield Editor projects or Windows Installer
packages.

Explains how to use Repackager’s Windows Installer Converter
to create virtual applications.

Explains how to use the InstallShield Virtualization Assistants to
create customized virtual applications in the Microsoft App-V,
VMware ThinApp, and Citrix XenApp virtual application formats.

Describes how to use InstallShield Editor to create setup
packages that utilize Windows Installer technology, while
harnessing the flexibility provided by InstallScript. Also explains
how to use InstallShield to create virtual applications.

Part 4: Testing Windows Installer Packages

Customizing Installations
Using Tuner

Identifying and Resolving
Application Conflicts Using
ConflictSolver

Explains how to use Tuner to create a transform file to add to,
modify, or remove information from a Windows Installer
package.

Explains how to use ConflictSolver to identify conflicts
between Windows Installer packages before you deploy them,
and resolve the problems before they affect your end users.
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Table 1-1 « AdminStudio Help Library (cont.)

Topic

Identifying and Resolving
Package Errors Using
PackageExpert

Analyzing the Impact of
Installing Microsoft Operating
System Patches

Chapter 1: AdminStudio 9.5 Help Library

Content

Explains how to use PackageExpert to automate the operation
of specific tests and resolutions against Windows Installer
(.msi) software packages. PackageExpert can check the
integrity of your Windows Installer packages, and identify and
resolve any issues relating to Windows Vista OS deployment.

Explains how to import Microsoft application patches into the
Application Catalog and thoroughly test the impact they will
have on your environment before they are deployed.

Isolating Applications Using
Application Isolation Wizard

Ensuring Package Quality
Using QualityMonitor

Explains how to use the Application Isolation Wizard to
solve component versioning conflicts by modifying an
application so it always loads the versions of components—
such as DLLs—with which it was originally developed and
tested.

Explains how to use QualityMonitor to run a series of built-in
tests to installed Windows Installer-based products, helping to
ensure they run correctly, especially in a locked-down
environment.

Part 5: Preparing Installations for Deployment

Preparing Packages for
Distribution Using Distribution
Wizard

Distributing Packages Using
Configuration Manager Web
Console

Explains how to use the Distribution Wizard to assist you in
deploying your package (and any associated transforms) to a
network location, an FTP server, as an administrative
installation, or using any of the following distribution
technologies:

e  Altiris

e LANDesk

e ManageSoft

e Marimba

e Microsoft Configuration Manager

e Microsoft SMS

e Tivoli

e ZENworks

Explains how to use Configuration Manager Web Console,
a Web-based application, to configure package distribution
options and distribute setup packages without going to
Configuration Manager Server.
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Table 1-1 « AdminStudio Help Library (cont.)

Topic Content

=y Analyzing Installations Prior to | Explains how to use the Predeployment Test tool to
bﬁ Deployment determine if a Windows Installer .msi package will succeed or
fail when it is installed in production by finding issues with disk
space, install conditions, and conflicts with .msi packages
already installed on the system.

License-Enabling Packages Explains how to use FLEXwrap to inject software licensing
2 Using FLEXwrap technology into existing Windows Installer (.msi) packages so
' that they can track usage of the executables in those
packages.

Part 6: Using Enterprise Tools: Job Manager and Report Center

Generating and Viewing Explains how to use the Report Center to report on or view all
I.l Reports in Report Center of the information regarding the applications in your
Application Catalog from a single location.

Job Manager consuming application migration tasks, saving you time and
enabling you to enforce standardized business practices on
the packaging process.

E Automating Tasks Using Explains how to use Job Manager to automate time

E

Note ° In October 2009, Acresso Software changed its name to Flexera Software, Inc. AdminStudio 9.5 includes the
new name Flexera Software. The AdminStudio Editor features functionality from InstallShield 2010 Service Pack 1.
Because InstallShield 2010 Service Pack 1 was released prior to the name change, it still contains references to
Acresso Software. In future releases, all logos and trademarks will be Flexera Software. The current logos and
trademarks cause no issues for users of AdminStudio 9.5.

What’s New in AdminStudio 9.5

AdminStudio 9.5 includes the following new features:
e |InstallShield 2010 SP1
e \Virtualization Pack Enhancements

® Repackager Enhancements
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InstallShield 2010 SP1

AdminStudio 9.5 now includes InstallShield 2010 SP1, which offers many new features and enhancements that will
help you use the latest technologies and save time on everyday tasks. InstallShield 2010 SP1 includes the
following new features and enhancements:

Ability to Target Windows 7 and Windows Server 2008 R2 Systems
Microsoft SQL Server 2008 SP1 Support

Windows Installer 5 Support

Improved User Interface

New String Editor View

New View for Configuring Run-Time Text File Changes

New Tool for Scanning an IIS Web Site, Recording Its Settings, and Importing Those Settings into an
InstallShield Project

Ability to Add IIS Web Applications to Web Sites, Plus Other [1IS-Related Improvements
Support for InstallShield Prerequisites in InstallScript Projects

Ability to Detect the Presence of a Virtual Machine

New Support for Setting Permissions for Files, Folders, and Registry Keys

Unicode Support

Support for 64-Bit COM Extraction

New InstallShield Prerequisites

New Billboard Support in Basic MSI Projects

Expanded Billboard Support in InstallScript and InstallScript MSI Projects

Support for HTML Controls on Dialogs During InstallScript and InstallScript MSI Installations
Support for Specifying Action Progress Messages

Setup.exe Manifests Now Have Compatibility Section to Avoid Triggering Program Compatibility Assistant on
Windows 7 and Windows Server 2008 R2 Systems

Updated Visual Studio Merge Modules

Windows Installer 5 Support for Configuring New Customization Options for Windows Services, Plus Other
Service-Related Improvements

Validation for the Windows 7 Logo Program
Windows Installer 5 Support for Setting Windows Shell Properties for a Shortcut

Ability to Specify a Custom .png Shortcut Icon for the Start Screen on Windows Mobile 6.5 Professional-
Powered Devices

Windows Installer 5 Support for the MsiPrint and MsiLaunchApp Control Events
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e Windows Installer 4.5 Prerequisites for Windows Vista Systems

e Dependency Scanning and COM Extraction Now Exclude Protected Windows 7 Files and Registry Entries

Ability to Target Windows 7 and Windows Server 2008 R2 Systems

InstallShield now enables you to specify that your installation requires Windows 7 or Windows Server 2008 R2. It
also lets you build feature and component conditions for these operating systems.

Microsoft SQL Server 2008 SP1 Support

InstallShield now includes support for running SQL script on SQL Server 2008 SP1. In addition, InstallShield
includes SQL Server 2008 SP1 in the predefined list of database servers that you can select when you are
specifying in the SQL Scripts view the target database servers that your product supports.

Windows Installer 5 Support

Windows Installer 5 is available with the releases of Windows 7 and Windows Server 2008 R2. With InstallShield
2010’s own implementation of Windows Installer 5 features, you can take advantage of the new Windows Installer
5 functionality, including:

e Support for Per-User Installations—The General Information view has a new Show Per-User Option
setting. This setting lets you specify whether you want the ReadyTolnstall dialog—in certain scenarios—to
include buttons that let end users indicate how they want to install the product: for the current user or for all
users. The per-user button sets the new Windows Installer property MSIINSTALLPERUSER equal to 1 to
indicate that the package should be installed for the current user.

e Support for Reducing the Time for Installing Large Packages—Use the new Fast Install setting in the
General Information view to select one or more options that may help reduce the time that is required to install
a large Windows Installer package. For example, you can specify that you do not want a system restore point
to be saved for your installation. You can also specify that you want the installation to perform file costing, but
not any other costing. This setting configures the new Windows Installer property MSIFASTINSTALL, which
can be set at the command line.

e Support for Additional Windows Installer Features—The Director Editor in InstallShield includes support
for the new Windows Installer 5 tables (MsiLockPermissionEx, MsiServiceConfig,
MsiServiceConfigFailureActions, and MsiShortcutProperty).

Improved User Interface

InstallShield user interface enhancements include new toolbars and views, customizable grids, and dynamic
search tools. Highlights include:

e Direct Editor view—When you select a table in this view, a new toolbar is displayed. The toolbar has buttons
that let you add, cut, copy, paste, find, and replace data in the table. This view also has support for dynamic
searches—as you are typing a string in the search box, InstallShield hides all of the table records that do not
contain it. When you are adding or editing a record, InstallShield displays help text for each field.

e Property Manager view—This view contains a new toolbar that has buttons for performing tasks such as
adding and deleting properties. This view also has support for dynamic searches—as you are typing a string
in the search box, InstallShield hides all of the table records that do not contain it. The top of the view has a
new group box area; you can drag and drop column headings onto this area to organize the rows in the view
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in a hierarchical format. You can now select multiple properties in this view (by using the mouse and the SHIFT
or CTRL button) and then delete them all at once.

o Redistributables view—The new toolbar and the new group box area in this view provide robust search and
organizational functionality. You can drag and drop column headings onto the group box area to organize the
list of redistributables in a hierarchical format. In addition, you can type a string in the toolbar’s search box,
and InstallShield hides all of the redistributables that do not contain it.

e Internet Information Services view—This view has been redesigned to look similar to IIS 7: the settings
are now displayed in grids, instead of on tabs. The grids have buttons that let you sort the grid settings by
category or alphabetically. When you select a setting in one of the grids in this view, InstallShield displays help
information for that setting in the lower-right pane.

e General Information view—All of the settings in this view are displayed in one grid, instead of as separate
grids that are associated with nodes within this view. The settings are grouped into several categories to make
it easy to find a particular setting. In addition, the grid has a button that lets you sort the grid settings by
category or alphabetically. The string tables that were previously in this view have been moved to a new
String Editor view.

o Path Variables view—This view contains a new toolbar that has buttons for performing tasks such as adding
and deleting path variables. This view also has support for dynamic searches—as you are typing a string in
the search box, InstallShield hides all of the rows that do not contain it. The top of the view has a new group
box area; you can drag and drop column headings onto this area to organize the rows in the view in a
hierarchical format.

New String Editor View

InstallShield has a new String Editor view. This view contains a spreadsheetlike table that shows the collection of
language-independent identifiers and corresponding language-specific values for your project. In the String Editor
view, you have complete and centralized control over the localizable text strings that are displayed at run time
during the installation process. The view replaces the string tables that were previously available as nodes within
the General Information view.

New View for Configuring Run-Time Text File Changes

InstallShield has a new Text File Changes view, which enables you to configure search-and-replace behavior for
content in text files—for example, . txt, .htm, .xm1, .config, .ini, and .sql files—that you want to modify at run
time on the target system. The text files can be part of your installation, or they can be files that are already present
on target systems.

You can use Windows Installer properties to specify the names of the text files that you want to include in or
exclude from your search. You can also use properties to specify the search strings and the replacement
strings.This enables you to use data that end users enter in dialogs, or other configuration information that is
determined at run time, when your product’s text files are modified on the target system. For example, if your
project includes a dialog in which end users must specify an IP address, your installation can search a set of files
for a token, and replace it with the IP address that end users enter.
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New Tool for Scanning an IIS Web Site, Recording Its Settings, and Importing Those Settings into
an InstallShield Project

InstallShield includes an IIS scanner (IISscan.exe), a new command-line tool for scanning an existing IS Web site
and recording IS data about the Web site. The IIS scanner creates an XML file that contains all of the settings for
the Web site, its virtual directories, its applications, and its application pools. You can use the XML file to import the
IIS data into the Internet Information Services view in InstallShield. Once you have imported the IIS data into a
project, you can use the Internet Information Services view to make changes to the IIS settings as needed.

Ability to Add 1IS Web Applications to Web Sites, Plus Other 11S-Related Improvements

InstallShield now lets you add IIS Web applications to Web sites. You can do so by right-clicking a Web site in the
Internet Information Services view and clicking New Application. Once you have added a new application, you can
configure its settings in the right pane.

InstallShield also lets you create a virtual directory without an application. Previously whenever you created a
virtual directory, an application was also created automatically.

In addition, InstallShield has new IIS settings:

e Managed Pipeline Mode—This setting enables you to specify the appropriate request-processing pipeline
mode—either integrated or classic—for an application pool.

e Enable 32-Bit Applications—This setting lets you specify whether you want to allow 32-bit applications in
the selected application pool to be run on 64-bit systems.

o _NET Framework Version—This setting is where you specify the version of the .NET Framework that an
application pool should load.

e ASP.NET Platform—If your installation may be run on a 64-bit version of Windows with the .NET Framework,
use this setting to specify which ASPNET platform should be used to map a Web site, application, or virtual
directory to the ASPNET version.

Support for InstallShield Prerequisites in InstallScript Projects

InstallShield now enables you to add InstallShield prerequisites to InstallScript projects. Previously, only Basic MSI
and InstallScript MSI projects included support for this type of redistributable.

InstallShield prerequisites are redistributables that usually install a product or technology framework that is
required by your product. Now you can add any of the InstallShield prerequisites that are provided with
InstallShield—or any of your own custom-designed InstallShield prerequisites—to InstallScript projects. If you work
on a mix of different project types, InstallShield lets you simplify your testing matrix by enabling you to reuse this
type of redistributable in all of your Basic MSI, InstallScript, and InstallScript MSI projects.

Ability to Detect the Presence of a Virtual Machine

InstallShield lets you determine whether an installation is running on any of the following types of virtual machines:
e  Microsoft Hyper-V

e A VMware product such as VMware Player, VMware Workstation, or VMware Server

e Microsoft Virtual PC
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Two new Windows Installer properties are available when you add an MSI DLL custom action to your project to
detect virtual machines: IS_VM_DETECTED and IS_VM_TYPE. The custom action should be configured to call
the ISDetectVM function in the SetAl1Users.d11 file, which is installed with InstallShield.

In addition, the InstallScript language has been expanded to support the detection. The structure SYSINFO contains
a new bIsVirtualMachine member, and a new VIRTUAL_MACHINE_TYPE constant is available for use with the
InstallScript function GetSysteminfo.

New Support for Setting Permissions for Files, Folders, and Registry Keys

InstallShield offers two new ways to secure files, folders, and registry keys for end users who run your product in a
locked-down environment:

e Custom InstallShield handling—In Windows Installer-based projects, you can choose to use custom
support for setting permissions at run time. With this option, InstallShield stores permission information for
your product in the custom ISLockPermissions table of the .msi database. InstallShield also adds custom
actions to your project to set the permissions.

e SetObjectPermissions, an InstallScript Function—You can use the new SetObjectPermissions
function in InstallScript events and InstallScript custom actions to set permissions at run time.

With the custom InstallShield handling option, the file, folder, or registry key for which you are setting permissions
must be installed as part of your installation. With the SetObjectPermissions function, the file, folder, or registry
key can be installed as part of your installation, or it can be already present on the target system.

Previously, the only option that InstallShield offered for setting permissions was to use the traditional Windows
Installer handling. With this option, the permission information is stored in the LockPermissions table of the .msi
database. The new custom InstallShield handling option and the SetObjectPermissions function offer several
advantages over the traditional Windows Installer handling:

e The custom option and the SetObjectPermissions function include support for many well-known security
identifiers (SIDs) that are not supported by the traditional Windows Installer handling option.

e The custom option and the SetObjectPermissions function support the use of localized user names for the
supported SIDs, unlike the traditional option. With the traditional option, if you try to use a localized name to
set permissions on a non-English system, the installation may fail.

e The custom option and the SetObjectPermissions function let you specify that you want to deny a user or
group from having the permissions that you are specifying. The traditional handling does not allow you to do
this.

e The custom option and the SetObjectPermissions function let you add permissions to a file, folder, or
registry key that already exists on the target system, without deleting any existing permissions for that object.
With the traditional handling, the existing permissions are deleted.

® The custom option and the SetObjectPermissions function let you configure permissions for a folder (or a
registry key), and indicate whether you want the permissions to be applied to all of the folder’s subfolders and
files (or the registry key’s subkeys). With the traditional handling, if you want to configure permissions for a
subfolder or afile in a folder (or a subkey under a registry key), the parent that is created on the target system
automatically inherits the permissions of its child.
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e The custom option and the SetObjectPermissions function let you configure permissions for a new user that
is being created during the installation. The traditional handling does not allow you to do this; the user must
already exist on the target system at run time.

The General Information view has a new Locked-Down Permissions setting that lets you specify whether you
want to use the new custom InstallShield handling or the traditional Windows Installer handling for all new
permissions that you set for files, folders, and registry keys in your project. If you have already configured some
permissions in your project and then you change the value of this setting, InstallShield lets you specify whether you
want to use the alternate handling method for those already-existing permissions. In all new projects, the default
value for this setting is the custom InstallShield handling option. If you upgrade a project from InstallShield 2009 or
earlier to InstallShield 2010, the traditional Windows Installer handling option is the default value of this setting.

Unicode Support

Windows Installer databases can now be built in a Unicode format, InstallShield projects are now stored in a
Unicode format, and the InstallShield interface now supports entering and viewing Unicode characters from
multiple character sets at the same time.

Support for 64-Bit COM Extraction

InstallShield now supports 64-bit COM extraction. If you are using InstallShield on a 64-bit operating system,
InstallShield can extract COM data from a 64-bit COM server. In order to install the data to the correct locations, the
component must be marked as 64 bit.

New InstallShield Prerequisites

InstallShield includes a number of new InstallShield prerequisites that you can add to your projects. New
InstallShield prerequisites include:

e Windows Installer 4.5 (with Microsotft fix), 3.1, 3.0, and 2.0

e .NET Framework 3.0 SP1 and 2.0 SP2

® Internet Explorer 8

e Microsoft SQL Server 2008 Express SP1 and 2005 Express SP3
® Microsoft Visual C++ 2005 SP1

® Oracle 11g Instant Client 11.1.0.7

e Crystal Reports Basic for Visual Studio 2008

New Billboard Support in Basic MSI Projects

Basic MSI projects now include support for billboards. You can add billboards to your projects to display
information to end users during the installation process. The billboards can be used to communicate, advertise,
educate, and entertain end users. For example, billboards can present overviews on new features of the product
being installed or other products from your company. Each billboard is a file that you or your company’s graphics
department creates for complete control over the look and feel of the file transfer.

Following are some of the highlights regarding billboard support in Basic MSI projects:

e You can add an Adobe Flash application file (.swf) as a billboard in your project.
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e Flash application files can consist of videos, movies, sounds, interactive interfaces, games, text, and more—
anything that is supported by the .swf type of file.

e InstallShield lets you use .bmp, .gif, .jpg, and .jpeg files as billboards.

e |[nstallShield includes a Billboard Type setting that lets you specify which style of billboard you want to use in
your installation. For example, with one style, the installation displays a full-screen background, with billboards
in the foreground, and a small progress box in the lower-right corner of the screen. With another style, the
installation displays a standard-size dialog that shows the billboards. The bottom of this dialog shows the
progress bar.

e InstallShield lets you preview a billboard to see how it would be displayed at run time, without requiring you to
build and run a release. Previewing a billboard lets you see how your billboard will look with the background
color, position, and related settings that are currently configured for your billboard.

e The Billboards view in InstallShield is where you add billboard files, configure billboard-related settings, and
preview billboards.

Previously, only InstallScript and InstallScript MSI projects included support for billboards.

Expanded Billboard Support in InstallScript and InstallScript MSI Projects

InstallScript and InstallScript MSI projects now let you use .gif, .jpg, and . jpeg files as billboards. Previously, only
.bmp files were supported. Use the Support Files/Billboards view to add billboards to your project.

Support for HTML Controls on Dialogs During InstallScript and InstallScript MSI Installations

InstallShield includes support for HTML controls on dialogs in InstallScript and InstallScript MSI projects. HTML
controls enable you to use HTML markup for dialog controls.

You can include on dialogs links to Web pages, installed HTML files, and HTML support files. If an end user clicks
the hyperlink on the run-time dialog, you can have the HTML page open in an Internet browser, or you can trigger
other behavior that you have defined through your InstallScript code.

The HTML control lets you use any valid HTML markup, including styles to control their appearance.

Support for Specifying Action Progress Messages

To keep end users informed, installations commonly display text on the progress dialog to describe the
installation’s current activity. This usually accompanies the progress bar as a means of installation status. As each
standard action and custom action is encountered, a message about the action is displayed on the progress
dialog. This may be especially useful for actions that take a long time to execute. The same action text is also
written to the installation’s log file if one is created.

The Custom Actions and Sequences view has a new Action Text area that lets you specify action descriptions and
details.

Setup.exe Manifests Now Have Compatibility Section to Avoid Triggering Program Compatibility
Assistant on Windows 7 and Windows Server 2008 R2 Systems

If you configure your InstallShield project to create a setup launcher for your installation, the manifest that
InstallShield creates for the setup launcher now includes a compatibility section. Previously, without this
compatibility section, a Program Compatibility Assistant (PCA) dialog box may have appeared at the end of an
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installation on Windows 7 and Windows Server 2008 R2 systems. The PCA dialog box indicated that the program
might not have installed correctly. This dialog box was displayed if the installation did not create the application
uninstallation key. This may happen if the end user cancels the installation or the installation fails to complete
successfully.

Updated Visual Studio Merge Modules

InstallShield includes updated versions of the Visual Studio 2008 SP1, Visual Studio 2005 SP1, and Visual Studio
.NET 2003 SP1 merge modules that are installed in Instali1Shield Program Files Folder\Modules\1i386 by
default. The updates include changes that were made for Microsoft Security Bulletin MS09-035 (Vulnerabilities in
Visual Studio Active Template Library Could Allow Remote Code Execution (969706)).

Windows Installer 5 Support for Configuring New Customization Options for Windows Services,
Plus Other Service-Related Improvements

InstallShield now includes support for configuring extended customization options for Windows services. The
customization options include a new delayed auto-start capability to help system startup performance, improved
failure detection and recovery options to improve system reliability, and more. Windows Installer 5 supports these
new options; earlier versions of Windows Installer ignore them.

To configure the new service-related settings, use the new Services node in the Advanced Settings area for a
component in the Setup Design view (in installation projects) or the Components view. All of the services for a
component are now grouped and listed by service name under the Services node. In addition, the previously
available service-related settings are now consolidated in the same grid with the new settings. In earlier versions of
InstallShield, these previously available service-related settings were split among separate subviews for the Install
NT Services and Control NT Services nodes. The consolidated grid of settings makes it easier to create a
component that installs, configures, starts, stops, or deletes a new or existing service during installation or
uninstallation.

Validation for the Windows 7 Logo Program

InstallShield includes two new validation suites: InstallShield Validation Suite for Windows 7 and InstallShield
Merge Module Validation Suite for Windows 7. These validation suites can help you verify that your Windows
Installer-based installation or merge module meets the installation requirements of the Compatible with Windows 7
logo program. If you want to be able to use the Windows 7 logo artwork, your product’s installation must meet the
program’s requirements.

If you want to configure InstallShield to perform validation with these validation suites each time that a release is
successfully built: On the Tools menu, click Options. On the Validation tab, select the appropriate check boxes.

If you want to perform validation separately from the build process: On the Build menu, point to Validation, and
then click the appropriate new suite.

Windows Installer 5 Support for Setting Windows Shell Properties for a Shortcut

The Shortcuts view in InstallShield now lets you specify one or more shortcut properties that need to be set by the
Windows Shell at run time. For example, if you do not want the Start menu entry for one of your shortcuts to be
highlighted as newly installed after end users install your product, you can set a property for that shortcut. You
might want to use this property with shortcuts that are for tools and secondary products.
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Windows Installer 5 includes support for setting Shell shortcut properties. Earlier versions of Windows Installer
ignore those properties.

Ability to Specify a Custom .png Shortcut Icon for the Start Screen on Windows Mobile 6.5
Professional-Powered Devices

If you are creating a mobile device installation for Windows Mobile-powered devices and you plan to distribute your
product through Windows Marketplace for Mobile, you need to use a 90x90 pixel Start screen icon (. png file) for
your product. Both the Windows Mobile Wizard and the Smart Device Setup Wizard in InstallShield enable you to
select the . png file that you want to use. When the shortcut is installed and displayed on Windows Mobile 6.5
Professional-powered devices, the Windows Mobile Shell scales down the shortcut’s icon as necessary,
depending on the DPI of the device.

The Shortcut Properties dialog box has a new Use a Start screen icon (.png) check box. If you want to use a
.png file, select this check box, and then click the browse button to specify the file. The Shortcut Properties dialog
box opens when you are using the Windows Mobile Wizard or the Smart Device Setup Wizard and you and you
add a new shortcut or change the properties of an existing shortcut on the Shortcuts panel.

Windows Installer 5 Support for the MsiPrint and MsiLaunchApp Control Events

When you are adding a control to a dialog in your project, you can select one of the new events that is now
available for Windows Installer 5:

e MsiPrint—You can add this event to a push button control that is on a dialog that has a scrollable text control.
When an end user clicks the push button control, the contents of the scrollable text control are printed.

e MsiLaunchApp—You can add this event to a check box control on a dialog, and select the file that you want
to be launched in the event’s Argument setting. The check box enables end users to choose whether to run
the file at the end of the installation. This event is typically used with a check box control that is on the
SetupCompleteSuccess dialog. The check box control should include a condition that prevents the control
from being displayed during uninstallation.

Windows Installer 5 includes support for these control events. Earlier versions of Windows Installer ignore these
events. Therefore, if your installation is run on a system that has Windows Installer 4.5 or earlier and you want to
use one or both of these new events, add a condition to the dialog controls so that they are not displayed on
systems that have Windows Installer 4.5 or earlier.

Windows Installer 4.5 Prerequisites for Windows Vista Systems

The conditions in the following two InstallShield prerequisites are now configured correctly: Windows Installer 4.5
for Windows Vista (x86) and Windows Installer 4.5 for Windows Vista (x64). If one of these InstallShield
prerequisites is installed on the target system during your installation, the installation no longer attempts to install it
again.
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Dependency Scanning and COM Extraction Now Exclude Protected Windows 7 Files and Registry
Entries

The Filters.xml file that is installed with InstallShield has been updated with exclusions for files and registry keys
that are protected by Windows Resource Protection (WRP) on Windows 7 systems. Therefore, if you extract COM
data from COM servers, InstallShield does not extract any registry keys that are protected by WRP for Windows 7.
In addition, if you run the dependency scanners in InstallShield, they do not list as dependencies any files that are
protected by WRP for Windows 7.

Virtualization Pack Enhancements

The Virtualization Pack Assistants include the following enhancements:
® Support for Creating App-V Package Upgrades

e Improved Batch Conversion Technology

e External Shortcut Support

® Windows Installer Wrapper Portability

e Support for Compressing App-V Packages

® Link to Build Output Folder Provided in Output Window

e Ability to Specify Global Setting to Identify Build Location

® Microsoft App-V Assistant OS Requirements List Now Includes Windows 7 and Windows Server 2008 R2
® Microsoft App-V Assistant Now Uses UTF-8 Encoding

® App-V Font Support

e App-V 64 KB Block Size

Support for Creating App-V Package Upgrades

InstallShield now has support for creating App-V package upgrades. The Package Information page in the
Microsoft App-V Assistant has a new Upgrade Settings link. Click this link to specify whether you want to create
an upgrade. If you specify that you do want to create an upgrade, you can specify additional information about the
upgrade, such as whether to append the version number to the App-V package file name. By default, App-V
package upgrades are not created.

Improved Batch Conversion Technology

AdminStudio’s App-V batch conversion technology has been enhanced to include additional Windows Installer
configurations, resulting in more Windows Installer packages being successfully converted to App-V packages.

External Shortcut Support

AdminStudio now supports external shortcuts in App-V packages, which means that the target executable no
longer needs to be included in the package. External shortcuts are especially useful for plug-ins.
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Windows Installer Wrapper Portability

A Windows Installer package can be generated as part of the App-V build output. This “wrapper MSI” can be used
to deploy the App-V package onto the App-V client. The .sft file can be included inside the wrapper or can be
located by the App-V client based on the information in the .osd and manifest files. In AdminStudio 9.5, the
wrapper MSI can now search for the . sft file in the same directory as the wrapper MSI, and, if found, it will use this
location for the . sft file when deploying the App-V package to the client. This makes the wrapper MSI more
portable, making it easy to move the wrapper MSI from one network location to another.

Support for Compressing App-V Packages

The Build Options page in the Microsoft App-V Assistant has a new setting that lets you specify whether you want
to use compression for the data files in the App-V package. If you select Yes for this setting, InstallShield uses z1ib
compression for your App-V package.

Link to Build Output Folder Provided in Output Window

When you build an App-V package, the Output window now displays a link to the build output folder for the virtual
package.

Ability to Specify Global Setting to Identify Build Location

InstallShield includes a new machine-wide setting that lets you specify an existing writable location where all virtual
packages should be built. You may want to use this global setting if you are converting .msi packages that are in a
read-only location to virtual packages.

To configure the machine-wide setting, find the Settings.xm1 file that is installed with InstallShield. In that
Settings.xm1 file, enter the path as the text content for the <Global1BuildRed1irectFolder> element, which is a child
element of the <Virtualization> element.

Microsoft App-V Assistant OS Requirements List Now Includes Windows 7 and
Windows Server 2008 R2

The Package Information page of the Microsoft App-V Assistant now includes options for targeting Windows 7 and
Windows Server 2008 R2.

Microsoft App-V Assistant Now Uses UTF-8 Encoding

InstallShield now creates the .osd, manifest, and . sprj files with UTF-8 encoding when building App-V packages;
this matches the behavior of the Microsoft Application Virtualization Sequencer. Previously, InstallShield created
these files with UTF-16 encoding, which seemed to lead to parser errors on some systems that had Cumulative
Update 1 for Microsoft Application Virtualization 4.5.

App-V Font Support

Custom fonts included in installation packages will now be supported for App-V conversions. Therefore, the fonts
will be available when running the applications (.osds) in the generated App-V packages.

App-V 64 KB Block Size

The data block size has been increased from 32K to 64K. This is consistent with Microsoft Sequencer 4.6. One of

the advantages of this change is that App-V packages will feature slightly better compression.
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Repackager Enhancements

AdminStudio Repackager 9.5 includes the following enhancements:

e Build Engine Upgrade

e Updated Repackager Exclusions List for Windows 7

e Updated Repackager Installation Monitoring Method Exclusions for Windows 7
e Enhanced Support for Capturing Side-by-Side Assemblies

e Enhanced User Folder Handling

e Enhanced International Language Support

Build Engine Upgrade

Repackager now uses the Build Engine from InstallShield 2010 SP1.

Updated Repackager Exclusions List for Windows 7

The default Repackager exclusions list has been updated for Windows 7. If you capture an application on a
Windows 7 operating system, Repackager will automatically exclude all OS files and registry entries.

Updated Repackager Installation Monitoring Method Exclusions for Windows 7

The process exclusions used by the Repackager Installation Monitoring method has been updated to include the
process exclusions for Windows Vista and Windows 7.

Enhanced Support for Capturing Side-by-Side Assemblies

Repackager now provides improved functionality when capturing side-by-side assembilies.

Enhanced User Folder Handling

In Windows 7, user data folders have been moved. Therefore, in AdminStudio 9.5, the handling of Repackager
user data has been improved to accommodate these changes.

Enhanced International Language Support

AdminStudio provides enhanced international language support:

e Enhanced repackaging on international platforms.

e Improved repackaging of international applications that use double-byte character sets.

e Management of international applications in the Application Catalog.

AdminStudio Editions

AdminStudio enables systems administrators to rapidly prepare error-free applications that deploy seamlessly into
any enterprise environment through a structured process built on application management best practices.
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To meet the needs of organization of every size, AdminStudio 9.5 is available in the following editions.

Table 1-2 « AdminStudio Editions

Edition

Standard

Professional

Description

Standard Edition provides basic repackaging and editing capabilities. Standard
Edition includes:

® Repackager

e |nstallShield Editor

e Application Isolation Wizard

e Tuner

e FLEXwrap

® Distribution Wizard

The Professional Edition is designed for professional packagers. It includes
application management, testing, and conflict resolution tools, as well as additional
distribution options.

Professional Edition includes all of the Standard Edition tools plus:
® Application Manager

e ConflictSolver

e  QualityMonitor

® Predeployment Test

e OS Snapshot Wizard

e Configuration Manager Web Console

Documentation on features that are only available in AdminStudio Professional and
Enterprise Editions includes the following note:

Edition - This feature is included with AdminStudio Professional and Enterprise Editions.
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Table 1-2 « AdminStudio Editions (cont.)

Edition Description

Enterprise The Enterprise Edition is the enterprise-class solution. It includes Web-based server
access with additional security, reporting, and automation tools. Enterprise Edition
includes all Professional Edition tools plus:

e PackageExpert

e OS Security Patch Wizard
® Security Console

e Job Manager

e Report Center

e Software Repository

Documentation on features that are only available in AdminStudio Enterprise Edition
includes the following note:

Edition - This feature is included with AdminStudio Enterprise Edition.

Virtualization Pack AdminStudio offers a Virtualization Pack that includes Microsoft App-V, VMware
ThinApp, and Citrix XenApp virtualization support. The following additional
components are available:

e |[nstallShield Microsoft App-V Assistant
e |[nstallShield ThinApp Assistant
e |[nstallShield Citrix Assistant

® Repackager Windows Installer Converter

Documentation on these features includes the following note:

Edition ° This feature is included in the AdminStudio Virtualization Pack.

Also, documentation on the Batch Convert option of Windows Installer Converter
includes the following note:

Edition * The Batch Convert option of Windows Installer Converter is only available when
purchased on the AdminStudio desktop licensing model.

E

Note * For a comprehensive list of the features available in the AdminStudio Standard, Professional, and Enterprise
Editions, plus the add-on features available for Enterprise Edition, see the AdminStudio Web site.
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Activating AdminStudio

When you launch AdminStudio or one of its tools for the first time, you are notified that you are using a time-limited
trial version, and you are given the opportunity to evaluate the product or to activate it by entering a valid Serial
Number for an AdminStudio Edition.

Task: To activate AdminStudio:
1. Install AdminStudio, as described in the AdminStudio Client Tools Installation Guide.

2. Launch AdminStudio or one of its tools. A dialog box opens, stating that you are using a time-limited trial
version.

3. Select Activate or Purchase AdminStudio and click Next. The AdminStudio Product Activation dialog
box opens, prompting you to enter a serial number.

4. Enter the serial number of the edition you purchased and click the Activate button. After a few seconds, you
will receive a message that activation was successful.

5. Click Finish. AdminStudio will launch.

E

Note - If you want to evaluate the AdminStudio Enterprise Server Web tools (Job Manager, Report Center, Security
Console), you need to obtain an Enterprise Server Evaluation Serial Number from an AdminStudio Sales
Representative.

Ports Used in Activation

AdminStudio product activation uses ports 80 (HTTP), 443 (HTTPS), and 8443. If these ports are locked down or if
you do not have an available internet connection, you can activate AdminStudio using one of the following
alternative methods:

e Self-hosted activation using FLEXnet License Server—Your organization can choose to purchase and
use a self-hosted FLEXnet License Server to manage their AdminStudio licenses. Using the FLEXnet License
Server eliminates the need to manually activate each installation of AdminStudio over the internet.

e Offline activation—You can perform offline activation using email.

AdminStudio 9.5 User Guide ADS-0950-UG00 71



Chapter 1: AdminStudio 9.5 Help Library
Evaluating AdminStudio

Silent Activation

AdminStudio supports silent activation, enabling you to use public Windows Installer properties to enter the Serial
Number automatically and activate during installation. To enable silent activation, you need to set the PRODUCTID
and ASACTSTATUS public Windows Installer properties. The following is an example of how to accomplish this via the
command line:

<AdminStudio_Install_Directory>Setup.exe /v'"PRODUCTID=XXXXXXX-XXX-XXXXXXXXXX ASACTSTATUS=1"
You can additionally make the installation completely silent by adding the /s and /qgn switches as follows:

<AdminStudio_Install_Directory>Setup.exe /s /v'"PRODUCTID=XXXXXXX-XXX-XXXXXXXXXX ASACTSTATUS=1 /gn"

E

Note ° Consult the Windows Installer Help Library for any additional Windows Installer command line options.

Evaluating AdminStudio

Task:

72

You can choose to evaluate AdminStudio for 21 days. By clicking Continue to Evaluate AdminStudio dialog box
that opens when you launch AdminStudio, you can begin evaluating the AdminStudio 9.5 Enterprise Edition client
tools. To evaluate the AdminStudio Enterprise Server Web tools, you need to contact AdminStudio Sales and
obtain an evaluation serial number.

Information about evaluating AdminStudio is presented in the following sections:
e Evaluating AdminStudio Enterprise Edition Client Tools

e  Evaluating AdminStudio’s Microsoft App-V Support

e Evaluating the Windows Installer Converter Batch Convert Option

e Evaluating the AdminStudio Enterprise Server Web Tools

E

Note -

Evaluating AdminStudio Enterprise Edition Client Tools

To evaluate the Enterprise Edition client tools, perform the following steps.

To evaluate the AdminStudio Enterprise Edition client tools:
1. Install AdminStudio, as described in the AdminStudio Client Tools Installation Guide.
2. Launch AdminStudio. A dialog box opens, stating that you are using a time-limited trial version.

3. If you want to evaluate AdminStudio, select Continue to Evaluate AdminStudio and click Next (or just wait
ten seconds). The product will launch.
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e When you run AdminStudio in this trial mode, all of its features are fully available.

e Each time you open AdminStudio while you are in evaluation mode, this dialog box shows you how many
days are left in your trial period.

4. If you have five or fewer days left in your trial period, the dialog box remains open, requiring you to click before
you can proceed. Do one of the following:

a. [f your trial period is not over, you can continue to use AdminStudio by selecting the Continue to
Evaluate AdminStudio option and clicking Next.

b. If you have already purchased a serial number or want to purchase one online, select Activate or
Purchase AdminStudio and click Next.

Evaluating AdminStudio’s Microsoft App-V Support

While evaluating the AdminStudio Enterprise Edition client tools, you will be able to convert a Windows Installer
package to an App-V application using both the Windows Installer Converter and the InstallShield App-V Assistant.
However, an App-V application built using an evaluation version of AdminStudio will display the following message
every time it is launched:

Thiz package was created with an evaluation verzion of InstallShield.

Figure 1-1: Evaluation Version Message

After purchasing the AdminStudio Virtualization Pack, you will be able to remove this message by rebuilding the
App-V application.

Evaluating the Windows Installer Converter Batch Convert Option

The Batch Convert option of Windows Installer Converter is only available when purchased on the AdminStudio
desktop licensing model.

When using an evaluation version of AdminStudio, you will be able to use the Batch Convert option to convert a
directory full of Windows Installer packages into individual virtual packages, but the batch conversion will be
limited to ten packages; only the first ten Windows Installer packages that Windows Installer Converter encounters
will be converted to virtual applications.

Evaluating the AdminStudio Enterprise Server Web Tools

If you want to evaluate the AdminStudio Enterprise Server Web tools (Job Manager, Report Center, Security
Console), you need to obtain an AdminStudio Enterprise Server Evaluation Serial Number from an AdminStudio
Sales Representative.

AdminStudio 9.5 User Guide ADS-0950-UG00 73



Chapter 1: AdminStudio 9.5 Help Library
Evaluating AdminStudio

4

Task: To evaluate the AdminStudio Enterprise Server Web tools:
1. Follow the steps in Evaluating AdminStudio Enterprise Edition Client Tools.

2. Contact an AdminStudio Sales Representative and obtain an AdminStudio Enterprise Server Evaluation Serial
Number.

3. Open the AdminStudio interface and select About AdminStudio from the Help menu.

4. Click Activate. The Upgrade and Activate dialog box opens.

AdminStudio

Upgrade and Activate 4
Auvailable AdminStudio Editions ‘ -

I vou have a valid serial number, click O to activate or upgrade vour current edition.
‘fou can view more details about each edition on the AdminStudio Web site or by clicking any of the
edition's hyperlinks.

° Enterprise Edition Enterprise-class solution; includes web-based server access with
additional security, reporting and automation,

@ Professional Edition  Designed For professional packagers; includes application management;
includes testing and conflict resolution; includes distribution options,

O Standard Edition Entry level option; basic repackaging and editing.

wehich edition is right for me?

Buy onling

[ OK H Caniel ]

5. Selectthe I have an AdminStudio Enterprise Server evaluation serial number option and click OK. The
Evaluate Enterprise Edition dialog box opens.

Evaluate AdminStudio Enterprise Server,

Enter below the serial number you obtained from the sales department ko
enable the evaluation of AdminStudio Enterprise Server,

AdminStudio Enterprise Server Evaluation Serial Mumber:

Cancel

6. Enter the serial number and click OK. You will be prompted to install the AdminStudio Enterprise Server on the
current machine.

7. Click Yes. The AdminStudio Enterprise Server installation begins.

8. Install AdminStudio Enterprise Server, as described in the AdminStudio and Workflow Manager Installation
Guide, which is available on the AdminStudio Downloads site.
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Upgrading Your Product Edition

An upgrade feature has been built-in to AdminStudio that allows you to activate features in a higher Edition without
re-installing the application. You just need to enter a Serial Number for the upgrade that you purchased, and the
features of that Edition are immediately unlocked and are available to you.

To upgrade, perform the following steps:

Task: To upgrade your AdminStudio Edition:
1. Contact an AdminStudio Sales Representative and purchase a Serial Number for the desired Edition.
Launch AdminStudio.

2
3. On the Help menu, click About AdminStudio. The About AdminStudio dialog box opens.
4. Click the Upgrade button. The Upgrade and Activate dialog box opens.

5

Click OK to upgrade your edition. The AdminStudio Product Activation dialog box opens, prompting you
to enter the serial number of the edition that you want to upgrade to.

6. Enter the serial number of the edition you purchased and click the Activate button. After a few seconds, you
will receive a message that activation was successful. The functionality of the upgraded edition is immediately
available to you.

]
Using Help
Help is available both from the AdminStudio interface Help menu and directly from certain individual interface
elements.
When you have questions about this product, first consult the AdminStudio Help Library, which is the complete

user’s guide for using AdminStudio.

Web-Based Online Help
Web-based online help is available to you 24 hours a day, seven days a week, on our Web site at:

http://helpnet.flexerasoftware.com

Documentation as PDF
AdminStudio documentation is also available as a PDF. Visit the AdminStudio Downloads site at:

http://www.flexerasoftware.com/downloads.htm

Help Conventions

In this documentation, reader alert and style conventions are used to bring your attention to specific information or
help you identify information.
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e Reader Alert Conventions

e Style Conventions

Reader Alert Conventions

Reader alerts are used throughout this documentation to notify you of both supplementary and essential
information. The following table explains the meaning of each alert.

Table 1-3 * Reader Alert Conventions

Image

Alert Name

Note

Important Note

Description

Notes are used to draw attention to pieces of information that should stand
out.

Important notes are used for information that is essential for users to read.

Caution

Tip

Best Practices

Cautions indicate that this information is critical to the success of the desired
feature or product functionality.

Tips are used to indicate helpful information that could assist you in better
utilizing the desired function or feature.

Best Practices alerts instruct you on the best way to accomplish a task.

Edition-Specific
Note

Procedure

Style Conventions

Edition-specific notes indicate that the information applies to a specific edition
of a product (such as Professional or Premier edition).

The Procedure graphic indicates that procedural instructions follow.

The following style conventions are used throughout this documentation.

Table 1-4 « Style Conventions

Style Example Description

User On the File menu, click Open. User interface elements appear in bold
Interface when referenced in tasks.

Elements

Variables fileName Variables appear in italics.
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Style Example Description

Code #define HWND_BROADCAST Oxffff Code snippets appear in a monospace
typeface.

User- Type $D(Cinstall). Text that is to be entered as a literal value

Inputted Text

is displayed in a monospace typeface, in
bold, and in blue.

File Names My files are located in the File names and directory paths are

and Directory = C:\MyDocuments\SampleCode directory. presented in a monospace typeface.

Paths

.INI File Text Insert the line LimitedUI=Y into the file to display = Text in .INI files is presented in a
only the Welcome dialog box when the monospace typeface.
Windows Installer package is run.

Command- To run the installation silently, enter: Command-line statements and

Line parameters are presented in a
Setup.exe /s /v/qgn

Statements monospace typeface.

Environment

Set the value of the windir environment

Environment variables are presented in a

Variables variable. monospace typeface.

Examples Create two groups, one called Admin and the Examples are presented in bold.
other called General.

Functions FeatureAddIltem adds a new feature to a Functions are presented in presented in
script-created feature set. bold.

Properties In the Name property, enter a name for this Properties are presented in bold.
custom control that is unique among all of the
controls in your project.

Screen If you type an incorrect parameter, the message = Screen output (from a log file or from the

Output The system cannot find the path specified. | console) is displayed in a monospace
is displayed. typeface, and in blue.

Links Obtain the latest white papers, project samples, | Links appear in blue.

Contacting

and more from:

http://www.mycompany.com/downloads.htm

Us

You may contact us from anywhere in the world by visiting our Web site at:
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http://www.flexerasoftware.com
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Using the Process Assistant

The Process Assistant is a procedure-based alternative interface to the standard AdminStudio interface that guides
you through the process of preparing a new application for enterprise use. Using the Process Assistant, you can
perform the following tasks:

® Packaging and feature customization
e Conflict resolution

o QAtesting

e Deployment hand-off

The ConflictSolver Process Assistant, which is integrated into the main Process Assistant but which can also be
opened from the ConflictSolver interface, guides you through the process of identifying and resolving conflicts
between Windows Installer packages.

Using the Process Assistant decreases the time required for new AdminStudio users to prepare software packages
for deployment, and also enables veteran systems administrators to efficiently jump start a new packaging project.
It provides assistance on what steps to perform next, based on your previous selections.

Process Assistant Pages

The Process Assistant Pages take you through the steps typically performed when preparing an application for
deployment.

Table 2-1 « Process Assistant Pages

Task Page Name Description
Home Page Select an existing non-MSI or legacy application to convert to Windows
o Installer format and launch the repackaging process.
- Package Page Select an existing non-MSI or legacy application to convert to Windows
wf Installer format and launch the repackaging process.
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Table 2-1 » Process Assistant Pages (cont.)

Task Page Name Description
r‘ Customize Page Customize your installation by directly modifying the Windows Installer

package or by creating a transform.

- Resolve Conflicts = Select the Windows Installer package you want to check for conflicts against
b‘.—# Page packages already in the Application Catalog, and launch the ConflictSolver
Process Assistant.

Test Page Test the package installation on the targeted deployment environment to
,i ensure that it works as expected.

g Distribute Page Prepare your package for distribution.

Opening the Process Assistant

To open the Process Assistant, click on the Assistant tab in the AdminStudio interface. You can also open it by
clicking the Process Assistant link on the Start Page.

Also, you can open the ConflictSolver Process Assistant from the ConflictSolver interface by selecting Process
Assistant on the View menu or by clicking the Process Assistant toolbar button:

L3

Using the Process Assistant

80

The Process Assistant is a procedure-based alternative interface to the standard AdminStudio interface. To open
the Process Assistant, click the Assistant tab in the AdminStudio interface. The Process Assistant Welcome
Page includes a packaging diagram to help you visualize the steps involved in preparing a package for
deployment.

Navigating in the Process Assistant

You move through the Process Assistant using the navigation bar at the bottom of the page:

Customee Distribute:

Conflcts

Figure 2-1: Process Assistant Navigation Bar

To navigate from one task page of the Process Assistant to another, click on buttons in the navigation bar:

e To navigate directly to a specific page, click the appropriate icon in the navigation bar at the bottom of the
page.
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e To follow the Process Assistant steps sequentially, click the Next or Back arrow buttons to move forward or

backward.

® To move back to the Home Page and view the diagram, click the Home button on the navigation bar.

List Controls

Each page in the Process Assistant contains a Help Links list control and, when applicable, a More Options list

control to assist you:

Table 2-2 « Help Links and More Options List Controls

7)) What are lockdown and runtime bests?
L7 What is M3I Dactar?

&) What are the benefits of running
deployment kesks?

% Isolate the application
[ Edit the package
‘Tgh Test using Predeployment Test,

Help Links

This list provides links to help topics pertinent
to the current Process Assistant page.

More Options

Provides additional configuration options
relating to the specific area on the Process
Assistant page. These are less common
options that complete the functionality of the
Process Assistant.

Opening the AdminStudio Interface

To open the AdminStudio interface and Tools Gallery (and hide the Process Assistant), click on the Tools tab.

Home Page

The Home Page displays a diagram outlining the major tasks that are usually performed when a package is being
prepared for deployment. On this Page, you can also select an installation program, and when you click Start, the
Process Assistant will open the Page that is most appropriate for the file selected. For example, if you select:

e Windows Installer package (*.msi)—The Customize Page opens, bypassing the Package Page, and
you are prompted to modify this package either directly or by creating a transform. Because this package is
already in Windows Installer format, the repackaging step would not be necessary.

e Setup program file (*.exe)—The Package Page opens and you are prompted to repackage this setup
program file into Windows Installer format.
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Package Page

On the Package Page, you select an existing non-MSI or legacy application to convert to Windows Installer format
and launch the repackaging process.

&

Task: To select a package for repackaging:

1.

2.

Click on the Package icon in the navigation bar. The Package Page opens.

Click Browse and select the package or application that you want to convert. Additional packaging fields
appear on the Package Page.

In the Product Information area, the Product name and Version number are automatically populated
based upon information in the selected file. Make any desired edits.

Enter any Repackaging Wizard Command-Line Options that you wish to include.
Select one of the Repackaging Methods: Install Monitoring or Snapshot.

Click Browse and select a Repackaging Wizard output directory, the directory where you want the
Repackaging Wizard to save the converted Windows Installer (.msi) package.

Click Repackage to launch the Repackaging Wizard

Customize Page

On the Customize Page, you can customize your installation by directly modifying the Windows Installer package
or by creating a transform, a file that you append to the package which will customize the file at the time of
installation.

Task: To customize an installation:

82

Click on the Customize icon in the navigation bar. The Customize Page opens.
Click Browse and select the Windows Installer package that you want to customize.

Under Customization Options, select to either modify the original Windows Installer file or to create a
transform.

If you selected the Create a transform file option, enter the name of the transform file you are creating or
click Browse to select a transform file that you are replacing.

Click Customize to begin the customization process. InstallShield Editor is launched either in Direct MST
Mode (to create a transform) or Direct Edit Mode (to modify the original .msi file).

Customize the package using InstallShield Editor.
After customization is complete, click Import on the Customize Page to import the converted package into

the Application Catalog.
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Adding Transforms to an MSI Package

When you prepare a package for distribution, you need to package the transforms with the base .msi package.
You can perform this task using InstallShield Editor or Tuner. See Customizing and Authoring Installations Using
InstallShield or Preparing Packages for Distribution Using Distribution Wizard.

You can also specify a transform at the command line:

msiexec /i “yourmsi.msi” TRANSFORMS="yourtrans.mst”

Resolve Conflicts Page

Edition * ConflictSolver is included with AdminStudio Professional and Enterprise Editions.

Although a Windows Installer package or merge module may be built to guidelines put forth by Microsoft, it is
possible that the interaction between packages, or between a package and the base operating system, may cause
unwanted results in your production environment. You perform conflict detection to identify these conflicts before
you deploy packages, and resolve the problems before they affect your end users.

On the Resolve Conflicts page, you select the Windows Installer package you want to check for conflicts against
packages already in the Application Catalog.

Task: To select a package for conflict detection:
1. Click on the Resolve Conflicts icon in the navigation bar. The Resolve Conflicts Page opens.

2. Click Browse to locate and select the package.

3. Should that package require transforms, click the New button (
dialog box and select a transform file.

i) to launch the Select Transform Files

e |[fthe package requires multiple transforms, you can repeat the procedure as necessary.

e The order in which transforms are applied can be changed by selecting a transform and clicking the
Move Up ( +|) and Move Down ( ¥|) buttons.

e Delete a transform file from the Transforms list by selecting the transform and clicking the Delete button
(x0).

4. From the ConflictSolver Operation list, select Detect conflicts for this package or Resolve conflicts for
this package.

5. Click Perform to launch conflict detection for this package.
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Importing Applications into the Application Catalog

You can import Windows Installer packages (.msi) with any associated transforms (.mst) or patches (.msp) and
merge modules (.msm) into the Application Catalog. Additionally, you can import OS snapshots (.osc), Marimba
Native Channel Packager (.ncp) files and other non-MSI based setup programs.

Once you import these files, they become available for conflict identification. Although you can identify conflicts
between an external package and packages already in ConflictSolver, it is strongly recommended you import the
package first and perform conflict identification after import. Conflict information is only persisted for the last
conflict identification performed between an external package and packages in ConflictSolver, and performance is
better when performing conflict identification between internal packages.

The Application Catalog also serves as a repository for all applications used in your organization. You can create
custom installations of a common Windows Installer package to distribute to different departments in your
organization, each installation including certain features that are appropriate for the department and excluding
certain features that are not appropriate.

Software Repository

If you are connected to an Application Catalog that has the Software Repository enabled, and you want to add the
package that you are importing to the Software Repository, select the Add package to the Software Repository
option on the Organize Package Page of the ConflictSolver Process Assistant. See About the Software
Repository for more information.

Application Conflicts

Although a Windows Installer package or merge module may be built to guidelines put forth by Microsoft, it is
possible that the interaction between packages, or between a package and the base operating system, may cause
unwanted results in your production environment. You can use ConflictSolver to identify these conflicts before you
deploy packages, and resolve the problems before they affect your end users.

ConflictSolver allows you to check for a variety of conflict types, including file, component, and registry conflicts. In
many cases, ConflictSolver can resolve the issues automatically. ConflictSolver has rules to detect conflicts
involving: Components, Files, Registry Entries, Shortcuts, INI Files, ODBC Resources, NT Services, File
Extensions, and Product Properties.

Automatic and Manual Conflict Resolution

84

Automatic Conflict Resolution

To identify conflicts between multiple installation packages, ConflictSolver uses Application Conflict Evaluators
(ACEs). Some ACE failures can be resolved automatically by ConflictSolver. These automatic resolution
techniques are defined in Conflict Application Resolution Definition (CARD) rules. ACEs that can be automatically
resolved by CARDs are referred to as Best Practice ACEs: ACE02, ACE04, ACE05, ACE06, ACEQ7, ACE15, ACE18,
ACE19, ACE20. CARDs resolve errors found by the corresponding ACE of the same number.
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You can choose to automatically resolve ACEs on the Conflicts view for the product. Select the conflict you want
to resolve and click Resolve. Alternatively, click Resolve All to resolve all resolvable conflicts for the selected
conflict category. See Resolving Best Practice ACE Errors.

Manual Conflict Resolution

Due to their complexity, some conflicts require manual resolution using Tuner or InstallShield Editor.

For information on manual solutions, consult the Application Conflict Evaluators (ACEs) topic or individual ACE
topics. These topics can provide valuable information regarding what is causing the conflict, so you can use Tuner
or InstallShield Editor to solve it.

Once you have resolved detected conflicts manually, you can re-import the package into ConflictSolver.

ConflictSolver Process Assistant

Edition * ConflictSolver is included with AdminStudio Professional and Enterprise Editions.

The ConflictSolver Process Assistant, a procedure-based alternative interface to the ConflictSolver Application
Manager interface, guides you through the process of identifying and resolving conflicts between Windows
Installer packages. The ConflictSolver Process Assistant is integrated into the main Process Assistant via the
Resolve Conflicts Page task, and can also be launched separately from the Tools Gallery.

The following standard ConflictSolver tasks are included in the ConflictSolver Process Assistant:

Table 2-3 « ConflictSolver Process Assistant Tasks

Task Description

Select a Select a current package or import a new one.
Package Page

H,
—

Extended View and edit optional attributes for packages.
Attributes Page

Validation Page Validate the package using selected Internal Consistency Evaluators (ICEs).

o Best Practices Check the selected package to see if it meets Windows Installer “best
By Page practices” rules, and then choose to resolve any best practice conflicts that are
found.

Detect Conflicts = Check the selected package against target packages to determine if conflicts
Page would occur if all of these packages were installed on the same system.

at
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Table 2-3  ConflictSolver Process Assistant Tasks

Task Description
f Resolve View all detected conflicts and choose to resolve any conflicts that have an
% Conflicts Page automatic resolution.

a2 Reporting Page Generate various types of package reports listing data about conflicts,
validation, extended attributes, files, and registry entries.

’ Organize Relocate packages within the Application Catalog.
L Package Page

Select a Package Page

Task:

86

On the Select a Package Page, you select a source package for conflict detection: the Windows Installer file you
want to check for conflicts against packages in the Application Catalog. You can choose either a package that is
already in the Application Catalog (a Current package) or a package that you want to import into the Application

Catalog prior to conflict detection (a New package). If you choose to import a package, you can also choose to
import transform files and patches along with it.

Importing a New Package

To import a new package:
1. Launch the ConflictSolver Process Assistant. The Select a Package Page opens.
2. Click Browse to locate and select the Windows Installer package.

3. Should that package require transforms, set the Would you like to include transforms? option to Yes to
enable the transform fields, and then select transform files:

e To locate and select a transform file, click the New button (:3]) .

e If the package requires multiple transforms, you can repeat the procedure as necessary.

e The order in which transforms are applied can be changed by selecting a transform and clicking the
Move Up ( +|) and Move Down ( £|) buttons.

o Delete a transform file from the Transform Files (.mst) list by selecting the transform and clicking the
Delete button ( X).

4. Should that package require patches, set the Would you like to include patch files? option to Yes to

enable the patch file fields, and then select the patch files that you want to include using the New, Move Up,
Move Down, and Delete buttons, as described above.
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5. Click Import. The package is imported into the Draft group of the Application Catalog and the Validation
Page opens.

Selecting a Current Package

Task: To select a current package:

-t
.

Launch the ConflictSolver Process Assistant. The Select a Package Page opens.

2. Select Current. The Application Catalog Group tree is displayed.

3. Expand the Group tree and select the package that you want to use as a source package in conflict detection.
4

Click Continue. The Validation Page opens.

Current and New Packages

On the Select a Package Page, you choose the package that you are going to process using the ConflictSolver
Assistant. You can choose to use either a Current or New package:

e Current—Package that has already been imported into the Application Catalog.

e New—Package that will be imported into the Draft Group of the Application Catalog, a working Group used
for packages in the process of being prepared for distribution.

After you have selected a package, you can use it in the Validation, Best Practices, Detect Conflicts, Resolve
Conflicts, Reporting, and Organize Package tasks of the ConflictSolver Assistant.
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Draft Packages

When you import a package into the Application Catalog using the ConflictSolver Process Assistant, that package
is automatically imported into a special group called Draft, a temporary working group that isolates an imported
package that has not yet been checked for conflicts from the rest of the packages in the Application Catalog. The
Draft group is only visible when you select Current on the Select a Package Page of the Process Assistant.

(%) Current
O hiews

Select a currant patkage

=) Dwafts
[ adabe ferobat 6,0 Professional v005.000,000
[ CardDesma v1,00,0000
[ pemaPlayer vi,00,0000
[ Developer Art v1.00,0000
[ Instalishield Adwirstudia ¥5.0
'Fl| Morban Ankivirus Corporate Edition +7.5.0.0
[ orea v1.50,2600,0000
[ PatkageFoeTheweh 4 v4.0.0
[ paire shop Pro 7 Anriversary Edkion w7.0.4,0000
=17 iaroLps
# 0 Accounting
# 7 Development
# 7) Marketirg
+ ) Operations

Figure 2-2: Draft Group visible on the Select a Package Page

By placing these newly imported packages into the Draft group, you are indicating that these packages are in the
process of being prepared for distribution, and should not be used as target packages in conflict detection.

After you have performed validation, conflict detection, and conflict resolution on a Draft package, and it is ready
for distribution at your organization, you should then move it out of the Draft group using the Organize Package
Page of the Process Assistant. The package will then be visible on the Application Manager View.

E

Note * While it is possible to move a package out of the Draft group before conflict detection and resolution have

been performed, it is not recommended.
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Creating a New Group

You can create a new group using the New button on the Organize Package Page of the Process Assistant.

W

Task: To create a new group:

1.

2
3.
4

If a package is not currently selected, go to the Select a Package page and select a package.
Click on the Organize Package button in the navigation bar. The Organize Package Page opens.
Click New. The New Group Properties dialog box opens.

Enter a Name, Description and any desired Comments for the new group and click OK. The new Group is
listed in the group tree and is automatically selected.

Configuring Import Options

Before importing a new package, you should review the following options on the Import tab of the ConflictSolver
Options dialog box:

Import Binary Data & Import Custom Tables—If you do not expect to run user-defined ACE rules, then
you do not need to import either binary data or custom tables.

Check for Validation Errors & Check for Conflicts—Checking packages for validation at the time of
import is often unnecessary. Also, conflict detection at the time of package importation will become an
exponentially slow operation as the size of your Application Catalog increases, since this option causes the
package to be conflict checked against all existing packages in the Application Catalog.

By deselecting these import options on the Import tab of the ConflictSolver Options dialog box, import
performance will improve.

Patch Files

AdminStudio supports the import of Windows Installer packages (.msi) with associated patches (.msp). A Windows
Installer patch (.msp file) is a file used to deliver updates to Windows Installer applications. A patch is a self-
contained package that contains all the information required to update an application.

A patch package contains the actual updates to the application and describes which versions of the application
can receive the patch. A patch package does not include a database like a regular installation package (.msi file).
Patches contain at minimum two database transforms. One transform updates the information in the installation
database of the application. The other transform adds information that the installer uses for patching files.
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Extended Attributes Page

Extended attributes are optional properties for packages that you can view and edit. Because you can manually
create the description file, you have the flexibility to include information about each package that may be specific to
your organization—such as the users or business groups that receive the package.

The attributes listed on the Extended Attributes match those defined in the Extended Attribute Description File that
is currently selected on the Extended Attributes tab of the Options dialog box.

On the Extended Attributes page, you can edit any of the listed attributes for the selected package by clicking on
the attribute name.

Task:

To enter or edit a package’s extended attributes:
1. If a package is not currently selected, go to the Select a Package Page and select a package.

2. Click on the Extended Attributes button in the navigation bar. The Extended Attributes Page opens,
listing all of the attributes defined in the Extended Attributes Description file, and listing any values that have
previously been entered.

3. To edit an attribute, click the attribute link. A dialog box opens and prompts you to enter text, make a selection
from a list, or upload a file (depending upon how the attribute was defined in the Extended Attribute
Description File).

4. Perform the desired action and click OK. When you return to the Extended Attributes Page, the changes
that you made are displayed.

Validation Page

On the Validation Page, you compare the package against selected Microsoft Internal Consistency Evaluators
(ICEs), custom actions written by Microsoft which can be executed to determine if an installation package is built
according to Windows Installer standards.

Task:

920

To validate a package:

1. After selecting a package on the Select a Package Page of the ConflictSolver Process Assistant, the
Validation Page opens. You can also open the Validation Page by clicking the Validation icon in the
navigation bar.

2. Click Validate to begin the validation process. Results are displayed in the Validation Results list and on the
Validate tab of the Output window.

If you do not want ConflictSolver to check for a particular ICE error during subsequent validations of a
package, you can choose to suppress it by selecting the ICE error and selecting Suppress from the context
menu.
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3. When you suppress an ICE error, it is listed in gray on the ConflictSolver Validation View and is not executed
in subsequent validations. You might choose to suppress an ICE error that is a known issue at your
organization which does not need additional corrections.

4. You can make a selection from the View list to view only ICE Errors that are Enabled, only those that are
Suppressed, or All ICE Errors.

Microsoft Internal Consistency Evaluators (ICEs)

When ConflictSolver validates a package, it compares a package against Microsoft ICEs (Internal Consistency
Evaluators), custom actions written by Microsoft which can be executed to determine if an installation package is
built according to Windows Installer standards.

ICEs are written in VBScript, JScript, or as a DLL or EXE. When these custom actions are executed, they scan the
database for entries in database records that are valid when examined individually but that may cause incorrect
behavior in the context of the whole database.

E

Note -« For a full listing and description of all Microsoft ICEs, see ICE Reference in the Microsoft MSDN Library.

Validation Error Severity Ratings

When ConflictSolver validates a package, it compares a package against Microsoft ICEs (Internal Consistency
Evaluators), custom actions written by Microsoft which can be executed to determine if an installation package is
built according to Windows Installer standards. ICE errors have the following degrees of severity:

e Errors—Database authoring that causes incorrect behavior. An example of an error would be duplicate
component GUIDs, which would cause the Installer to incorrectly register components.

e Warnings—Database authoring that can cause incorrect behavior. Warnings can also report unexpected
side-effects of database authoring. An example of a warning would be entering the same property name in two
conditions that differ only by the case of letters in the name. Because the Installer is case-sensitive, the
Installer treats these as different properties.

e [nformational—Information from the ICE that do not indicate a problem with the database. Often they are
information about the ICE itself, such as a brief description. They can also provide progress information as the
ICE runs.
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Configuring Validation Options

Task:

Validation options are set on the Validate tab of the ConflictSolver Options dialog box. To fine tune validation for
your organization, you may want to adjust some of the following settings.

Excluding Specific ICEs from Execution During Validation

You can permanently exclude the execution of specific ICEs that are listed in the selected .cub file.

To exclude the execution of specific ICEs during validation:
1. In ConflictSolver, select Options from the Tools menu. The Options dialog box opens.
2. Select the Validate tab from the dialog box. The Validate tab opens.

3. Inthe MSI Input files and MSM Input files areas, list the ICEs that you want to exclude in the ICE Rules field,
separated by semicolons (;), such as:

ICEO7; ICE09; ICE22

All of the ICEs in the specified .cub file will be executed during validation except for the ICEs listed here.

Changing the Default Validation File

By default, ConflictSolver compares packages against the full set of Microsoft ICEs. In the overwhelming majority
of cases, this is the file you will want ConflictSolver to use when performing validation. However, there may be
times you want to compare your base package against a different validation file, depending on your needs.

Task:

92

To specify a different validation file to use:
1. Select Options from the Tools menu. The Options dialog box opens.

2. Select the Validate tab from the dialog box. The Validate tab opens.

3. Inthe MSI Input files and MSM Input files areas, click the Browse button ([.-]) next to the Cub File field to locate
the validation file (.cub) that you would like to use.

4. To permanently exclude the execution of specific ICEs, list them in the ICE Rules field, separated by
semicolons (;). Otherwise, all rules will be used. See Excluding Specific ICEs from Execution During Validation
for more information.

Suppressing Warnings and Informational Messages

To suppress Warnings and Informational Messages from being displayed in the Validate tab of the Output window
during validation, you can clear the Warnings and Info check boxes on the validate tab of the ConflictSolver
Options dialog box. It is strongly recommended you do not suppress warning messages So you can ensure proper
validation of packages before importing them into ConflictSolver.
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Best Practices Page

On the Best Practices Page, you check a package to see if it meets Windows Installer “best practices” rules, and
then you are given the opportunity to resolve any conflicts that are found. See Best Practice ACEs for more
information.

Task: To check a package against Best Practice ACEs:

1. Inthe ConflictSolver Process Assistant, click the Best Practices icon in the navigation bar. The Best
Practices Page opens.

2. Click Detect to check the selected package. Any conflicts that are found are listed in the Best Practice ACE
list, and are also listed in the Conflicts tab of the Output Window.

3. Select the conflicts that you would like to resolve and click Resolve.

Best Practice ACEs

A best practice ACE is an ACE that operates like an ICE to enforce Microsoft best practices. While an ICE is a
custom action written by Microsoft which is used during validation to determine if an installation package is built
according to Windows Installer standards, an ACE is a custom action included with ConflictSolver that is also used
to enforce Windows Installer standards.

When testing an installation package against a best practice ACE, there is no target package involved. The source
installation package is tested to see if it meets the standards defined in the ACEs.

The ConflictSolver best practice ACEs are the following:

Table 2-4 « Best Practice ACEs

ACE Rule Description Result CARD Resolution
ACEO04 Checks to see if components | If a component does nothave = A CreateFolder entry is
that have NULL KeyPath a key file, and if the directory/ | created for the component.
values are valid by checking component pair is not listed
for an entry for the in the CreateFolder table,
component in the ACEO4 fails.

CreateFolder table.

ACEO05 Checks for the existence of If more than one executable Modifies the component so
more than one executable exists in acomponent, ACE05 that only one EXE or DLL
(EXE, DLL, OCX, HLP, CHM, fails. exists, and it adds new
TLB, SYS, DRV) per components for remaining
component in a Windows EXE, DLL, OCX, HLP, CHM,
Installer package. TLB, SYS, and DRV files.
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Table 2-4 ¢« Best Practice ACEs

ACE Rule

ACEO06

ACE25

ACE26

Description

Checks whether the
executable module (EXE,
DLL, OCX, HLP, CHM, TLB,
SYS, or DRV) within the
component is the key file.

Checks the entries in the

package’s CustomAction
table to identify any hard

coded paths in the Target
field.

Checks the Merge Modules in
a package to confirm that
they have been imported into
the Application Catalog.

Result

If the executable module is
not the key file, ACEQ6 fails.

If a package has a hard
coded path in the Target field
of the CustomAction table, a
warning is generated.

If a package refers to a Merge
Module that does not exist in
the Application Catalog, a
warning is generated.

CARD Resolution

The executable module is
automatically made the key
file.

Open the package file in
InstallShield Editor and
change the hard coded paths
to relative paths in the
CustomAction table.

Import the missing Merge
Module into the Application
Catalog.

ACE27

Checks to see if data exists in
the DuplicateFile MSI table
that is not being executed
with an associated
DuplicateFiles action.

If a package contains data in
the DuplicateFile table but not
the necessary actions to use
this data, a warning is
generated.

Consider whether a
DuplicateFiles or
RemoveDuplicateFiles action
is needed for your
InstallExecuteSequence
table. If so, open the MSI file
in InstallShield and add the
appropriate action to the
InstallExecuteSequence
table, or remove the unused
data from the DuplicateFile
table.

ACE28

Checks the Value field of the
package’s Environment table
to identify any hard coded
paths.

If any hard coded paths exist
in the Value field of a
package’s Environment table,
a warning is generated.

Open the package file in
InstallShield Editor and
change any hard coded paths
in the Value field of the
Environment table to relative
paths.

ACE29

Checks the Value field of a
package’s IniFile table to
identify any hard coded
paths.

If the Value field of a
package’s IniFile table has
any hard coded paths, a
warning is generated.

Open the package file in
InstallShield Editor and
change any hard coded paths
in the Value field of the IniFile
table to relative paths.
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ACE Rule

ACE30

ACE31

ACE32

ACE33

AdminStudio 9.5 User Guide

Description

Checks to identify
components with different
ComponentIDs installing the
same key file to the same
directory. (A check for
KeyPath conflicts across
components.)

Checks to see if data exists in
the MoveFile MSI table that is
not being executed with an

associated MoveFiles action.

Checks entries in the Registry
table to identify any hard
coded paths in its Value field.

Checks to see if data exists in
the RemoveFile MSI table that
is not being executed with an
associated RemoveFiles
action.

ADS-0950-UG00
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Result

If components with different
ComponentIDs installing the
same key file to the same
directory is identified, a
warning is generated.

If a package contains data in
the MoveFile table but not the
necessary actions to use this
data, a warning is generated.

If there are any hard coded
paths in the Value field of the
package’s Registry table, a
warning is generated.

If a package contains data in
the RemovekFile table but not
the necessary actions to use
this data, a warning is
generated.

ConflictSolver Process Assistant

CARD Resolution

If a product component is
installing a KeyPath file which
is also being installed by a
product with a different
Component Id, the KeyPath
ACE fails.

Consider whether a
MoveFiles action is needed
for your
InstallExecuteSequence
table. If so, open the MSI file
in InstallShield and add the
appropriate action to the
InstallExecuteSequence
table, or remove the unused
data from the MoveFile table.

Open the package file in
InstallShield Editor and
change any hard coded paths
in the Value field of the
Registry table to relative
paths.

Consider whether a
RemoveFiles action is needed
for your
InstallExecuteSequence
table. If so, open the MSI file
in InstallShield and add the
appropriate action to the
InstallExecuteSequence
table, or remove the unused
data from the RemoveFile
table.
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Table 2-4 « Best Practice ACEs

ACE Rule

ACE34

ACE35

ACE36

Description

Checks to see if data exists in
the RemovelniFile MSI table
that is not being executed
with an associated
RemovelniFiles action.

Checks to see if data exists in
the RemoveRegistry MSI
table that is not being
executed with an associated
RemoveRegistryValues
action.

Checks to see if a package’s
required Merge Modules have
been imported into the
Application Catalog.

Result

If a package contains data in
the RemovelniFile table but
not the necessary actions to
use this data, a warning is
generated.

If a package contains data in
the RemoveRegistry table but
not the necessary actions to
use this data, a warning is
generated.

If any of a package’s required
Merge Modules do not exist
in the Application Catalog, a
warning is generated.

CARD Resolution

Consider whether a
RemovelniFiles action is
needed for your
InstallExecuteSequence
table. If so, open the MSI file
in InstallShield and add the
appropriate action to the
InstallExecuteSequence
table, or remove the unused
data from the RemovelniFile
table.

Consider whether a
RemoveRegistryValues action
is needed for your
InstallExecuteSequence
table. If so, open the MSI file
in InstallShield and add the
appropriate action to the
InstallExecuteSequence
table, or remove the unused
data from the
RemoveRegistry table.

Import the package’s missing
Merge Modules into the
Application Catalog.
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Resolving Best Practice ACE Errors

On the Best Practices Page of the Process Assistant, after you click Detect, any conflicts that are found are listed
in the Best Practice ACE list. To resolve these conflicts, select the conflicts that you would like to resolve and click
Resolve.

You can also resolve Best Practice ACEs conflicts along with standard ACE conflicts on the ConflictSolver Conflicts
View.

Task: To resolve conflicts on the Conflicts View:
1. From the Product View, select the product for which you want to view identified conflicts.
2. Select the Conflicts View for the product.
3. Select the category containing the automatically resolvable conflict from the Conflict Information list.
4. Expand the ACE containing conflicts that can be resolved.

The icon displayed next to the conflict indicates its status:

Table 2-5 «
Icon Status
2 Resolvable
0 Resolved
@ Unresolvable

5. Select the conflict you want to resolve and click Resolve. Alternatively, click Resolve All to resolve all
resolvable conflicts for the selected conflict category.

6. For CARDs that can be resolved in multiple ways, and if the Maximize user flexibility in selecting
resolutions option is selected on the Resolution tab of the Options dialog box, the CARD Resolution
Options dialog box appears, prompting you to make a selection to determine how conflict resolution will
proceed. Make a selection and click OK to continue.

7. Ifthe Preview and approve all resolutions option on the Resolution tab of the Options dialog box is
selected, the Resolution Details dialog box will appear, listing the proposed CARD resolutions that will be
made to the package. Select the CARD resolutions that you want to resolve, and click Approve to execute
them.

If the Preview and approve all resolutions option is not selected, the Resolution Details dialog box will
not appear, and all selected conflict resolutions will be executed.
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Configuring Conflict Detection

o

You can specify which ACEs you want to be selected by default on the Conflict Options panel of the Conflict
Wizard.

Task:

To select the default ACEs:
1. Select Options from the ConflictSolver Tools menu. The Options dialog box opens.
2. Click the Conflicts tab.

3. Select the default conflicts you want to check for from the Predefined and Custom ACE Rules area. Conflict
rules (ACEs) associated with unselected boxes will not be performed by default during conflict identification.
However, you can override these in the Conflict Options panel of the Conflict Wizard.

4. Click OK.

Configuring Resolution Options

98

On the Resolution Tab of the ConflictSolver Options dialog box, you can specify options to determine how
conflict resolutions are performed.

Table 2-6 * Conflict Resolution Options

Option Description

Perform resolutions If this option is selected, ConflictSolver will, by default, save conflict detection
against a transform file = resolutions in a transform file (MST). The original Windows Installer package (MSI)
remains untouched.

You can override this option for an individual package by going to that package’s
Conflict View and clicking Edit and change this option on the Resolution
Options dialog box.

Preview and approve Select this option if you want to review and approve the suggested resolution for

all resolutions each conflict before ConflictSolver performs any resolutions. When the conflict
detection process is completed, the Resolutions Details dialog box is
displayed, listing the conflicts that were found and the CARDs that could be used
to resolve these conflicts. Before ConflictSolver will continue resolving these
conflicts, each conflict resolution must be approved. See Conflict Resolution
Process for more information.

Maximize user Some CARDs can resolve a conflict in more than one way. For example, ACE06
flexibility in selecting checks whether the executable module within the component is the key file, and
resolutions accumulates a list of potential files to be used for the key file. If this option is

selected, this list of files is displayed on the CARD Resolution Options dialog
box, and you are prompted to select which file to use. If this option is not selected,
the CARD will perform its default resolution.
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Detect Conflicts Page

W

Task:

On the Detect Conflicts Page, you will check the selected package against target packages to determine if conflicts
would occur if all of these packages were installed on the same system.

To perform conflict detection:

1. Inthe ConflictSolver Process Assistant, click the Detect Conflicts icon in the navigation bar. The Detect
Conflicts Page opens.

2. Inthe Group tree, select the target packages that you would like to include in the conflict detection process.

3. Click Detect. Results appear in the Conflict tab of the Output window.

Target Packages

In conflict detection, target packages are the individual packages or groups of packages that you want to compare
the source package(s) against. The source package is the package you are checking for conflicts.

Typically target packages are a group of applications and operating systems that are installed on workstations at
your organization. You would perform conflict detection against these target packages to determine if any conflicts
would occur if you installed the source package(s) on the same machine.

You select the target packages that you want to use in conflict detection on the Target Information Panel of the
Conflict Wizard.

Configuring Conflict Detection

W

Task:

You can specify which ACEs you want to be selected by default on the Conflict Options Panel of the Conflict
Wizard.

To select the default ACEs:
1. Select Options from the ConflictSolver Tools menu. The Options dialog box opens.
2. Click the Conflicts tab.

3. Select the default conflicts you want to check for from the Predefined and Custom ACE Rules area. Conflict
rules (ACEs) associated with unselected boxes will not be performed by default during conflict identification.
However, you can override these in the Conflict Options Panel of the Conflict Wizard.

4. Click OK.
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Resolve Conflicts Page

W

Task:

On the Resolve Conflicts Page, you will view all detected conflicts and choose to resolve any conflicts that have an
automatic resolution.

To resolve conflicts:

1. Inthe ConflictSolver Process Assistant, click the Resolve Conflicts icon in the navigation bar. The Resolve
Conflicts Page opens.

For the Select the type of conflicts to display option, select Automatically resolvable conflicts.
Select the ACE errors that you would like to automatically resolve.
Click Resolve. The Resolution Details dialog box opens prompting you to approve the changes.

Click Approve. The resolved conflicts now are listed with a check mark icon.

o o 2 0 b

You can also view the manually resolvable conflicts. See Application Conflict Evaluators (ACEs) for resolution
instructions.

Automatic and Manual Conflict Resolution

100

Automatic Conflict Resolution

To identify conflicts between multiple installation packages, ConflictSolver uses Application Conflict Evaluators
(ACEs). Some ACE failures can be resolved automatically by ConflictSolver. These automatic resolution
techniques are defined in Conflict Application Resolution Definition (CARD) rules. ACEs that can be automatically
resolved by CARDs are referred to as Best Practice ACEs: ACE02, ACE04, ACE05, ACE06, ACE07, ACE15, ACE18,
ACE19, ACE20. CARDs resolve errors found by the corresponding ACE of the same number.

You can choose to automatically resolve ACEs on the Conflicts View for the product. Select the conflict you want
to resolve and click Resolve. Alternatively, click Resolve All to resolve all resolvable conflicts for the selected
conflict category. See Resolving Best Practice ACE Errors

Manual Conflict Resolution

Due to their complexity, some conflicts require manual resolution using Tuner or InstallShield Editor.

For information on manual solutions, consult the Application Conflict Evaluators (ACEs) topic or individual ACE
topics. These topics can provide valuable information regarding what is causing the conflict, so you can use Tuner
or InstallShield Editor to solve it.

Once you have resolved detected conflicts manually, you can re-import the package into ConflictSolver.

ADS-0950-UG00 AdminStudio 9.5 User Guide



Chapter 2: Using the Process Assistant
ConflictSolver Process Assistant

Configuring Resolution Options

On the Resolution Tab of the ConflictSolver Options dialog box, you can specify options to determine how conflict

resolutions are performed.

Table 2-7 « Conflict Resolution Options

Option

Perform resolutions
against a transform file

Preview and approve
all resolutions

Maximize user
flexibility in selecting
resolutions

Description

If this option is selected, ConflictSolver will, by default, save conflict detection
resolutions in a transform file (MST). The original Windows Installer package (MSI)
remains untouched.

You can override this option for an individual package by going to that package’s
Conflict View and clicking Edit and change this option on the Resolution
Options dialog box.

Select this option if you want to review and approve the suggested resolution for
each conflict before ConflictSolver performs any resolutions. When the conflict
detection process is completed, the Resolutions Details dialog box is
displayed, listing the conflicts that were found and the CARDs that could be used
to resolve these conflicts. Before ConflictSolver will continue resolving these
conflicts, each conflict resolution must be approved. See Conflict Resolution
Process for more information.

Some CARDs can resolve a conflict in more than one way. For example, ACE06
checks whether the executable module within the component is the key file, and
accumulates a list of potential files to be used for the key file. If this option is
selected, this list of files is displayed on the CARD Resolution Options dialog
box, and you are prompted to select which file to use. If this option is not selected,
the CARD will perform its default resolution.
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Reporting Page

102

On the Reporting Page, you can generate package reports listing data about conflicts, extended attributes, files,

and registry entries.

Select the report that you would like to generate, and click Generate. The report opens in a new browser window.
The following reports are available:

Table 2-8 « Available Reports

Report

Package

File

Registry

Description

Provides a report including the following information:

e Product Information—Lists all information that appears on the Product View for a
package.

e Conflict Information—Lists all conflicts found during the most recent Conflict
Wizard execution, or the most recent Import (if conflict identification was performed).

e Validation Information—Lists all validation errors and warnings found during the
most recent validation execution for that package.

E

Note < Validation information is persisted only for validations performed after the package was

imported into the Application Catalog; validation results for validation performed during import are not

persisted.

e Extended Attributes—Lists user-defined information that appears on the
Extended Attributes View for a package.

The following information is displayed:
® Product Information—Lists all information that appears on the Product View for a
package.

o Files—Lists all of the files that are included with the package. These files are also
listed on the Files/Components View for that package.

The following information is displayed:

e Product Information—Lists all information that appears on the Product View for a
package.

e Registry—Lists any registry entries created or changed by the package. These
registry entries are also listed on the Registry View for that package.
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Table 2-8 « Available Reports (cont.)

Report Description

Crystal Reports The following reports in Crystal Report format are available:

e Crystal Reports Conflicts—Provides a report of all conflicts found during the most
recent Conflict Wizard execution, or the most recent Import (if conflict identification
was performed). This report is also available on a per-product basis by right-clicking
on a product in the Product View.

e Crystal Reports Files—Provides a comprehensive listing of all files in
ConflictSolver, sorted on a per package and per component basis. This report is also
available on a per-product basis by right-clicking on a product in the Product View.

e Crystal Reports Registry—Provides a comprehensive listing of all registry entries
in ConflictSolver, sorted on a per package and per component basis. This report is
also available on a per-product basis by right-clicking on a product in the Product
View.

E

Note « The three Crystal Reports selections will be listed on the Report menu if the Display RPT
Reports option on the General tab of the ConflictSolver Options dialog box is selected. To
suppress the display of the Crystal Reports selections, unselect this option.

E

Note ° You can also generate reports by selecting the report name from the ConflictSolver Reports menu.

Organize Package Page

On the Organize Package Page, you select the Group(s) where you want the imported package to belong to, and
you can also choose to add the file to the Software Repository.

About the “Draft” Group

When you import a package into the Application Catalog using the ConflictSolver Process Assistant, that package
is automatically imported into a special group called Draft, a temporary working group that isolates an imported
package that has not yet been checked for conflicts from the rest of the packages in the Application Catalog. The
Draft group is only visible when you select Current on the Select a Package Page of the Process Assistant.

By placing these newly imported packages into the Draft group, you are indicating that these packages are in the
process of being prepared for distribution, and should not be used as target packages in conflict detection. After
you have performed validation, conflict detection, and conflict resolution on a Draft package, and it is ready for
distribution at your organization, you should then move it out of the Draft group using the Organize Package
Page. The package will then be visible on the ConflictSolver and Application Manager Product View.
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About the Software Repository

A Windows Installer package is made up of many files that are executed when the setup is run. However, only the
.msi file is imported into the Application Catalog database. To safeguard these additional files against alteration or
being misplaced, you can choose to manage these files using the Software Repository. When you import a
package into the Software Repository, all of its associated installation files are stored in the Software Repository
location defined for the open Application Catalog.

If you want to add a file you are importing to the Software Repository, select the Add package to the Software
Repository option on the Organize Package Page. In order to select this option, you must be connected to an
Application Catalog that has the Software Repository enabled. See Managing Application Catalog Databases and
Enabling the Software Repository in an Existing Application Catalog.

Task:

To relocate a package within your Application Catalog:

1. Inthe ConflictSolver Process Assistant, click the Organize icon in the navigation bar. The Organize Package
Page opens.

In the Destination Groups list, the check boxes next to the Groups that your package is in (if any) are
selected. If you have just imported a package, it is still in the Draft group, which is not displayed on this list.

2. Select the check boxes next to the Group(s) where you want this package to be located.

3. If you want to add this package to the Software Repository, select the Add package to the Software
Repository option.

E

Note * The Add package to the Software Repository option is only displayed if you are connected to an
Application Catalog that has the Software Repository enabled. See Enabling the Software Repository in an
Existing Application Catalog.

4. Click Organize. The package is moved into the selected group(s) and, optionally, copied into the Software
Repository.

Current and New Packages

104

On the Select a Package Page, you choose the package that you are going to process using the ConflictSolver
Assistant. You can choose to use either a Current or New package:

e Current—Package that has already been imported into the Application Catalog.

e New—Package that will be imported into the Draft Group of the Application Catalog, a working Group used for
packages in the process of being prepared for distribution.

After you have selected a package, you can use it in the Validation, Best Practices, Detect Conflicts, Resolve
Conflicts, Reporting, and Organize Package tasks of the ConflictSolver Assistant.
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Draft Packages

When you import a package into the Application Catalog using the ConflictSolver Process Assistant, that package
is automatically imported into a special group called Draft, a temporary working group that isolates an imported
package that has not yet been checked for conflicts from the rest of the packages in the Application Catalog. The
Draft group is only visible when you select Current on the Select a Package Page of the Process Assistant.
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By placing these newly imported packages into the Draft group, you are indicating that these packages are in the
process of being prepared for distribution, and should not be used as target packages in conflict detection.

After you have performed validation, conflict detection, and conflict resolution on a Draft package, and it is ready
for distribution at your organization, you should then move it out of the Draft group using the Organize Package
Page of the Process Assistant. The package will then be visible on the ConflictSolver and Application Manager
Product View.

E

Note « While it is possible to move a package out of the Draft group before conflict detection and resolution have
been performed, it is not recommended.
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Creating a New Group

o

Task:

You can create a new group using the New button on the Organize Package Page of the Process Assistant.

To create a new group:

1.

2
3.
4

If a package is not currently selected, go to the Select a Package Page and select a package.
Click on the Organize Package button in the navigation bar. The Organize Package Page opens.
Click New. The New Group Properties dialog box opens.

Enter a Name, Description and any desired Comments for the new group and click OK. The new Group is
listed in the group tree and is automatically selected.

Test Page

Task:

106

Edition * QualityMonitor is included with AdminStudio Professional and Enterprise Editions.

On the Test Page, you test the package installation on the targeted deployment environment to ensure that it works
as expected.

To test a package installation:

1.

2.

Click on the Test icon in the navigation bar. The Test Page opens.

In the Package File field, specify the name of the package that you want to test. The fields on the Test page
change depending upon whether the selected package is installed on your machine.

o [|f the selected application is already installed on your machine, skip to step 6.

e [f the selected application is not installed on your machine, you are prompted to install the
application.

Include any additional transform files in the installation by adding them to the Transform List.
Click Install to install the package. The package’s installation program runs.

Complete the steps required to install the selected package. When the installation is complete, the Test
selection list appears.

From the Test selection list, select the tests that you want to run:

e Execute all deployment—Deployment tests are performed against the installed product, ensuring that
the product has been installed correctly and all key functionality works in the installed environment. See
Deployment Testing
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o Verify the package in a lockdown environment—You are provided with a list of available shortcuts in
the package and all of the executables in the package. You can then launch via the shortcut or
executable, and exercise functionality in the application. When you close the application, information
about the executable is listed, allowing you to see failures in the application execution. See Lockdown
and Runtime Testing

e Verify the package installation status using MSI Doctor—Allows you to verify if an MSI package is
installed properly. This helps prevent users from seeing an auto-repair dialog box when they run the
application. See Using MSI Doctor to Verify Package Deployment Status.

e Click Test to run the selected test against the package.

Distribute Page
On the Distribute Page, you prepare your package for distribution.
Task: To prepare your package for distribution:

1. Click on the Distribute icon in the navigation bar. The Distribute Page opens.

2. Click Browse to locate and select the package.

3. Should that package require transforms, click the New button (
dialog box and select a transform file.

i|) to launch the Select Transform Files

e If the package requires multiple transforms, you can repeat the procedure as necessary.

e The order in which transforms are applied can be changed by selecting a transform and clicking the
Move Up ( 4|) and Move Down ( ¥|) buttons.

e Delete a transform file from the Transforms list by selecting the transform and clicking the Delete button
(%)

4. From the Distribution Type list, select the type of distribution you want to perform. A description of each type
appears when it is selected.

5. Click Distribute to complete the distribution process.
See Also

Preparing Packages for Distribution Using Distribution Wizard
Distributing Transforms With an MSI Package

AdminStudio 9.5 User Guide ADS-0950-UG00 107



Chapter 2: Using the Process Assistant
Distribute Page

Distributing Transforms With an MSI Package

To distribute a package that requires transforms, you would specify the files that you want to include in the
Transform Files list on the Distribute Page.

After you have selected the package to distribute, click the New button (:
Files dialog box, and select a transform file (.mst).

i) to launch the Select Transform

e If the package requires multiple transforms, you can repeat the procedure as necessary.

e The order in which transforms are applied can be changed by selecting a transform and clicking the Move Up

( #]) and Move Down ( #|) buttons.

e Delete a transform file from the Transforms list by selecting the transform and clicking the Delete button (x]).
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Using the AdminStudio Interface

The AdminStudio interface is the central application for AdminStudio. From it, you can launch AdminStudio tools,
launch the Process Assistant, create workflow templates and projects, and connect to and create Application
Catalogs. You can launch the AdminStudio interface from the Windows Start menu.

E

Note * The Process Assistant is a procedure-based alternative interface to the standard AdminStudio interface. For
more information, see Using the Process Assistant.

AdminStudio interface documentation is presented in the following sections:

Table 3-1 « AdminStudio interface Documentation

Section

Configuring the
AdminStudio Interface

Description

Includes information on customizing the AdminStudio Interface, including
setting shared directories.

Working with Tools

Workflows and Projects

Frequently Asked
Questions

Explains how to configure AdminStudio tools and also external tools
necessary to perform workflow tasks.

Explains how to use workflow functionality to define repeatable processes to
accomplish your goals.

A list of questions frequently asked by AdminStudio users, with links to the
appropriate help topics.

AdminStudio Interface
Reference
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Configuring the AdminStudio Interface

This section explains how to configure and customize the AdminStudio interface. The following topics are
discussed:

Table 3-2 » Topics on AdminStudio Interface Configuration
Category Topics
Launching Applications ® Launching AdminStudio Applications

Configuring Application e Specifying the Shared AdminStudio Application Catalog

Catalog Settings e Specifying the AdminStudio Shared Location
Setting Interface e Setting the Workflow Task Help Page Location
Preferences e Configuring How Often AdminStudio Checks for Updates

e Configuring AdminStudio to Stay on Top
® Generating a Debug Log for AdminStudio

Configuring Interactivity | e Specifying the AdminStudio Enterprise Server URL
Settings e Specifying the Configuration Manager Web Console URL

Launching AdminStudio Applications

Individual AdminStudio applications, such as ConflictSolver, InstallShield Editor, or Repackager, can be launched
by clicking on the tool in the Tools Gallery on the AdminStudio Start Page.

Use the Process Assistant to guide you through the pre-deployment and application

h corfiguration process.

@ Repackager M@ cedior

B conflictsalver wa CualityMoritor
@ PackageExpert B Distribution Wizard
L'j Report Center ‘b Security Console

Figure 3-1: Tools Gallery on Start Page

You can also launch AdminStudio applications by double-clicking on the tool icon in the Tools Gallery on the Tools
Tab.
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Figure 3-2: Tools Gallery on the Tools Tab

E

Note - If a core AdminStudio tool is not in the Tools Gallery or available from the menu, it may mean that either you
are not assigned to a Role that has permission to use that Tool, or that the Tool is not available in your Edition of
AdminStudio.

E

Note ° You can also launch AdminStudio tools from the Process Assistant. See Using the Process Assistant for
more information.
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Specifying the Shared AdminStudio Application Catalog

W

Task:

This field displays the name and location of the shared AdminStudio Application Catalog. Click the Browse button
to connect to another Application Catalog using the Connect to Application Catalog dialog box.

To specify the location of the AdminStudio Shared Location:

1. Launch the AdminStudio interface.
2. From the Tools menu, select Options. The Options dialog box opens.
3. Select the Application Catalog tab.

4. Select the Shared AdminStudio Application Catalog.

5. Click OK to close the Options dialog box.

Specifying the AdminStudio Shared Location

Task:

112

The AdminStudio Shared Directory (also referred to as the AdminStudio Shared Location) contains shared
information for repackaging and conflict identification, and other AdminStudio functions. The AdminStudio Shared
Directory contains the following:

e The Shared AdminStudio.ini file, which specifies default Application Catalog database settings
e Application Manager duplicate package identifier options

® Repackager isrepackager.ini exclusion list

® OS Snapshot issnapshot.ini file

e ConflictSolver user-defined ACEs

e Distribution Wizard Distribution Type templates and .1in1 files

If you are working in a team environment, the AdminStudio Shared Directory should be set to a centralized network
location, accessible by all AdminStudio users at your organization, rather than on your local machine. Follow the
steps below to specify the location of the AdminStudio Shared Directory.

E

Note * To maintain consistency when creating workflows, InstallShield recommends that you set the AdminStudio
Shared Directory the same for each AdminStudio user.

To specify the location of the AdminStudio Shared Directory:
1. Launch the AdminStudio Interface.

2. From the Tools menu, select Options. The Options dialog box opens.
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3. Inthe Options dialog box, select the Locations tab.
4. Enter or browse to the directory for the AdminStudio Shared Location.

5. Click OK to close the Options dialog box.

Setting the Workflow Task Help Page Location

The Task Help Page Location is the directory where you want to store all HTML pages that serve as workflow
task instructions.

o

Task: To specify the location of task help pages:

1. Launch the AdminStudio interface.
2. From the Tools menu, select Options.The Options dialog box opens.
Select the Locations tab.

Enter or browse to the Task Help Page Location, the location where workflow task help pages are stored.

L N

Click OK to close the Options dialog box.

Configuring How Often AdminStudio Checks for Updates

You specify how often you want AdminStudio to check for updates on the Updates tab of the Options dialog box.

&

Task: To configure how often AdminStudio checks for updates:

1. Open AdminStudio.

2. Onthe Tools menu, click Options. The Options dialog box opens.

3. Onthe Updates tab, select the frequency that AdminStudio will check for software updates:
® Once every 15 days
e Once every 30 days
® Once every 60 days
e Never

4. Click OK to close the Options dialog box.
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Configuring AdminStudio to Stay on Top

When you launch AdminStudio tools, you can specify whether they open in front of or behind the AdminStudio
interface. If you select Always on Top from the View menu, application will always open behind the AdminStudio
interface.

Task: To configure AdminStudio to stay on top of other applications:
1. Launch the AdminStudio interface.

2. From the View menu, select Always on Top.

Generating a Debug Log for AdminStudio

To create a debug log for AdminStudio, perform the following steps.

o

Task: To generate a debug log for AdminStudio:

Use the following registry value to turn debugging on. Once this debugging is turned on, a log file will be created in
the same location as the .exe file.

[HKLM\Software\Instal1Shield\AdminStudio] DebuglLoglLevel="3"

Levels 0, 1, 2, 3 are supported with 3 being the highest. Default is level 0.

Specifying the AdminStudio Enterprise Server URL

You specify the Web site URL of AdminStudio Enterprise Server on the Application Catalog tab of the Options
dialog box.

W

Task: To specify the AdminStudio Enterprise Server URL:
1. Launch the AdminStudio interface.
2. On the Tools menu, click Options. The Options dialog box opens.
3. Select the Application Catalog tab.
4. Enter the AdminStudio Enterprise Server URL.

5. If you have more than one AdminStudio Enterprise Servers, select the Make this the default Shared AES
URL to make the URL in the AdminStudio Enterprise Server URL field the default.

6. If you want to Allow automatic authentication by AdminStudio Enterprise Server, select this option.

7. Click OK to close the Options dialog box.
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Specifying the Configuration Manager Web Console URL

AdminStudio 9.5

Enter the URL for the Configuration Manager Web Console Web site. You specify the Web site URL of the
Configuration Manager Web Console on the Locations tab of the Options dialog box.

Task: To specify the Configuration Manager Web Console URL:
1. Launch the AdminStudio interface.
2. On the Tools menu, click Options. The Options Dialog Box opens.
3. Select the Locations tab.
4. Enter the Configuration Manager Web Console URL.

5. Click OK to close the Options dialog box.

Working with Tools

Topics in this section involve adding, configuring, and associating tools in the Tools Gallery on the Tools Tab. This
section contains the following topics:

e Adding New Tools to the Tools Gallery

Editing Properties for an Existing Tool

® Adding Command-Line Configurations for an Existing Tool

® Modifying Command-Line Configurations for an Existing Tool
e Deleting Command-Line Configurations from an Existing Tool
® Associating Tools with Tasks

® Running Associated Tools in Projects

® Deleting Existing Tools

e Limiting Tool Accessibility
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Adding New Tools to the Tools Gallery

W

Task:

To add a new tool to the Tools Gallery:
1. From the Tools Tab, right-click in the Tools Gallery and select Add Tool. The Add Tool Wizard opens.
2. Onthe Welcome Panel, click Next. The Tool Properties Panel opens.

3. On the Tool Properties Panel, provide the necessary details about the tool. Click Next. The Command-
Line Configuration Panel opens.

4. |If there are command-line options you want associated with the tool, do so from the Command-Line
Configurations Panel. Each tool can have multiple command-line options associated with it for different
purposes.

5. Click Finish.

After using the Add Tool Wizard, the new tool appears in the Tools Gallery and is available for use in workflows
and projects.

E

Note ° In AdminStudio, tools are any external application or file that you can launch from a workflow or project. This
typically is an application, but can be a simple document or batch file necessary to completing the project.

Editing Properties for an Existing Tool

&

Task:

116

To edit the properties of a Tool in the Tools Gallery, perform the following steps.

To edit an existing tool's properties:

1. From the Tools Tab, right-click the tool in the Tools Gallery and select Properties. The Tool Properties
dialog box is displayed.

2. Click the Properties tab.
3. Modify tool properties as necessary.

4. Click OK to apply the changes.

E

Note * In AdminStudio, tools are any external application or file that you can launch from a workflow or project. This
typically is an application, but can be a simple document or batch file necessary to completing the project.
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Adding Command-Line Configurations for an Existing

Tool

To add command-line configurations for an existing Tool, perform the following steps:

W

Task: To add a command-line configuration to an existing tool:

1.

2,
3
4
5.
6

E

From the Tools Tab, right-click the tool to which you want to add a configuration from the Tools Gallery and
select Properties. The Tool Properties dialog box is displayed.

Click the Configuration tab.

Click Add. The Command-Line Properties dialog box is displayed.
Enter a description and the command-line configuration.

Click OK to close the Command-Line Properties dialog box.

Click OK to close the Tool Properties dialog box.

Note ° In AdminStudio, tools are any external application or file that you can launch from a workflow or project. This

typically is an application, but can be a simple document or batch file necessary to completing the project.

Modifying Command-Line Configurations for an Existing

Tool

To modify command-line configurations for an existing Tool, perform the following steps:

W

Task: To edit and existing tool's command-line configurations:

1.

From the Tools Tab, right-click the tool in the Tools Gallery and select Properties. The Tool Properties dialog
box is displayed.

Click the Configuration tab.

Select the command-line configuration you want to edit and click Modify. The Command-Line Properties
dialog box appears.

Modify the description and/or command line.
Click OK to dismiss the Command-Line Properties dialog box.

Click OK in the Tool Properties dialog box to apply the changes.
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E

Note * In AdminStudio, tools are any external application or file that you can launch from a workflow or project. This
typically is an application, but can be a simple document or batch file necessary to completing the project.

Deleting Command-Line Configurations from an Existing

Tool

o

To delete command-line configurations from an existing Tool, perform the following steps.

Task:

To delete a command-line configuration from an existing tool:

1.

E

From the Tools Tab, right-click the tool from which you want to remove the configuration in the Tools Gallery
and select Properties. The Tool Properties dialog box is displayed.

Click the Configuration tab.
Select the configuration you want to remove and click Delete.

Click OK to close the Tool Properties dialog box.

Note * In AdminStudio, tools are any external application or file that you can launch from a workflow or project. This

typically is an application, but can be a simple document or batch file necessary to completing the project.

Associating Tools with Tasks

o

To associate a Tool with a Workflow task, perform the following steps.

Task:

118

To associate a tool with a task:

Click the Workflow Templates tab in the Interface.
In the Workflows tree, expand a Workflow to display all of its tasks.

From the Workflows tree, select the task with which you want to associate the tool. The Task Properties are
displayed.

From the Tool list, select the tool you want to associate with the task. If the necessary tool is not listed, select
<New Tool...> from the list to add the tool.

In the Tool Configuration list, select the configuration you want to use with the tool. If the configuration is not
listed, click Configure to create the new configuration.
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E

Note * In AdminStudio, tools are any external application or file that you can launch from a workflow or project. This

typically is an application, but can be a simple document or batch file necessary to completing the project.

Running Associated Tools in Projects

W

Task:

To run associated Tools in Projects, perform the following steps.

To run a tool associated with a task:
1. Select the Projects tab from the Interface.
2. Expand a Project in the Projects tree to display all of its tasks.

3. Right-click the task with which the tool is associated and select Run Task from the context menu.

E

Note * In AdminStudio, tools are any external application or file that you can launch from a workflow or project. This
typically is an application, but can be a simple document or batch file necessary to completing the project.

Deleting Existing Tools

o

To delete a Tool from the Tools Gallery, perform the following steps.

Task:

To delete an existing tool from the Tools Gallery:
1. From the Tools Tab, right-click the tool you want to delete from the Tools Gallery and select Delete.

2. Confirm the deletion.

E

Note * In AdminStudio, tools are any external application or file that you can launch from a workflow or project. This
typically is an application, but can be a simple document or batch file necessary to completing the project.
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Limiting Tool Accessibility

Edition * AdminStudio Enterprise Server is included in AdminStudio Enterprise Edition.
Accessibility of tools is determined by a user’s assigned Roles. If you want to modify an existing Role so that users

assigned to that Role can no longer access a specific tool, see Editing an Existing User Role in the Managing Roles
and Permissions section.

Workflows and Projects

Workflows, which can be created and modified from the Workflow Templates tab, are the basis for all projects in
AdminStudio. These workflows consist of defined tasks, with which instructions (in the form of HTML files) and
tools can be associated. Users can then create projects based on these workflows, and execute them—following
the specific steps defined in the workflow. This allows you to create specific, repeatable procedures to accomplish
your application migration goals.

Tip - If you update a workflow, all projects based on that workflow will reflect the changes made to the workflow.
The following topics relate to workflows and projects:

e Creating and Editing Workflows

e Creating and Using Projects

e  Saving Workflow and Project Changes

o Workflow Project Example: Using the New Workflow Project Wizard

e Workflows, Projects, and Permissions

Creating and Editing Workflows

120

Workflows serve as templates upon which projects are based. Typically, only a few individuals create workflows,
while others create projects and execute the projects to accomplish the workflow goal.

The following topics relate to creating and executing workflows:
e (Creating New Workflows

® Renaming Workflows

e Filtering Workflows

o Deleting Workflows

® (Creating New Tasks

e Modifying Task Properties
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® Creating Notes for a Task
® Renaming Tasks
® Reordering Tasks
® Associating Help Files with Tasks
e Deleting Tasks

e Adding New Tools from the Workflow Templates Tab

Creating New Workflows

&

Task: To create a new workflow:

1. Click the Workflow Templates tab in the Interface. The Workflow Templates tab appears.
2. Right-click in the Workflows tree pane and select New Workflow. A new Workflow is listed.

3. Provide a name for the workflow.

Renaming Workflows

4

Task: To rename an existing workflow:
1. Select the Workflow Templates tab in the Interface.
2. Right-click the workflow you want to rename and select Rename from the context menu.

3. Provide a new name for the workflow.

Filtering Workflows

4

Task: To display a specific workflow:

1. From the Interface, click the Workflow Templates tab.

2. From the drop-down menu above the Workflows tree, select the workflow you want to display.

AdminStudio 9.5 User Guide ADS-0950-UG00 121



Chapter 3: Using the AdminStudio Interface
Workflows and Projects

Deleting Workflows

%

Task: To delete an existing workflow:
1. Click the Workflow Templates tab in the interface.
2. From the Workflows tree, right-click the workflow you want to delete and select Delete from the context menu.

3. Confirm the deletion by clicking Yes in the resulting dialog box.

Creating New Tasks

%

Task: To create a new task:

1. Select the Workflow Templates tab in the interface.

2. Right-click the workflow to which you want to add the task and select New Task. Alternatively, right-click on a
task and select New Task to create a subtask.

A new task appears named NewTasknn, and the Task Properties view for that task is displayed.
3. Enter a name for the new task.

4. Modify properties for the task.

Modifying Task Properties
&

Task: To modify properties for an existing task:
1. Click on the Workflow Templates tab.

2. From the Workflows tree, select the task you want to modify. The Task Properties view for the selected task is
displayed.

3. Change Task Properties as necessary for the task.
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Creating Notes for a Task

o

Task: To create notes for a task:
1. Select the Projects tab in the Interface.

2. From the Projects tree, select the task to which you want to add notes. The Project Task Properties view
appears for the selected task.

3. Enter notes in the Notes field.

Q
Tip * You can also add notes to a task in the Workflow Templates tab. If you do, all projects based on that
workflow will use the notes you enter as the default notes for the specific task.

E

Note ° There is a 255 character limit on notes.

Renaming Tasks

o

Task: To rename an existing task:
1. Select the Workflow Templates tab in the Interface.
2. Right-click the task you want to rename and select Rename from the context menu.

3. Provide a new name for the task.

Reordering Tasks

o

Task: To change the task order:

1. Select the Workflow Templates tab in the Interface.
2. Inthe Workflows tree, select the task you want to move.

3. From the toolbar, click Move Up or Move Down to change the order in which tasks are performed. Click Move
Right to make a task a subtask of another task; click Move Left to promote a task.

4. Repeat the previous steps as necessary.
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Associating Help Files with Tasks

o

Task: To associate a help file with a task:
1. Click the Workflow Templates tab in the Interface.

2. From the Workflows tree, select the task with which you want to associate the help file. The Task Properties
view appears for the selected task.

3. Inthe Help File field, enter the name and location of the help file, or click Browse and navigate to it.

@ The help file can either be local, or you can use a URL (for example, http://www.mycompany.com/
myURL.htm).

® You can also click the Edit HTML button to the right of the Browse button to open a default HTML page in
an HTML editor as a starting point.

E

Note  Help files must be in HTML format.

Deleting Tasks

o

Task: To delete an existing task:
1. Select the Workflow Templates tab in the Interface.
2. In the Workflows tree, right-click the task you want to remove and select Delete.

3. From the resulting dialog box, click Yes to confirm the deletion.

Adding New Tools from the Workflow Templates Tab

%

Task: To add a new tool to the Tools list from the Workflow Templates tab:
1. Click the Workflow Templates tab in the Interface.

2. From the Workflows tree, select the task with which you want to associate the new tool. The Task Properties
view appears for the selected task.

3. From the Tool list in the Task Properties view, select <Add Tool ...>. The Add New Tool dialog box opens.
4. Inthe Add New Tool dialog box, enter properties about the tool.
5. Click OK.
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Creating and Using Projects

Projects, which are based on existing workflows, are the procedures followed to accomplish a set goal. Projects
may include instructions describing what to do, and perhaps links to tools necessary to perform tasks. They also
allow you to provide notes to help document issues that may arise during a project.

Tip - If you update a workflow, all projects based on that workflow will reflect the changes made to the workflow.

The following topics relate to creating and using projects:

Creating Workflows with the New Workflow Project Wizard
Filtering Projects

Executing Projects

Running Associated Tools in Projects

Deleting Projects

Creating Workflows with the New Workflow Project Wizard

o

Task: To create a workflow using the New Workflow Project Wizard:

1. Launch AdminStudio.

2. Click the Projects tab.

3. Right-click in the Projects tree and select New Project. The New Workflow Project Wizard launches.

4. From the Welcome Panel, click Next. The Workflow Selection Panel appears.

5. From the Workflow Selection Panel, select the workflow on which you want to base the new project.

6. Provide a name for the new project and click Next. The Source Package panel appears.

7. From the Source Package Panel, specify the name and location of the source package used in this project.
Alternatively, click Browse to navigate to it.

8. Click Next. The Target Directory and Filename panel appears.

9. From the Target Directory and File Name Panel, specify the Target Directory in which you want to store all
files associated with this project.

10. In the Target File Name field, provide a name for the output file. Depending on the task being executed, the
appropriate extension will be added to the file name.

11. Click Finish. The new Workflow is now listed.
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Filtering Projects

%

Task: To display a specific project:
1. From the Interface, click the Projects tab.

2. From the drop-down menu above the Projects tree, select the project you want to display.

Executing Projects

Task: To execute a project:

1. From the Interface, click the Projects tab.

2. Display the project you want to execute. If you want to only display that project, use the filter above the
Projects tree.

Click the first task in the project.
Perform the task.

When finished with the task, click the box to the left of the task.

o g s o

Repeat for subsequent tasks in the project.

Running Associated Tools in Projects

%

Task: To run a tool associated with a task:
1. Select the Projects tab from the Interface.
2. Expand a Project in the Projects tree to display all of its tasks.

3. Right-click the task with which the tool is associated and select Run Task from the context menu.

E

Note - In AdminStudio, tools are any external application or file that you can launch from a workflow or project. This

typically is an application, but can be a simple document or batch file necessary to completing the project.
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Deleting Projects

W

Task: To delete an existing project:
1. Click the Projects tab in the Interface.

2. From the Projects tree, right-click the project you want to delete and select Delete Project from the context
menu.

3. Confirm the deletion by clicking Yes in the resulting dialog box.

Saving Workflow and Project Changes

Because AdminStudio uses a database (the Application Catalog) to store information involving Workflows and
Projects, all changes are stored immediately. There is no need to “save” your modifications; AdminStudio performs
this automatically.

Workflow Project Example: Using the New Workflow
Project Wizard

The following basic example covers creating a workflow and project which takes advantage of command-line
functionality available in AdminStudio.

Prior to creating projects, you must create a workflow on which to base the project. This workflow might involve few
steps, or it might cover as broad of a task as repackaging a legacy installation, editing it in InstallShield Editor,
customizing it in Tuner, performing application isolation, identifying and resolving conflicts, distributing it, and
entering information about it into a third-party tracking system.

In this example, you are going to create a basic workflow involving two steps: repackaging a legacy installation and
opening the resulting InstallShield Editor project.

Creating a New Workflow

Task: To create a new workflow:

-t
.

Launch AdminStudio.

Click the Workflow Templates tab in the Interface. The Workflow Templates tab appears.
Right-click in the Workflows tree pane and select New Workflow. A new Workflow is listed.
Name the workflow My Workflow Example.

Right-click My Workflow Example and select New Task.

o o & 0 N

Name the task Repackage a Legacy Setup.
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10.

11.

12.

With the Repackage a Legacy Setup task selected, from the Task Properties pane, select Repackager from the
Tool menu. This associates Repackager with this task.

Change the Tool Configuration to Repackage a legacy setup. This associates a predefined command line (-
app "[SourcePackage]" -o "[TargetDir]" -pp "[TargetFileName]") with this task.

Right-click My Workflow Example and select New Task.
Name the task Open the Repackaged Setup.

With Open the Repackaged Setup selected, from the Task Properties pane, select Editor from the Tool menu.
This associates InstallShield Editor with this task.

Change the Tool Configuration to Edit an InstallShield Editor project created with Repackager. This associates
a predefined command line (-"[TargetDir]\[TargetFileName].1ism") with this task.

Creating a Project Based on the Workflow

Task:

128

To create a project based on your new workflow:

1.

2
3.
4

4

10.

11.

Click the Projects tab.
Right-click in the Projects tree and select New Project. The New Workflow Project Wizard launches.
From the Welcome Panel, click Next. The Workflow Selection Panel appears.

From the Workflow Selection Panel, select My Workflow Example as the workflow on which you want to
base the new project.

Name the new project My Sample Project and click Next. The Source Package panel appears.
From the Source Package Panel, click Browse and navigate to the following directory:
AdminStudio Installation Directory\Tutorial\Repackager\PackageForTheWeb 3

Select PackageForTheWeb3. exe and click Open. This value (the directory and package name) are stored in the
SourcePackage variable, which is used by the command line in Repackager set when you created the
workflow.

Click Next. The Target Directory and File Name Panel opens.

From the Target Directory and File Name panel, specify the directory where you want to store files associated
with your project. For this example, use C:\AdminStudio Shared\Test\WorkflowExample This value is written
to the TargetDir variable used in the command line set for InstallShield Editor when creating the workflow.

Set the Target File Name to WorkflowProjectEx. This value is written to the TargetFileName variable used in
the command line set for InstallShield Editor when creating the workflow.

Click Finish. The new Workflow Project is now listed.
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Running the Workflow

Task: To run the workflow:

1. Expand the workflow My Sample Project in the Projects tree.
2. Right-click the task Repackage a Legacy Setup and select Run Task.<

When Repackager launches, it reads the value SourcePackage to determine the file to repackage. It also
reads TargetDir and TargetFileName to determine where to place the output and what to call the output file.

3. After completing the steps above, right-click on the second step in the project and run the associated tool.
InstallShield Editor launches, and opens the project file (.1ism) created by Repackager.

Summary

This is just a brief example of how AdminStudio tools can be made aware of each other during a project. When
crafting workflows, create command lines to streamline your projects.

Workflows, Projects, and Permissions

AdminStudio interface functionality (including workflows, projects, and the Tools Gallery) is directly influenced by
user authorization and permissions. For example, Administrators can see all users and projects assigned to those
users in AdminStudio. In the case of NT Groups, Administrators can see individual members of those groups in the
Projects tab. Further, Administrators can assign projects to users when running the New Workflow Project
Wizard.

An example of how permissions affect workflows and projects is the display of the Workflow Templates tab,
which requires the View Workflow Tab permission. Likewise, only users with the Create Project permission can
create projects. Even if you have permission to view and create workflows, you can only associate tools which you
are permitted to use with tasks you create. If you are executing projects, you can only launch tools you have
permissions to use, regardless of whether they are associated with a task in the workflow.

For more information, see Managing Roles and Permissions.
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Frequently Asked Questions

130

The following is a list of questions frequently asked by AdminStudio users, including a link to the appropriate help
topic.

General & Workflow

e How do | add a new tool to the Tools Gallery? See Adding New Tools to the Tools Gallery.

e How do | add a command line configuration to a tool? See Adding Command-Line Configurations for an
Existing Tool.

e How do | specify a default Application Catalog? See Specifying a Default AdminStudio Application Catalog.

Application Isolation Wizard

e How do | isolate applications? See Isolating Applications Using Application Isolation Wizard.

e How do | modify the default isolation recommendations? See Modifying the Default Isolation
Recommendations.

ConflictSolver

e What types of conflicts can ConflictSolver detect? See Identifying and Resolving Application Conflicts Using
ConflictSolver.

e How do | change which conflicts are checked? See Changing Default Conflict Types Checked.
e How do | validate a package? See Validating Packages.
e How do | identify conflicts? See Checking for Conflicts Using the Conflict Wizard.

e How do | automatically resolve conflicts? See Automatically Resolving Conflicts.

Tuner
e What should | do If MSI prevalidation fails? See Handling Invalid Windows Installer Packages.
e How do | prevent a feature from displaying during custom installation? See Changing a Feature’s Visibility.

® When should | use the Dialogs View instead of MSI command-line options? See Dialogs View vs. Command-
Line Options.

e How do | create a setup.exe file for my package and transform? Creating a Setup.exe File for the Package and
Transform.

® When do | use Tuner vs. InstallShield Editor? See Customizing Installations Using Tuner.

Repackager
e Why do people use a Repackager? See Repackaging Legacy Installations Using the Repackaging Wizard.
e \Why is a “clean” system important for repackaging? See About Repackaging on Clean Systems.

e Should | repackage a Windows Installer (.msi) setup? See Repackaging Wizard Best Practices.
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How do | repackage a non-Windows Installer setup? Repackaging Legacy Installations Using the
Repackaging Wizard and Converting Legacy Installations Using the Repackager Interface.

How can | speed up repackaging? See Repackaging Wizard Best Practices.

What can | do with a repackaged setup? See Repackaging Legacy Installations Using the Repackaging
Wizard and Converting Legacy Installations Using the Repackager Interface.

Where does Repackager store my repackaged files and the MSI packages it builds? See Set Target Project
Information and Capture Settings Panel.

How do | identify and fix WinINSTALL conversion problems? See Troubleshooting Guidelines for WinINSTALL
Conversion.

How do | identify and fix SMS conversion problems? See Troubleshooting Guidelines for SMS Conversion.

What do | do if | receive a ISDEV: fatal error -5023: Error building table file error while using
Repackager? See Resolving an “Error Building Table File” Error.

Distribution Wizard

How do | create an administrative installation? See Creating Administrative Installations for Packages.

OS Snapshot Wizard

Why do | need an OS Snapshot? See Taking OS Snapshots.

InstallShield Editor

Answers to common questions regarding InstallShield Editor can be found under Frequently Asked Questions
in the InstallShield Editor Help Library.

AdminStudio Interface Reference

The AdminStudio interface reference is organized into the following areas:

AdminStudio Start Page
Assistant Tab

Tools Tab

Workflow Templates Tab

Projects Tab

Enterprise Server Tab
AdminStudio Menus and Toolbar
Dialog Boxes

Wizards
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AdminStudio Start Page

The AdminStudio Start Page provides quick access to product information, to recently opened files, and to
InstallShield resources.

AdminStudio Views

The AdminStudio interface is organized into the following tabs, which appear across the top of the Start Page:

(] Start Page l". Assistant l # Tools l @] Projects l [ workflow Templates l B Enterprise Server l

Figure 3-3: AdminStudio Interface Tabs

Click on these tabs to access the following AdminStudio views:
e Start Page—Initial view of AdminStudio.

e Assistant—The Process Assistant, a procedure-based alternative interface to the standard AdminStudio
interface, is accessible on the Assistant Tab.

® Tools—The Tools Tab includes the Tools Gallery and information on the selected tool.

e Workflow Templates—On the Workflow Templates Tab, you can create and modify workflows, which are the
basis for all projects in AdminStudio.

® Projects—On the Projects Tab, you can create, execute, and delete projects, and access existing projects,
which are the procedures followed to accomplish a set goal.

e Enterprise Server—On the Enterprise Server Tab, you can use Job Manager to automate tasks and Report
Center to generate reports. You can also manage Users, Roles, and Permissions.

Tools Gallery

You can launch each tool in the AdminStudio suite by clicking on the appropriate icon in the Tools Gallery.

Use the Process Assistant to guide wou through the pre-deployrment and application

&)
h configuration process,

& FRepackager B cdior

p ConflickSokver 'ih GualityMonitor

@ PackageExpert @ Distribution Wizard
|'_'] Repork Center dﬂ Security Console

Figure 3-4: Tools Gallery on the AdminStudio Start Page
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E

Note -« Individual AdminStudio applications can also be launched by double-clicking on the tool in the Tools Gallery
on the Tools Tab. See Tools Tab.

Application Tasks and Help Topics

Click on an Application Task to quickly launch the Process Assistant task for packaging a setup, customizing a
setup, identifying and resolving application conflicts, ensuring package quality, or preparing packages for
distribution. Frequently accessed Help Topics are also listed. To access the entire AdminStudio Help Library from
the Start Page, click the Help Library link in the Resources section or click the Help button in the toolbar.

f 30 i
Fi ::;Tslt;irﬂm Process ¥ Package a sstup
3] How do T launch [ Customnize a packags

= -
AdminStudio Tools? B3 [dentiy and reschee

F How do T specify a default applcation conflicks
¥
AdminStucko cakahog?

#| How do I identify and ;
B resobe spplic stion 'Fi Prepare package for
confhobsy distribution

s Ersure package quality

Figure 3-5: Help Topics and Application Tasks Areas

(Recently Opened Files)

The section in the middle of the Start Page lists your most recently accessed files, the task you were performing
with that file, and the dates on which they were last modified. Click on a file to quickly launch the Process Assistant
task and continue processing that file.

Resources

The Resources section contains a number of links to connect you to helpful InstallShield information and
InstallShield’s responsive customer support.

Contact Us

To provide feedback about InstallShield or join our Customer Experience Improvement Program, click one of the
links listed here.
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Assistant Tab

The Assistant Tab is the Welcome page to the AdminStudio Process Assistant, a procedure-based alternative
interface to the standard AdminStudio interface. It guides you through the process of preparing a new application
for enterprise use including packaging and feature customization, conflict resolution, QA testing, and deployment
hand-off.

The ConflictSolver Process Assistant, which is integrated into the main Process Assistant but which can also
be launched separately, guides you through the process of identifying and resolving conflicts between Windows
Installer Packages.

E

Note * For more information, see Using the Process Assistant,
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Tools Tab

The Tools tab, which is accessed from the AdminStudio Start Page, includes the Tools Gallery and the Content
Pane.

Tools Gallery

You can launch each tool in the AdminStudio suite by double-clicking on the appropriate icon in the Tools Gallery.

Individual AdminStudio applications can also be launched by clicking on the tool in the Tools Gallery on the Start
Page:

Catalog View Took Help

S| = « + | @

[ start Page ] & Assistant P Tools lmProjects ] @’Workﬂow Templates 1

(5 - Identify & Resolve Conflicts

Overvisw Repackager

4 V ConflictSolver provides sdministrators & means of locating and reporting diffsrent types of conflicts that may
5 exist between Windows Installer packages. Using this information, administrators can make appropriate

w modifications to resolve these issues. ConflictSolver allows you to check for a variety of conflict types, including

file, component, and registry conflicts. In many cases, ConflictSalver can resalve the issues automatically.

Editor Conflictsoher
< L Application =
7& @ Windaws Installir Packages EA Marisger ConflictSolver
05 Snapshots
QualityMonitor  PackagsExpert B TR

.al"ﬂ: Conflict analysis
‘ - between a package and
B (7 [ scrobat b

its target workstation
@ DPthsho g V Conflict resolution.
rl ] A winax P 5 .
Distribution Wizard  Application = -
Manager s
* E
©
ul @ 0 | 5
Report Centsr  Sseurity Consols Merge Modules
Adthoc [mport L
oo mpor B nuics
= MDAC26 ! S
= Patches & Transforms 5QL Server or Oracle
@ i sl e or
Job Managsr Job Manager &M“ 1185 photoshop.msp — Resolve in Resolve Using
Engine [ | =y f I Original .msi Transforms
| P
:A msoffice.mst | | ¥ i "] "]
o | ¥ ' J
T = A
05 Security Patch FLEXmrap L Software Repository -msi E st
Wizard

@ ConflictSolver is included with Adminstudio Professional and Enterprise Editions,

0S Snapshot  Application Isolstion %

Done

Figure 3-6: Tools Gallery on the Tools Tab

E

Note - If a core AdminStudio tool is not in the Tools Gallery or available from the menu, it may mean an
administrator has restricted tool access based on user permissions.

By right-clicking in the Tools Gallery, you can launch the Add Tool Wizard, from which you can add new tools into
the gallery and make them available for task assignments in workflows and projects.
Content Pane

The first icon in the Tools Gallery, Overview, is selected by default. When selected, the Content Pane lists a
description of each of the AdminStudio tools. If you single-click on an AdminStudio tool icon in the Tools Gallery on
the Tools tab, additional information about the selected tool is displayed in the Content Pane.
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Workflow Templates Tab

Tasks

136

Workflows, which can be created and modified from the Workflow Templates tab, are the basis for all projects in
AdminStudio. These workflows consist of defined tasks, with which instructions (in the form of HTML files) and
tools can be associated. Users can then create projects based on these workflows, and execute them—following
the specific steps defined in the workflow. This allows you to create specific, repeatable procedures to accomplish
your application migration goals.

Once you create a workflow, you can add tasks to it. Tasks are discrete steps in your overall process. Each task
has the following configurable options:

Table 3-3 ¢ Task Options

Option Description

Tool If needed, you can pick a tool to associate with the task. When a user runs the
workflow, the tool can be launched from the workflow step. By default, the
AdminStudio tools are included in this list. If you have added tools to the Tools Gallery,
they also appear in this list. If you want to add a tool directly from the Workflow
Templates tab, select the <New Tool> option to display the Add New Tool dialog box.
This adds the tool to the Tools Gallery and makes it available for the current task.

E

Note - If, after adding a new tool for a task that is not included in the Tools Gallery, you assign a
different tool or no tool to the task, the tool you added will no longer be available. To avoid this,
when possible, add tools to the Tools Gallery

Tool Configuration This list contains all available command-line configurations for the selected tool. If you
do not need a configuration, select <None>. Click Configure to add new
configurations to the tool, which you can then select from this list.

Help File You can associate a help file (in HTML format) with the task to provide instructions for
performing the task. Enter the path and help file in this field, or use the Browse button
to navigate to it. If you have yet to create an HTML page, click the Edit HTML button to
the right of the Browse button to open a default page in an HTML editor.

Notes Add any notes you want associated with this task. This field can only hold 255
characters, so additional information should be added to your help file.
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Projects Tab

Purpose

From the Projects tab, you can create, execute, and delete projects. You can also access existing projects. The
drop-down filter above the Project pane allows you to view all available projects, or only a specific project.

Each project must be based on an existing workflow. In this way, projects are similar to photocopies from a master
instruction sheet—all planning and design of the procedure is done to the workflow. The project is a copy of that
workflow, and multiple projects can be based on the same workflow if you are performing the same procedure.
Integration with AdminStudio Workflow Manager

AdminStudio Workflow Manager is a Web-based application that manages the application lifecycle, incorporating
standards (data) and methodologies (process). AdminStudio Workflows and Workflow Manager Workflows can be
integrated, so that an AdminStudio Project can be a Workflow Phase in a Workflow Manager Workflow.

When an AdminStudio Project is linked to a Workflow Manager Workflow, please note the following indications on
the Projects tab:

e When an integrated AdminStudio project is selected on the Projects tab, the name of its associated Workflow
Manager Application is displayed in the Project Properties.

e When an AdminStudio Project is linked to a Workflow Manager Workflow and the workstation is not currently
connected to the Workflow Manager Server, the following icon appears in the bottom right of the Projects tab
view:

E 4

Enterprise Server Tab

Edition * The Enterprise Server tab is available in AdminStudio Enterprise Edition.

AdminStudio Enterprise Server is a security console and set of Web tools that are closely integrated with
AdminStudio. The Enterprise Server tools include the Security Console, Job Manager, Report Center, Configuration
Manager Web Console, and Workflow Manager. For more information, see the following topics:

® Generating and Viewing Reports in Report Center

e Automating Tasks Using Job Manager

e Distributing Packages Using Configuration Manager Web Console
e Managing Roles and Permissions

e Managing Users, Directory Services, and User Logins
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Workflow Manager Tab

AdminStudio Workflow Manager is a Web-based application that manages the application lifecycle, incorporating
standards (data) and methodologies (process). AdminStudio Workflows and Workflow Manager Workflows can be
integrated, so that an AdminStudio Project can be a Workflow Phase in a Workflow Manager Workflow.

If you have purchased AdminStudio Enterprise Edition and Workflow Manager, the Workflow Manager icon will be
displayed in the AdminStudio Tools Gallery on the AdminStudio Tools tab and will be available as a tab on the
AdminStudio Enterprise Server interface.

E

Note ° For more information on Workflow Manager, see Using Workflow Manager to Manage Enterprise
Software Packaging in the AdminStudio Enterprise Server Help Library.

AdminStudio Menus and Toolbar

The following commands and toolbar buttons are available in the AdminStudio interface.

Table 3-4 « AdminStudio Menus and Toolbar

Menu Command Shortcut Button @ Description
Catalog Connect Ctrl+0 Displays the Connect Application Catalog Dialog
— Box, where you can open an existing SQL Server
Application Catalog or the AdminStudio Enterprise
Server Application Catalog.

Catalog Create Ctrl+N l_] Displays the Application Catalog Wizard, where you
can create a new SQL Server Application Catalog
database.

Catalog Disconnect Ctrl+D Closes the currently open Application Catalog.

Catalog Properties Opens the Application Catalog Properties Dialog
Box where you can configure the Software
Repository.

Catalog Change AES Change the password of the current user to log in

Password to the AdminStudio Enterprise Server.

Catalog Logout Log out of the AdminStudio Enterprise Server.
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Menu Command Shortcut Button @ Description

Catalog Replication Ctrl+R Use to access the SQL Server Application
Catalog Replication feature. These menu items
are selectively enabled depending on whether the
current user is connected to an SQL Server
database and has been assigned sysadmin
privileges in SQL Enterprise Manager on that
database server. If the open database is a
Subscriber database, the Subscription Manager
option will be enabled, and if it is a Publisher
database, the Publication Manager option will be
enabled.

Catalog Exit Alt+C+X Exits AdminStudio and returns you to the Windows
desktop.

View Toolbar Alt+V+T Toggles the Toolbar.

View Status Bar Alt+V+S Toggles the Status Bar.

View Always On Top Alt+V+A 1 When checked, the AdminStudio Interface remains
on top of all other windows.

View Start Page Select to open the AdminStudio Start Page.

View Process Select to open the Welcome Page of the Process

Assistant Assistant.

View Tools Select to open the Tools tab, which includes the
Tools Gallery and information on the selected tool.

View Projects Select to open the Projects tab. Projects, which are
based on existing workflows, are the procedures
followed to accomplish a set goal.

View Workflow Select to open the Workflow Templates tab, where
you can create and modify workflows. Workflows
serve as templates upon which projects are based.

Tools Check for Alt+T+U Start the Update Service to determine if there any

Updates updates or messages available for AdminStudio.

Tools Options Alt+T+0O Displays the Options dialog box, from which you
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Table 3-4 « AdminStudio Menus and Toolbar (cont.)

Menu Command Shortcut Button Description
Help Contents Alt+H+C @ Launches the online Help Library and displays the
Contents tab.
Help Index Alt+H+I B Launches the online Help Library and displays the
* Index tab.
Help Search Alt+H+S ) Launches the online Help Library and displays the
& Search tab.

Help Support Alt+H+U Connects to the AdminStudio Support Web site.
Central

Help Web Alt+H+M Connects to the AdminStudio Web Community.
Community

Help ReadMe Alt+H+R Displays the AdminStudio Release Notes file.

Help Feedback Alt+H+F Connects to an online form, through which you can

provide feedback about AdminStudio.

Help AdminStudio Alt+H+W H Connects to the AdminStudio Web site.
on the Web

Help About Alt+H+A Displays the About dialog box with version
AdminStudio information for AdminStudio.

Context New Workflow Create a new Workflow.

Menu

Context New Task Create a new Task.

Menu

Context Rename Rename selected Workflow or Task.

Menu

Context Delete Delete selected Workflow or Task.

Menu

Context New Project Ctrl-P Create a new Project.

Menu

Context Del Project Delete selected Project.

Menu
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Menu Command Shortcut Button Description

Context Run Task i Runs the tool associated with the selected task in
Menu * the project.

Context Move Up . Moves the selected task up in the task order.
Menu

Context Move Down 3 Moves the selected task down in the task order.
Menu

Context Move Left - Moves the selected task left in the task order.
Menu

Context Move Right - Moves the selected task right in the task order.
Menu

Dialog Boxes

The following dialog boxes can be opened from the AdminStudio Interface:

e Add New Tool Dialog Box

About AdminStudio Dialog Box

e Command Line Properties Dialog Box

e Options Dialog Box

® Tool Properties Dialog Box

About AdminStudio Dialog Box

The About AdminStudio dialog box can be opened by selecting About AdminStudio from the Help menu. This
dialog box displays information about the product, including the full version number (essential if you need
technical support). If you have not registered AdminStudio, click the Register button to connect to the
InstallShield Web site to begin the Product Registration process. Registering your product offers you expert
technical support, new product announcements and special offers, plus notification of product upgrades.
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Add New Tool Dialog Box

The Add New Tool dialog box is displayed if you select <New Tool> from the Tool list while designing a workflow.
This dialog box allows you to provide information about a tool you want accessible from AdminStudio, particularly
to use in workflow tasks.

This dialog box contains the following options:
Table 3-5 * Add New Tool Dialog Box Options

Option Description

Target Enter the location of the tool or Browse to the application or file you want added
to the tools pane for use in AdminStudio.

Name in Tools Gallery This description is used as the display name for the application in the Tools
Gallery.

Command Line Enter any command-line arguments for the tool. Because you may have different

Arguments uses for applications, you can add the same application multiple times to the

tools pane, with each instance using different command line arguments.

Working Directory If this tool requires a working directory, enter it here or click Browse to locate it.
Comments Enter any comments about this tool in this field.
HTML Explanation File Enter the location and name of an HTML file you want displayed when you

single-click on the tool in the tools pane. Alternatively, click Browse and navigate

to it. If you have yet to create one, click the Edit HTML button ([i]) below the field
to open a default page in an HTML editor:

Add to Tools Gallery When this box is checked, the tool will be added to the Tools Gallery. If
Check Box unchecked, it is only available for the task where it was added.
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Command Line Properties Dialog Box

The Command Line Properties dialog box is displayed when you create or edit a command-line configuration for a

tool.

The Command Line Properties dialog box has two configurable options:

Table 3-6 » Command Line Properties Dialog Box Options

Option

Description

Description

Provide a description for the configuration. This assists you in differentiating similar
command-line options.

Command Line

Options Dialog Box

Provide the actual command-line parameters for the tool. The arrow to the left allows you
to select one of the following variables to include in the command-line:

e InstallLocation—The location where AdminStudio is installed.

e DevLocation—The location where InstallShield Editor is installed.

e SharedPoint—The AdminStudio shared directory.

e SourcePackage—The name and location of the source package.

e TargetDir—The directory where output from the selected project is stored.

® TargetFileName—The name of the output file.

® ProjectName—The name of the current project.

From the Options dialog box, you can configure settings including application catalog settings, shared locations
settings, and the frequency AdminStudio checks for updates. The dialog box consists of the following tabs:

e Application Catalog Tab

® |Locations Tab

e Updates Tab

e \Virtual Packages Tab

e Quality Tab: Customer Experience Improvement Program
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Application Catalog Tab

From this tab, you can configure the following options:

Table 3-7 » Options Dialog Box/Application Catalog Tab Options

Option

Shared AdminStudio
Application Catalog

Description

This field displays the name and location of the shared AdminStudio
Application Catalog. Click the Change button to select another
Application Catalog using the Select Application Catalog Dialog Box.

AdminStudio Enterprise Server | Enter the URL for the AdminStudio Enterprise Server, available in the

URL AdminStudio Enterprise Edition.
Make this the default shared If you have more than one AdminStudio Enterprise Servers, select this
AES URL option to make the URL in the AdminStudio Enterprise Server URL

field the default.

Allow automatic authentication | Select this option to allow automatic authentication by AdminStudio

Install AES

Locations Tab

144

Enterprise Server.

If AdminStudio Enterprise Server is not installed and you want to install it
on this machine, click this button to launch the installation.

From this tab, you can configure the following options:

Table 3-8 * Options Dialog Box/Locations Tab Options

Option

Description

AdminStudio Shared
Location

Task Help Page
Location

Configuration Manager
Web Console URL

Enter or browse to the shared location for AdminStudio. This location will contain
shared information for repackaging and conflict identification. To maintain
consistency when creating workflows, it is recommended that you set this shared
location the same for each AdminStudio seat.

Tip » The AdminStudio Shared Location is defined during installation and normally does
not need to be changed. It is usually assigned to a network folder, preferably a UNC path.

Enter or browse to the directory where you want to store all HTML pages that
serve as workflow task instructions.

Enter the URL for the Configuration Manager Web Console Web site.
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Updates Tab
You can configure the following options from this tab:

Table 3-9  Options Dialog Box/Updates Tab Options

Option Description
Check for software Specify how often you want AdminStudio to check for updates. Your options are:
updates

® Never

e Once every 15 days
e Once every 30 days (default)

e Once every 60 days

Virtual Packages Tab

On the Virtual Packages tab, you can control which of the available virtual package formats are displayed in the
AdminStudio toolset—Microsoft App-V, VMware ThinApp, and/or Citrix XenApp—and you can choose whether to
include the App-V Application Launcher with App-V applications.

Application Catalog | Locations | Updates | Guality | Yirtual Packages

AdminStudio supports corverting YWindows Inztaller packages to the following wirtual package formatz, vou
may chooze to hide a particular format throughout the AdminS tudio toolset by unchecking the appropriate
option. You may not dizable all options.

Show the following formats:
Microzoft &pp
Whware Thindpp
Citris =endpp

App Y Options

Create utility to test launch App applications as part of building App- applications.

I [1]4 ][ Cancel ][ Help

Figure 3-7: Virtual Packages Tab of the Options Dialog Box
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The Virtual Packages tab of the Options dialog box has the following options:

Table 3-10 * Virtual Packages Tab of the Options Dialog Box

Option

Microsoft App-V

Description

Select to display all Microsoft App-V virtual package format options throughout
AdminStudio and InstallShield Editor. If this check box is not selected, the options for
the virtual package format will be hidden.

VMware ThinApp

Citrix XenApp

Select to display all VMware ThinApp virtual package format options throughout
AdminStudio and InstallShield Editor. If this check box is not selected, the options for
the virtual package format will be hidden.

Select to display all Citrix XenApp virtual package format options throughout
AdminStudio and InstallShield Editor. If this check box is not selected, the options for
the virtual package format will be hidden.

Create utility to test
launch App-V
applications as part
of building App-V
applications.

0

Select this option to include the App-V Application Launcher with each App-V
application that you build. You can use the App-V Application Launcher to locally test
a newly built App-V application before moving it to a deployment server. For more
information, see Testing App-V Applications Using the App-V Application Launcher.

E

Note - This option is only visible when the Microsoft App-V format is selected.

Important  You may not disable all options.

Quality Tab: Customer Experience Improvement Program
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The Customer Experience Improvement Program (CEIP) helps AdminStudio improve the quality, reliability and
performance of our software and services.

If you choose to participate in the Customer Experience Improvement Program, we will collect anonymous
information about how you use AdminStudio. This information helps us identify trends and usage patterns.

All information collected is anonymous, and this data collection will not affect the performance of AdminStudio
tools. You will never be prompted to complete a survey, and no one from our company will contact you. You can
continue working with AdminStudio without interruption.

Your membership status in the Customer Experience Improvement Program is specified on the Quality tab of the
AdminStudio Options dialog box. If you initially select to participate but later you change your mind, you can opt-
out of this program by changing the selection on the Quality tab.
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Options g|

Application Catalog || Locations | Updates | Quality
Custarmer Experience Improvement Program

‘wie invite pou ta join our Customer Experience Improvernent Program to inprove the quality,
._-‘-i.,) reliability, and performance of Macrovision software and services.

If you accept, we will collect anonymous information about how you use our software and
services to identify brends and usage patterns.

We will not collect your name, address, or any other personally identifiable information. There are
no surveys to complete, no salesperson will call, and you can continue working without
interruption. [t iz simple, user-friendly, and completely anonymous.

You can leave this program at any time by clicking Tools | Options to return to these settings,

ez, | am wiling to participate anonymausly in the Customer Experience |mpravement
rogram, (Fecommended)

o, | don't wish to participate.

Eead more sbout the Customer Esperience Improvement Proram

[ Ok, ] l Cancel ] l Help

Figure 3-8: Quality Tab of the AdminStudio Options Dialog Box

Participation in the Customer Experience Improvement Program is not mandatory, but your input is appreciated.

For more information on the Customer Experience Improvement Program, visit the AdminStudio Web Site.

Tool Properties Dialog Box

The Tool Properties dialog box is displayed when you right-click on a tool in the Tools gallery and select Properties.
This dialog box contains the following tabs:

® Properties Tab

e Configuration Tab

Properties Tab

The Properties tab of the Tool Properties dialog box contains information about the tool, including the name and
location of the executable, the name of the tool as it appears in the Tools gallery, and the help file associated with it
(if any).

The following options can be configured:
Table 3-11 * Tool Properties Dialog Box/Properties Tab Options

Option Description

Target Enter the location of this tool’s executable. Alternatively, click Browse and
navigate to it.

Name in Tools Gallery Provide a name for the tool as it will appear in the Tools gallery.
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Table 3-11 ¢ Tool Properties Dialog Box/Properties Tab Options (cont.)

Option

Command Line
Arguments

Description

Enter any default command line arguments for this tool.

Working Directory
Comments

HTML Explanation File

If this tool requires a working directory, enter it here or click Browse to locate it.
Provide any comments about this tool.

Enter the location and name of an HTML file you want displayed when you single-
click on the tool in the tools pane. Alternatively, click Browse and navigate to it. If
you have yet to create one, click the Edit HTML button below the field (shown
below) to open a default page in an HTML editor:

Configuration Tab

From the Configuration tab of the Tool Properties dialog box, you can Add, Modify, or Delete command-line
configurations associated with the tool. Each tool can have multiple configurations associated with it, for different

uses.

Table 3-12 « Tool Properties Dialog Box/Configuration Tab Options

Option

Description

Command Line List

Listing of all command lines defined for this tool.

Add

Modify

148

Click to open the Command Line Properties Dialog Box, where you can add a new
command line. In the Description field, you provide a description for the
configuration. This assists you in differentiating similar command-line options. In the
Command Line field, you provide the actual command-line parameters for the tool.
The arrow to the left allows you to select one of the following variables to include in
the command-line:

e InstallLocation—The location where AdminStudio is installed.

e DevLocation—The location where InstallShield Editor is installed.

e SharedPoint—The AdminStudio shared directory.

e SourcePackage—The name and location of the source package.

e TargetDir—The directory where output from the selected project is stored.

e TargetFileName—The name of the output file.

® ProjectName—The name of the current project.

Click to open the Command Line Properties Dialog Box, where you can modify the
selected command line.
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Table 3-12 « Tool Properties Dialog Box/Configuration Tab Options (cont.)

Option Description

Delete Click to delete the selected command line.

E

Note » Most AdminStudio Tools have one or more command-line configurations already defined. Although you can
change or remove these configurations, there is no way to automatically reset them to their default values.

Ways to Assign a Command Line to a Tool
There are three ways a user can assign a command line to a tool:

e Tool Properties Panel of Add Tool Wizard—When you add a tool, you can assign a command line on the
Tool Properties Panel of the Add Tool Wizard.

o Properties Tab of the Tool Properties Dialog Box—When you view the tool’s properties, you can assign a
command line on the Properties Tab of the Tool Properties dialog box.

e Configuration Tab of the Tool Properties Dialog Box—Using the Configuration Tab of the Tool
Properties dialog box, you can create multiple command lines and can use AdminStudio variables in these
command lines. Then, when you go to the Workflow tab and create a new Workflow, you can associate a Tool
with a task and also select which command line configuration they want to use. Once you have done that, you
can go to Project tab and create a new Project. When you create a new Project, you will have to specify the
Source Package and the target directory and file name. Once the Project is created, when you execute the
task, AdminStudio will execute the command line configuration you previously selected by replacing the
AdminStudio variables in the command line.

E

Note - Acommand Line entered by the user in Properties Tab of the Tool Properties dialog box play no role in
the Workflow and Project tab. This command line is used only when you run the tool from the Tools Tab.
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Wizards

The AdminStudio interface includes the following Wizards:
e Add Tool Wizard

e New Workflow Project Wizard

Add Tool Wizard

The Add Tool Wizard allows you to add new tools that appear in the AdminStudio Tools gallery. You can specify the
tool’s executable, provide command-line options for the tool, and provide a link to information about the tool.

The Add Tool Wizard includes the following panels:
o Welcome Panel
® Tool Properties Panel

e Command-Line Configurations Panel

Welcome Panel

The Add Tool Wizard allows you to add new tools that appear in the AdminStudio Tools gallery. You can specify the
tool’s executable, provide command-line options for the tool, and provide a link to information about the tool.

Click Next to proceed to the Tool Properties Panel.

Tool Properties Panel

From the Tool Properties panel of the Add Tool Wizard, you can enter information about the tool you are adding to
the gallery.

You can configure the following options:

Table 3-13 * Add Tool Wizard/Tool Properties Panel Options

Option Description

Target Enter the location and name of this tool’s executable. Alternately, click Browse and
navigate to it.

Name in Tools Gallery Provide a name for the tool as it will appear in the Tools Gallery.

Command Line Enter any default command line arguments for this tool.
Arguments
Working Directory If this tool requires a working directory, enter it here or click Browse to locate it.
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Table 3-13 « Add Tool Wizard/Tool Properties Panel Options (cont.)

Option Description

Comments Provide any comments about this tool.

HTML Explanation File Enter the location and name of an HTML file you want displayed when you single-
click on the tool in the tools pane. Alternatively, click Browse and navigate to it.

If you have yet to create one, click the Edit HTML button below the field (shown
below) to open a default page in an HTML editor:

Command-Line Configurations Panel

From this panel, you can add command-line configurations for the tool. Each tool can have multiple command-line
configurations for different tool uses.

Click Add to add a new option from the Command-Line Properties dialog box. You can also click Modify to edit
the selected command-line option, or Delete to remove the selected option.

Click Finish to add the tool to the Tools Gallery; click Back to return to the Tool Properties Panel.

New Workflow Project Wizard

The New Workflow Project Wizard assists you in creating a new project based on an existing workflow. The values
you specify in this Wizard are stored in variables that can be accessed from tools, allowing for greater
interoperability in AdminStudio. The New Workflow Project Wizard includes the following panels:

e Welcome Panel
e Workflow Selection Panel
® Source Package Panel

e Target Directory and File Name Panel

Welcome Panel
The New Workflow Project Wizard assists you in creating a new project based on an existing workflow. The values

you specify in this Wizard are stored in variables that can be accessed from tools, allowing for greater
interoperability in AdminStudio.
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Workflow Selection Panel

From the Workflow Selection panel, you can specify the workflow on which you want to base this project. Available
workflows appear in the workflows window.

Select the workflow you want to use, and provide the name for the new project (which is stored in the ProjectName
predefined variable).

Source Package Panel

From the Source Package panel, you can specify the name and location of the source package used in this
workflow. If you are creating a repackaging project, this is usually an executable, such as Setup.exe. The source
package name and location is stored in the predefined variable SourcePackage.

E

Note * You must specify the name and location of a source package if it is required in the workflow (by using the
SourcePackage variable). For example, if the workflow specifies to launch a package with certain command-line
parameters, AdminStudio needs to know what package to launch.

Source packages can also be non-setup files. For example, if you are creating a simple workflow that involves
editing a Notepad file, the source package may be a .ixt file.

Target Directory and File Name Panel

152

From the Target Directory and File Name panel, specify the Target Directory and Target File Name used in
this project.

All output files (such as an INC file from Repackager or an MST file from Tuner) associated with the project will be
stored in the Target Directory, and the value for this directory can include a predefined variable such as
SharedPoint. The Target File Name is the name used for all files created by project tasks in this project, with the
appropriate extension appended to it depending on the file type. The Target Directory is stored in the predefined
variable TargetDir and the output file name is stored in the variable TargetFileName.

E

Note - If any workflow tasks use the TargetDir or TargetFileName variables, you must specify the target directory
and package name. For example, if the workflow specifies to save a task's output, AdminStudio needs to know

where to save it and what to call it.

Click Finish to close the Wizard.
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Log File Location

AdminStudio.log C:\Program Files\AdminStudio\9.5

predeploytest.log C:\Program Files\AdminStudio\9.5\PreDeployTest\Client
licwrapserver.log C:\Program Files\AdminStudio\9.5\FLEXWrap\Server
debug.log C:\Program Files\AdminStudio\9.5\FLEXWrap\Server
distributer.log C:\Program Files\AdminStudio\9.5\Common

islc.log C:\Program Files\AdminStudio\9.5\Repackager
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Part 2

Managing Users, Roles,
Permissions, Application
Catalogs

This part of the AdminStudio 9.5 User Guide includes the following chapters:
e Managing Users, Directory Services, and User Logins
e Managing Roles and Permissions

e Managing Application Catalog Databases
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Managing Users, Directory Services,
and User Logins

You can create a user account for each person that you want to have access to AdminStudio Enterprise Server, or
you can import users or groups of users from a Windows Active Directory or Novell eDirectory Directory Service.

You can also configure various login methods to best suit your needs: AdminStudio account login, domain account
login, single sign-on login, and guest account login.

Information is presented in the following main sections:
e Managing Users and Groups
® Managing Directory Services Configurations

e Managing User Logins

Managing Users and Groups

There are several methods for creating new users in AdminStudio Enterprise Server:

e Create a user account—Create a user account for each person that you want to have access to
AdminStudio Enterprise Server. See Creating a New User Account.

e Import Directory Service users—Set up a Windows Active Directory or Novell eDirectory Directory Service
Connection and import users from that Directory Service. See Importing Directory Services Users and Groups.

e Import Directory Service group—Set up a Windows Active Directory or Novell eDirectory Directory Service
Connection and import a group from that Directory Service. This allows you to provide dynamic access to all
of the members of that group as the members of that group changes. For more information, see Importing
Directory Services Users and Groups.

E

Note ° For more information on the methods for logging into AdminStudio Enterprise Server, and the how
authentication is performed, see Managing User Logins.
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Creating a New User Account

W

Task:

To create a new user account, perform the following steps.

To create a new user account:

0 ® N

Open AdminStudio Enterprise Server and open the Administration tab.
Open the Users & Groups tab. The User Administration page opens.
Click Add. The User Details view opens.

Select the new user's Company from the list.

Enter a User Name and a Password, with the User Name in the format of:
us ername@companyname .com

Optionally, enter the user’s Email address.

Optionally, enter a geographic Location that you can use to group users together, such as New York Office
or Midwest Region, etc. Assigning a geographical location to a user enables you to display this information in
reports.

All of the Roles that have been defined for the selected Company are listed. Select the Roles that you want to
assign to this user.

E

Note * The Roles that a user is assigned to determine what portions of AdminStudio Enterprise Server and
Workflow Manager functionality they will have access to. Therefore, you must assign at least one Role to a user.

Click Update to save your entries and close the User Details view, or click Update and Add New to remain
in the User Details view so you can add another user.

Importing Directory Services Users and Groups

158

If you have defined a Directory Service, as described in Adding a Directory Service Connection, you can choose to
add Users or Groups from that Directory Service into AdminStudio Enterprise Server.

When a user is added from a Directory Service into AdminStudio Enterprise Server, only information that uniquely
identifies the user in the Directory Service is stored in AdminStudio Enterprise Server. Information such as
telephone number and email address will always be queried at run time, so that the most current information is
obtained.

AdminStudio Enterprise Server supports Windows Active Directory and Novell eDirectory directory services.

E

Note * For more information on AdminStudio Enterprise Server support for Directory Services, see Managing

Directory Services Connections and Managing User Logins.
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Task: To import users or groups from a Directory Service into AdminStudio Enterprise Server:

1.  Open AdminStudio Enterprise Server and open the Administration tab.

2. Open the Users & Groups tab. The User Administration page opens.

3. Click Directory Service User/Group Import. The Directory Services User/Group Add view opens.

4. From the Select a Directory Service list, select the Directory Service that you want to import users or groups
from.

5. Next to Select Group or User, select the User or Group option.

6. Next to Filter Directory Service list, select one of the following options:

o Show All—Select this option to include all Users or Groups in the list.

e Filter list by—Select this option, enter text in the box, and click Find to filter the list by the specified
criteria.

For example, to search for all of the users that start with the letter B, use the asterisk wildcard character (*) and

enter P# in the Filter list by box.

7. From the Select Group or User to Add list, select the group or user to import to AdminStudio Enterprise
Server. The User Details view opens, providing a read-only view of the imported user or group’s User Name
and Password.

If you import a User that is a member of a Group that was previously imported, that User inherits the Roles that
are assigned to that Group. You can then assign additional Roles to that User.

8. Click Update to save your entries and close the User Details view, or click Update and Add New to remain

in the User Details view so you can add another user.

Disabling a User or Group Account

User and Group accounts have a status of Active or Inactive. If a User or Group has the status of Inactive, that
User or a member of that Group:

Cannot log into AdminStudio Enterprise Server.

Cannot be assigned any work.

Is not listed on the User Administration page.

Does not get any email notifications.

Cannot be selected as a Customer Contact or Servicer Contact.

Cannot be viewed by Customers.
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Deleting vs. Disabling a User Account

If a user is associated in any way with an open or completed Workflow Manager Application Request, you cannot
delete that user from the system. In that case, you would instead disable that account by setting its Status to
Inactive.

If a user IS NOT associated with an Application Request, you can delete that user. This means that if
you create a user by mistake, before that user has interacted with the application, you can delete it by opening
that user on the User Details view and clicking Delete.

If a user IS associated with an Application Request, However, since AdminStudio Enterprise Server
stores the IDs of users on actions and assignments for historical, tracking and reporting purposes, you cannot
delete a user that is associated with a Workflow Manager Application Request. In this case, you would set the
user’s Status to Inactive on the User Details view.

Task: To disable a user account:

0 ® Db

Open AdminStudio Enterprise Server and open the Administration tab.
Open the Users & Groups tab. The User Administration page opens.
Select the User or Group that you want to disable to open its User Details view.

Select Inactive from the Status list and click Update.

Deleting a User Account

You can delete a User or Group account from the User Details view.

&

Task: To delete a user account:

0 © Db

160

Open AdminStudio Enterprise Server and open the Administration tab.

Open the Users & Groups tab. The User Administration page opens.
Select the User or Group that you want to delete to open its User Details view.
Click Delete. You are prompted to confirm the deletion.

Click OK. The deleted User or Group is no longer listed on the User Administration page.
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Managing Directory Services Configurations

AdminStudio Enterprise Server can be integrated with Windows Active Directory and Novell eDirectory. This
enables you to set up automatic login with AdminStudio Enterprise Server based upon Directory Services
authentication.

If you import a Group, all members of that group could then login to AdminStudio Enterprise Server without
requiring you to import the individual members of the Group. AdminStudio Enterprise Server can then retrieve user
attributes, such as email address or telephone number, from the Directory Service dynamically.

e Directory Service Connections—Rather than creating a user account for each person who will use
AdminStudio Enterprise Server, you can import users from Windows Active Directory or Novell eDirectory
directory services. For information on integrating AdminStudio Enterprise Server with Directory Service users
and groups, see Managing Directory Services Connections.

e Directory Service Attributes—When creating a Workflow Manager Template, you can set a Data Element’s
Data Type to Directory Service. This means that when a Directory Service authenticated user performs the
Workflow Step that requests that Data Element, information is pulled from the Directory Service to
automatically populate the field, such as that user’s name, email address, or location. For information on
enabling the use of Directory Service Attributes, see Managing Directory Services Attributes.

E

Note * For more information about Directory Services and Lightweight Directory Access Protocol (LDAP), see
Ldp Overview on the Microsoft TechNet Web site.

Managing Directory Services Connections

Rather than creating a user account for each person who will use AdminStudio Enterprise Server, you can import
users from Windows Active Directory or Novell eDirectory directory services. To integrate AdminStudio Enterprise
Server with a Directory Service users and group, you set up a Directory Service Connection.

This section includes the following topics:
e Adding a Directory Service Connection
e Editing an Existing Directory Service Connection

e Deleting a Directory Service Connection

Adding a Directory Service Connection

Directory Services Connections are used to import users and groups into AdminStudio Enterprise Server, and to
authenticate Active Directory or eDirectory users logging into AdminStudio Enterprise Server.

You can choose to have a Directory Service listed in the Domain list on the AdminStudio Enterprise Server login
page. This enables users in this Directory Service to login to AdminStudio Enterprise Server using their enterprise
network credentials.
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W

Task:

162

To add a Directory Service connection, perform the following steps:

To add a Directory Service connection:

1.

2.

@

ol

On the Administration tab, click Directory Services. The Directory Services page opens.

Click Manage Directory Services Connections. The Directory Services List page opens.

Click Add. The Add Directory Service Connection view opens.

Enter the following information:

Option

Use to Authenticate
Users?

Directory Service
Name

Description

Select Yes to include this Directory Service in the Domain list on the
AdminStudio Enterprise Server login page. This enables users to login to
AdminStudio Enterprise Server using their enterprise network credentials.

You can create many Directory Service connections, but only those connections
that have this field checked will be listed in the Domain list on the AdminStudio
Enterprise Server login page.

E

Note < In an enterprise, there is usually only one Directory Service that is responsible for
authenticating users. However, you can create additional Directory Service connections to
import users and groups.

Enter a name to identify this Directory Service in the Domain list on the
AdminStudio Enterprise Server login page. It is recommended that the Directory
Service Name match the Domain Name.

Description

Enter a description of this Directory Service.

Directory Service
Type

Identify the type of Directory Service that you are adding a connection to:

e Active Directory

® Novell eDirectory

Directory Service
Host

Directory Service
Port

Enter the name or IP address of the Server on which this Directory Service is
running.

Enter the port number of the Server on which this Directory Service is running. By
default, AdminStudio Enterprise Server uses Port 389.

[0

Important » The value for the Directory Service Port should be the port on the given server
to which AdminStudio Enterprise Server should connect to send LDAP queries.
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Base Distinguished
Name

Domain Name

Use Secure Socket
Layer (SSL)?

Connect
Anonymously?

Admin
Distinguished Name
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Description

Enter the Base Distinguished Name (DN) to identify the root node of this Directory
Service.

For example, for MyCompany, the Base DN could be:

dc="MyCompany", dc="com"

Enter the Domain Name of this Directory Service. This Domain Name is used to
create the right credentials, along with the Admin User Name. For example, you

would enter DomainName\AdminUserName to connect to the specified Directory
Service.

E

Note * To upgrade from AMS 2.5, enter the same Domain Name that was used in AMS 2.5.
AdminStudio Enterprise Server will read this Domain Name and then try to authenticate the
User using this Directory Service. For single sign-on to work on an upgrade scenario from
2.5 to 4.0, administrators have to configure at least one Directory Service.

Select Yes if this Directory Service is configured to use Secure Socket Layer
(SSL).
Select No if you do not want to permit anonymous connections.

If you select Yes to permit anonymous connections, AdminStudio Enterprise
Server may not be able to authenticate Directory Service users and may not be
able to add Directory Service users/groups into AdminStudio Enterprise Server.

Enter the Distinguished Name of a user who has permission to retrieve users/
groups information and authenticate any user against this Directory Service.
Enter the Distinguished Name in the format of:

domainname\username
such as:

abcinc\jsmith

AdminStudio 9.5 User Guide

Password

Group Class Name

Group Name
Attribute
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Enter the password for the Admin Distinguished Name.

Enter the object class names for groups for this Directory Service. Default values
are:

e Active Directory: group

e eDirectory: groupofnames

Enter an attribute used by this Directory Service to name groups. The default
value for both Active Directory and eDirectory is cn.
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Option

Group Member
Attribute

Description

Enter an attribute used by this Directory Service to define member groups.
Default values are:

e Active Directory: member

e eDirectory: uniquemember

User Class Name

User Name Attribute

Enter the object class name used by this Directory Service for users. Default
values are:

® Active Directory: user

e eDirectory: inetorgperson

Enter the attribute used by this Directory Service to identify users. Default values
are:

® Active Directory: samaccountname

e eDirectory: uid

5. Click Test Connection test to see if the settings that you entered can be used to successfully connect to this

Directory Service.

6. Click Update to save your entries and return to the Directory Services List page or click Update and Import
(User/Group) to save your entries and open the Directory Services User/Group Add view.

Editing an Existing Directory Service Connection

To edit an existing Directory Service connection, perform the following steps:

W

Task: To edit an existing Directory Service connection:

1. On the Administration tab, click Directory Services. The Directory Services page opens.

2. Click Manage Directory Services Connections. The Directory Services List page opens.

3. Select the Directory Service connection that you want to edit. The Edit Directory Service Connection page

opens.

4. Edit these entries as described in Adding a Directory Service Connection.

164
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Deleting a Directory Service Connection

You can import a user/group into an AdminStudio Enterprise Server database using a Directory Service
Connection. This will create a reference to this Directory Service Connection in the database. You can then import
a Directory Service Attribute into the database.

In order to delete this Directory Service, user has to delete all the references to this Directory Service Connection. If
there are references left (like users from this directory service or attributes from this directory service) you cannot
delete this Directory Service Connection.

Managing Directory Services Attributes

When creating a Workflow Manager Template, you can assign a Data Element the Data Type of Directory
Service. This means that when a Directory Service authenticated user performs the Workflow Step that requests
that Data Element, information is pulled from the Directory Service to automatically populate the field, such as that
user’s name, email address, location, etc.

# FirstMame
Gregary

» LastMame
Johnsan

Figure 4-1: Example of Fields Populated With Directory Services Attributes

E

Note - If the user is not connected using Directory Service authentication, then the fields will be left blank and
enabled.

On the Directory Services Attributes Administration Page, which is accessed by clicking Manage Directory
Services Attributes on the Directory Services page, Administrators can map their customizations for the
directory service.
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Task:

Creating Directory Services Attributes

To add a new Directory Services attribute from the directory server into the AdminStudio Enterprise Server
database, perform the following steps.

To create a new Directory Services attribute:

1.

On the Directory Services page, click Manage Directory Services Attributes. The Directory Services
Attributes Administration page opens.

Click Add. The Add Directory Service Attributes view opens.

Using the current user’s credentials, the Attribute Name list lists all of the Directory Services attributes from
the Directory Services server. Select the Directory Services attribute that you want to add to the AdminStudio
Enterprise Server database. A Directory Services attribute is used in Directory Services protocol to access
information directories, such as employeeNumber or documentAuthor.

In the Attribute Alias text box, enter the name that you want to use to identify the Directory Services attribute
in AdminStudio Enterprise Server, such as Employee ID or Author.

Click Add to add the defined Directory Services attribute. If AdminStudio Enterprise Server is unable to
connect to the server (and no attributes are retrieved), the Add button is disabled.

Deleting Directory Services Attributes

To delete a Directory Services Attribute, open the Directory Services Attributes Administration page and click
Delete next to the attribute that you want to delete.

Managing User Logins
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This section explains the four methods of logging into AdminStudio Enterprise Server, and how to set the session
timeout value.

Login Methods

Using AdminStudio Enterprise Server Account Login
Using Domain Account Login

Using Single Sign-On Login

Using Guest Account Login

Setting the Session Timeout Value
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Login Methods

There are four methods you can use to login to AdminStudio Enterprise Server:

Table 4-1 « AdminStudio Enterprise Server Login Methods

Method

AdminStudio

Enterprise
Server
Account
Login

Domain
Account
Login

Single Sign-
On Login

AdminStudio 9.5 User Guide

Description

Users login to AdminStudio Enterprise Server using a User
Account (User Name and Password) that was created in
AdminStudio Enterprise Server by clicking Add on the User
Administration page.

Users login to AdminStudio Enterprise Server using their
Domain Account (User Name and Password), the same
account they use to login to their network.

To set this up, you import users or groups from a Directory
Service: Active Directory or Novell eDirectory.

E

Note ° For domain account login, the Anonymous access option
on the IIS Authentication Methods Dialog Box must be selected.

You set up AdminStudio Enterprise Server so that if users
are logged on to your network using their Domain Account
(User Name and Password), they are automatically logged
in to AdminStudio Enterprise Server.

To set this up, you import users or groups from Active
Directory

E

Note ° For Single Sign-On, IIS performs user authentication. For all
other login methods, AdminStudio Enterprise Server performs
authentication.

E

Note « Single Sign-on is not supported for Novell eDirectory users
and groups.

E

Note ° For single sign-on login, the Anonymous access option
on the IIS Authentication Methods Dialog Box must not be selected.
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Related Topics

Using AdminStudio
Enterprise Server
Account Login

Creating a New User
Account

Using Domain Account
Login

Adding a Directory
Service Connection

Importing Directory
Services Users and
Groups

Using Single Sign-On
Login

Adding a Directory
Service Connection

Importing Directory
Services Users and
Groups
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Table 4-1 « AdminStudio Enterprise Server Login Methods (cont.)

Related Topics

Method Description

Guest You set up a Guest account to permit users without °
Account AdminStudio Enterprise Server login credentials to access
Login features — such as viewing Reports or searching for an °

Application Request — without entering a User ID or

Password.

1S Authentication Methods Dialog Box

To set the Anonymous access option in IS, perform the following steps.

7

Task: To open the IIS Authentication Methods dialog box:

1.

2
3.
a

168

Open Internet Information Services (lIS).

Select the AdminStudio Enterprise Server Web site in the tree view.

Using Guest Account
Login

Setting Up a Guest
Account

Logging in as a Guest

On the Action menu, select Properties. The Web Site Properties dialog box opens.

Open the Directory Security tab and click Edit in the Anonymous access and authentication control

area. The Authentication Methods dialog box opens.

Authentication Methods

[#] Arroremons: secess
Ho user name/passwond requied to access this resownce.
Accourt used for anormOus JCCEST

User name: | USER_rZSMITHIOHNP Bt
Password:
[] vt 115 1y cominol passwond

Autherticabed access
o the lcllowng suthentication methods, wer name and passwond
e paquired when

- anOnMoUS accest B deablad, o

- access ik resticbed using MTFS access conbrol ksts
Duwlmm fon "Windows domain serveis

[#] Basic suthentication [password is serk in chear text]

ot e
Reakn ICOMEAn. Com

[#] Irtegated Windows suthenticstiaon

Lok ] [ Comcel | [ Hep |

Figure 4-2: Anonymous Access option on the IIS Authentication Methods Dialog Box

ADS-0950-UG00

AdminStudio 9.5 User Guide



Chapter 4: Managing Users, Directory Services, and User Logins
Managing User Logins

Using AdminStudio Enterprise Server Account Login

To Set Up

To set up AdminStudio Enterprise Server User Account login, create a user account (User Name and Password)
for each person that you want to have access to AdminStudio Enterprise Server. See Creating a New User
Account.

To Login

Users with AdminStudio Enterprise Server accounts enter their AdminStudio Enterprise Server-generated User
Name and Password on the AdminStudio Enterprise Server Login page. AdminStudio Enterprise Server performs
the authentication.

More Information

For more information, see Creating a New User Account

Using Domain Account Login

To Set Up
To set up Domain Account login, you do the following:

e Set up a Windows Active Directory or Novell eDirectory Directory Service Connection. See Adding a
Directory Service Connection.

e  On your AdminStudio Enterprise Server IS Server, open the IIS Authentication Methods Dialog Box and select
the Anonymous access option. This specifies that AdminStudio Enterprise Server is going to authenticate
the users.

e Import users or groups from that Directory Service. See Importing Directory Services Users and Groups.

To Login

Imported users or users belonging to the imported groups enter their Directory Service User Name and
Password on the AdminStudio Enterprise Server Login page.

AdminStudio Enterprise Server then connects with the Directory Service using the credentials provided on the Add
Directory Service Connection View, and then passes the login User Name and Password to the Directory Service
so that it can authenticate the user.

E

Note » When entering the User Name, it is not necessary to enter the Directory Service domain name.
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More Information

For more information, see:
e Adding a Directory Service Connection
e Importing Directory Services Users and Groups

e IS Authentication Methods Dialog Box

Using Single Sign-On Login

To Set Up
To set up Single Sign-on login, you do the following:

e Set up a Windows Active Directory Directory Service Connection. See Adding a Directory Service
Connection.

e  On your AdminStudio Enterprise Server IIS Web Server, open the IIS Authentication Methods Dialog Box and
clear the Anonymous access option. This specifies that IS is going to authenticate the users.

e Import users or groups from that Active Directory Directory Service. See Importing Directory Services Users
and Groups.

E

Note ° Regarding Single Sign-On, note the following:

e For Single Sign-On, IIS performs user authentication . For all other login methods, AdminStudio Enterprise
Server performs authentication.

e Single Sign-on is not supported for Novell eDirectory users and groups.

To Login

When a user with single sign-on opens AdminStudio Enterprise Server, the IIS Web Server checks to see if the
user’'s domain User Name and Password are valid in the Active Directory Domain Server, and then automatically
logs the user in to AdminStudio Enterprise Server. AdminStudio Enterprise Server does not need to connect to the
Active Directory Domain Server.

For More Information

For more information, see:
e Adding a Directory Service Connection
e Importing Directory Services Users and Groups

e IS Authentication Methods Dialog Box
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Using Guest Account Login

This section describes how to setup a Guest Account and how to login using a Guest Account:
e Setting Up a Guest Account

® |ogging in as a Guest

Setting Up a Guest Account

When a Guest Account is set up, AdminStudio Enterprise Server users without a User Account are automatically
logged in using a Guest Account.

The AdminStudio Enterprise Server administrator can set up a Guest account to permit users without login
credentials to access features such as viewing a report or searching for an Application Request . By using a Guest
Account, Administrators do not have to add a new user account just to provide access for users who only need
very limited functionality.

AdminStudio Enterprise Server system administrators should configure a Guest Account as follows:

Task: To set up a Guest Account:

1. Create a new user account to use as the Guest Account, and add this user to the web. config file located in the
AdminStudio Enterprise Server Web Application wwwroot directory. Enter the user name in the following
location of the web. config file:

<!-- Guest System Access -->
<add key="GuestAccount" value="username@companyname.com" />

2. Onthe Administration tab, click Users & Groups. The User Administration page opens.

3. Assign the Guest Account user to Roles with limited permissions. See Managing Roles and Permissions for
more information.

Guest System Access Recommendations
When setting up Guest System Access, please follow these guidelines:

e The AdminStudio Enterprise Server Administrator should assign the Guest account user to Roles with limited
privileges. If the Guest account belongs to a Role with high privileges, then every user who logs on as a Guest
will have high privileges.

e If the GuestAccount key does not exist in the web. config file, then the Guest Access option does not appear
on the AdminStudio Enterprise Server Login page.

e [fthe GuestAccount key exists in the web. config file but the user name specified in the value is empty (such as
value=""), then the Guest Access option does not appear on the AdminStudio Enterprise Server Login page.

e If the GuestAccount key exists in the web. config file, but the user name specified in the value does not exist in
the AdminStudio Enterprise Server database, then AdminStudio Enterprise Server displays an error message
when a user tries to log on as a Guest User.
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Configuring a Guest Account on a Workflow Manager Portal Site

Please note the following regarding configuring a Guest account on a Workflow Manager Portal site:

E

If users are accessing Workflow Manager through a Workflow Manager portal, then the AdminStudio
Enterprise Server administrator should add the GuestAccount key to the web. config file of the Portal site. By
default, Workflow Manager will use the Guest account value configured at the portal site to log on the Guest
user. If the portal site does not have any GuestAccount value configured, then Workflow Manager uses the
GuestAccount value at the Workflow Manager Web Application site to log on the Guest account.

If users are accessing the Workflow Manager site directly (not going through a portal), then Workflow Manager
uses the GuestAccount value configured in the web. config file located in the AdminStudio Enterprise Server
Web Application wwwroot directory to log on the Guest account.

Note * The web.conf1ig file installed by AdminStudio Enterprise Server should contain the GuestAccount key with
an empty value. It is the responsibility of the System Administrator to fill in that value in the web. config file of the
Portal site or the AdminStudio Enterprise Server Web Application site.

Logging in as a Guest

172

Before anyone can log on to AdminStudio Enterprise Server as a Guest User, the System Administrator must
configure a Guest Account, following the instructions in Setting Up a Guest Account. Then a user could log on to
your AdminStudio Enterprise Server site as a guest using the appropriate method:

If Directory Service authentication is used at your site, and the user’s Directory Service user name does
not exist in the AdminStudio Enterprise Server database, AdminStudio Enterprise Server automatically logs
this user on using the Guest account.

If Directory Service authentication is not used at your site, AdminStudio Enterprise Server opens the
AdminStudio Enterprise Server Login page by default. The user then selects the Guest Access option and
clicks Login.

ADS-0950-UG00 AdminStudio 9.5 User Guide



Chapter 4: Managing Users, Directory Services, and User Logins
Managing User Logins

) User Login

User Mare:
Password;

I Forgok my passwiord

Domain:

Database w

Remember my user name

{(*) Guest Access

The AdminStudio Enterprise Server Administrator assigns the Guest account to specific Roles, and the degree of
permissions that the Guest account has depends upon which Roles the account is assigned to.

e When a Role is created, the administrator must indicate whether that Role has permission to create a
Workflow Manager Application Request.

e When Reports are created, the administrator must indicate which Roles have permission to view them.
Guest Users can view all Reports that their assigned Roles have permission to access.

Setting the Session Timeout Value

When AdminStudio Enterprise Server is installed, the session timeout value is set to 20 minutes. This means that
after you login to the AdminStudio Enterprise Server, if your session remains idle for 20 minutes, you are prompted
to login again.

You can change the session timeout value by editing two values in the web. config file: sessionState timeout and
LoginPageTimeOut.

Task: To change the session timeout value:

1. Open the wwroot directory of the AdminStudio Enterprise Server installation and open web.config in a text
editor.

2. Locate the line that contains sessionState timeout:

<sessionState timeout="20" mode="InProc" stateConnectionString= "tcpip=127.0.0.1:42424"
sqlConnectionString="data source=127.0.0.1; Trusted_Connection=yes" cookieless="false" />
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3. Change the value specified for sessionState timeout="nn" to the new timeout value.
4. Locate the following line that contains LoginPageTimeOut:
<add key="LoginPageTimeOut" value="19.5" />

5. Change this value to match the timeout value you specified for the sessionState.

Users/Groups and Directory Services
Reference

This section details the contents of the AdminStudio Enterprise Server pages that are used to manage users and
directory services:

Table 4-2 * Users/Groups and Directory Services Tabs Reference

Page Subpages

User Administration Page e User Details View

e Directory Services User/Group Add View

Directory Services Page e Directory Services List Page
® Add Directory Service Connection View
e Directory Services Attributes Administration Page

e Add Directory Service Attributes View

User Administration Page

This view lists all users defined in the system. From this view, you can add a new User, edit an existing User, or
import a Directory Service User or Group.

Table 4-3 * User Administration Page Options

Option Description

Add Click to access the User Details View, where you can add a new User.

Directory Service Click to access the Directory Services User/Group Add View, where you can import a

User/Group Import User or Group from an Directory Service.

Status To filter the list of users by Status, make a selection from this list: Active, Inactive or
All
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Table 4-3 » User Administration Page Options (cont.)

Option Description

User Name Name user uses to log onto AdminStudio Enterprise Server, in the format of:
user’name@companyname .com

If a Directory Services Group has been imported, the Group name is listed in this

column.
Roles Lists the roles that this User has been assigned to.
Company Name of user’s Company.

From the User Administration page, you can perform the following tasks:

® Create a AdminStudio Enterprise Server user account—Create a user account for each person that you
want to have access to AdminStudio Enterprise Server. See Creating a New User Account.

e Import Directory Service Users or Groups—Set up a Windows Active Directory or Novell eDirectory
Directory Service Connection and the click Directory Service User/Group Import on the User
Administration page to import Users or Groups from that Directory Service. See Importing Directory Services
Users and Groups. Importing a group allows you to provide dynamic access to all of the members of that
Group as the members of that Group changes.

e Edit a user account—To edit an existing account, click Select next to the User Name to open the User
Details view.

E

Note * For more information on the methods for logging into AdminStudio Enterprise Server and how authentication
is performed, see Managing User Logins.
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User Details View

176

On this view, enter or edit user account and imported Directory Services account information. On this page, you
can also delete a user account.

Table 4-4 * User Details View Options

Option Description

Company Select the Company that this user or group belongs to.

User Name Perform one of the following:

e New—When creating a new user, enter the name the user will use to log onto
AdminStudio Enterprise Server in the format of: username@companyname . com.

e Importing—When importing a user group from a Directory Service, the name listed
here will be prepopulated and uneditable.

Password Enter the User’s password.

Note < This field is not shown when importing a Directory Service Group.

Status Select Active to make this user or group active in the AdminStudio Enterprise Server
system, or select Inactive to disable this account. See Disabling a User or Group
Account.

Email User’s email address.

Note - This field only appears when creating a new user account. For users imported from a Directory
Service, this information is retrieved dynamically from the Directory Service when needed.

Roles Listing of all of the defined Roles at the selected Company. Select the Roles appropriate
for this user or group.

Location Optionally, enter a geographic Location that you can use to group users together, such as
New York Office or Midwest Region, etc. Assigning a geographical location to a user
enables you to display this information in reports.

Update Click to save your entries and close the User Details view.

Update and Add | Click to save your entries and remain in the User Details view, where you can enter

New another new user.

Delete Click to delete this user account.

Cancel Click to exit this view without saving your entries.
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Directory Services User/Group Add View

This view is accessed by clicking Directory Service User/Group Import on the User Administration page.
The following options are included:

Table 4-5 * Directory Services User/Group Add View

Option

Select a Directory
Service

Select Group or
User

Filter Directory
Service List

Select Group or
User to Add

Update

Description
Select the defined Directory Service that you want to import a user or group from.

E

Note « For information on defining a Directory Service Connection, see Adding a Directory
Service Connection.

Specify whether you are importing a User or a Group.

Select Show All to include all Users or Groups in the list, or select Filter list by,
enter text in the box, and click Find to filter the list by the specified criteria.

For example, to search for all of the users that start with the letter P, use the asterisk

wildcard character (*) and enter P* in the Filter list by box.

From the Select Group or User to Add list, select the group or user to import.

E

Note - If you import a User that is a member of a Group that was previously imported, that User
inherits the Roles that are assigned to that Group. You can then assign additional Roles to that
User.

Click to save your entries.

The selected user or group is then opened in the User Details View.
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Directory Services Page

AdminStudio Enterprise Server can be integrated with Windows Active Directory and Novell eDirectory. This
integration enables you to integrate Directory Services Users and Groups and also to use Directory Services
attributes.

Table 4-6 * Directory Services Page Options

Option Description

Manage Directory Click to open the Directory Services List Page where you can set up connections

Service Connections to Active Directory and eDirectory Directory Services.

Manage Directory Click to open the Directory Services Attributes Administration Page where you

Service Attributes can map Directory Service attributes, which can be used when defining Data
Elements.

When a Data Element is defined as a Directory Service attribute, when this Data
Element appears during a data entry step in a Workflow, information about the
logged in user will be pulled from the Directory Service to populate those fields,
such as: Department, Location, Employee Number, etc.

E

Note * For more information about Directory Services and Lightweight Directory Access Protocol (LDAP), see
Ldp Overview on the Microsoft TechNet Web site.

Directory Services List Page

Directory Services Connections are used to import users and groups into AdminStudio Enterprise Server, and to
authenticate Active Directory or Novell eDirectory users logging into AdminStudio Enterprise Server.

You can choose to have a Directory Service listed in the Domain list on the AdminStudio Enterprise Server login
page. This enables users in this Directory Service to login to AdminStudio Enterprise Server using their enterprise
network credentials.

The information and options are included:
Table 4-7 « Directory Services List Page Options
Option Description

Directory Service Name The name that identifies this Directory Service in the Domain list on the
AdminStudio Enterprise Server login page.

Description A description of this Directory Service.
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Table 4-7 - Directory Services List Page Options (cont.)

Option Description

Directory Service Type Identifies this Directory Service as either a Windows Active Directory or Novell
eDirectory type.

Directory Service Host The name or IP address of the Server on which this Directory Service is running.

Add Click to add a new Directory Service connection.

Add Directory Service Connection View

On the Add Directory Service Connection view, which is opened by clicking Add on the Directory Services List
Page, you enter the necessary settings to connect to an Active Directory or Novell eDirectory Directory Service.

Table 4-8 * Add Directory Service Connection View Options

Option Description

Use to Authenticate | Select Yes to include this Directory Service in the Domain list on the AdminStudio
Users? Enterprise Server login page. This enables users to login to AdminStudio Enterprise
Server using their enterprise network credentials.

E

Note « For Single Sign-On, IIS performs user authentication. For all other login methods,
AdminStudio Enterprise Server performs authentication.

Directory Service Enter a name to identify this Directory Service in the Domain list on the AdminStudio
Name Enterprise Server login page. It is recommended that the Directory Service Name
match the Domain Name.

Description Enter a description of this Directory Service.
Directory Service Identify the type of Directory Service that you are adding a connection to:
Type

e Active Directory

® Novell eDirectory

Directory Service Enter the name or IP address of the Server on which this Directory Service is running.
Host

Directory Service Enter the port number of the Server on which this Directory Service is running. By
Port default, AdminStudio Enterprise Server uses Port 389.

7]

Important * The value for the Directory Service Port should be the port on the given server to
which AdminStudio Enterprise Server should connect to send LDAP queries.
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Option

Base Distinguished
Name

Domain Name

Use Secure Socket
Layer (SSL)?

Connect
Anonymously?

Admin
Distinguished Name

Table 4-8 » Add Directory Service Connection View Options (cont.)

Description

Enter the Base Distinguished Name (DN) to identify the root node of this Directory
Service.

For example, for MyCompany, the Base DN could be:
dc="MyCompany", dc="com"
Enter the Domain Name of this Directory Service. This Domain Name is used to create

the right credentials, along with the Admin User Name. For example, you would enter
DomainName\AdminUserName to connect to the specified Directory Service.

E

Note * To upgrade from AMS 2.5, enter the same Domain Name that was used in AMS 2.5.
AdminStudio Enterprise Server will read this Domain Name and then try to authenticate the User
using this Directory Service. For single sign-on to work on an upgrade scenario from 2.5 to 4.0,
administrators have to configure at least one Directory Service.

Select Yes if this Directory Service is configured to use Secure Socket Layer (SSL).

Select No if you do not want to permit anonymous connections.

If you select Yes to permit anonymous connections, AdminStudio Enterprise Server
may not be able to authenticate Directory Service users and may not be able to add
Directory Service users/groups into AdminStudio Enterprise Server.

Enter the Distinguished Name of a user who has permission to retrieve users/groups
information and authenticate any user against this Directory Service. Enter the
Distinguished Name in the format of:

domainname\username

such as:

abcinc\jsmith

Password

Enter the password for the Admin Distinguished Name.

Group Class Name

Enter the object class names for groups for this Directory Service. Default values are:

e Active Directory: group

e eDirectory: groupofnames

Group Name
Attribute

Enter an attribute used by this Directory Service to name groups. The default value for
both Active Directory and eDirectory is cn.
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Table 4-8 » Add Directory Service Connection View Options (cont.)

Option

Group Member
Attribute

User Class Name

Description

Enter an attribute used by this Directory Service to define member groups. Default
values are:

e Active Directory: member

e eDirectory: uniquemember
Enter the object class name used by this Directory Service for users. Default values
are:

e Active Directory: user

e eDirectory: inetorgperson

User Name Attribute

Enter the attribute used by this Directory Service to identify users. Default values are:

e Active Directory: samaccountname

e eDirectory: uid

Update

Update and Import
(User/Group)

Test Connection

Click to save your entries and return to the Directory Services List Page.

Click to save your entries and open the Directory Services User/Group Add View.

Click to test to see if the settings that you entered can be used to successfully connect
to this Directory Service.

Directory Services Attributes Administration Page

On the Directory Services Attributes Administration page, which is accessed by clicking Manage Directory
Services Attributes on the Directory Services page, Administrators can map their customizations for the

directory services.

Directory Service attributes can be used when defining Data Elements. When a Data Element is defined as a
Directory Service attribute, when this Data Element appears during a data entry step in a Workflow, information
about the logged in user will be pulled from the Directory Service to populate those fields, such as: Department,
Location, Employee Number, etc.

The following information is listed:

Table 4-9 - Directory Services Attributes Administration Page Options

Option Description

Directory Name of the LDAP (Lightweight Directory Access Protocol) Directory Service attribute that
Service is used in Directory Services protocol to access information directories, such as
Attribute employeeNumber or documentAuthor.
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Table 4-9 - Directory Services Attributes Administration Page Options (cont.)

Option Description

Attribute Alias Name that you want to use to identify the Directory Service attribute in AdminStudio
Enterprise Server, such as Employee ID or Author.

Delete Click to delete the listed attribute.

Add Directory Service Attributes View

When you click Add on the Directory Services Attributes Administration page to add a new Directory Service
attribute into the AdminStudio Enterprise Server database, the following fields are displayed:

Table 4-10 * Add Directory Service Attributes View Options

Option Description

Directory Select the Directory Service that contains the attribute that you want to add.

Service

Attribute Lists all the attributes from the selected Directory Service server, using the currently logged
Name user’s credentials.

Attribute Alias | Enter the name that you want to use to identify the Directory Service attribute in
AdminStudio Enterprise Server.

Add Click to add the defined Directory Service attribute. If AdminStudio Enterprise Server is
unable to connect to the server (and no attributes are retrieved), the Add button is disabled.

When a Data Element is defined as a Directory Service attribute during Workflow Manager Template creation, when
this Data Element appears in the Workflow, information will be pulled from the Directory Service to populate those
fields, such as:

= FirstMarne
Gregaory

= LastMame
Johnsan

However, if the user is not connected using Directory Service authentication, then the fields will be left blank and
will be enabled.
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All of the AdminStudio and Workflow Manager permissions are related to Roles. The amount of functionality that a
user has is directly related to what Roles they are assigned to.

This section contains information on the following tasks:
® AdminStudio and Workflow Manager Roles and Permissions

e Creating a New Role

e Editing an Existing User Role
e Copying an Existing Role
® Roles Reference

AdminStudio and Workflow Manager Roles
and Permissions

Permissions are assigned to Roles, and Roles are assigned to users. Therefore, all permissions in AdminStudio
and Workflow Manager are controlled by Roles.

This section includes the following topics:

® Role Permission Lists
e AdminStudio Client Tools Permissions
e AdminStudio Enterprise Server Tools Permissions
e Workflow Manager Permissions

e System Roles
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Role Permission Lists
Permissions to perform all AdminStudio and Workflow Manager functions are assigned using Roles. A user has
permission to perform only those tasks that are explicitly selected in the Role(s) that the user is assigned to.
This section describes all of the AdminStudio and Workflow Manager permissions:
e AdminStudio Client Tools Permissions
e AdminStudio Enterprise Server Tools Permissions

e Workflow Manager Permissions

AdminStudio Client Tools Permissions

The AdminStudio client tools have the following permissions:
Table 5-1 « AdminStudio Client Tools Permissions

Category Permission

AdminStudio e Edit—Permits user to view and edit those Projects on the Projects tab that

Projects Tab are assigned to him.

® Create—Permits user to create new Projects and assign them to users.
Users with the Create permission see a list of all users and their associated
Projects on the Projects tab. Users with only the Edit permission cannot
create new Projects and can only view and edit Projects that are assigned to
him.

o Delete—Permits user to delete a Project from the Projects tab.

AdminStudio ® View—Permits user to view the Workflow tab and all of the existing

Workflow Templates Tab Workflows.
e Edit—Permits user to edit existing Workflows on the Workflow tab.
® Create—Permits user to create a new Workflow on the Workflow tab.

e Delete—Permits user to delete a Workflow from the Workflow tab.

AdminStudio e Add—Permits user to add a new tool to the Tools tab.
Tools Tab e Edit—Permits user to edit the properties of an existing tool on the Tools tab.

e Delete—Permits user to delete an existing tool on the Tools tab.
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Table 5-1 « AdminStudio Client Tools Permissions (cont.)

Category
AdminStudio

General

Permission

Modify Tools Options Dialog—Permits user to set options on the
Locations, Updates and Quality tabs of the AdminStudio Options dialog
box. Users without this permission can view the Options dialog box but
cannot make any changes.

If a user has only the Modify Tools Options Dialog permission but does
not also have the Change Default Application Catalog permission, that
user cannot edit the Shared AdminStudio Application Catalog field on
the Application Catalog tab of the Options dialog box.

Change Default Application Catalog—Permits user to edit the Shared
AdminStudio Application Catalog field on the Application Catalog tab
of the Options dialog box (if that user also has the Modify Tools Options
dialog permission). This permission also permits user to edit the Make this
the default shared Application Catalog option on the Connect
Application Catalog dialog box

Application Manager /
Conflict Solver

Conflicts

Application Manager /
Conflict Solver

Package

Run Analysis—Permits user to perform conflict analysis on a package.

Resolve—Permits user to resolve any automatically resolvable conflicts
found during conflict analysis on a package.

Modify Rules—Permits user to open the Rules Viewer and create and edit
new Rules.

Modify Data—Permits user to create new Groups, rename existing Groups,
and modify Group Properties.

Permits user to Cut and Paste a Group to a new location.

Permits user to Copy/Cut and Paste a package into a new Group.

Permits user to modify options on the Resolution Options dialog box.

Permits user to edit a package Description on the Products View.

Delete—Permits user to delete a package from the Application Catalog.
Import—Permits user to import a package into the Application Catalog.

Modify Extended Attributes—Permits user to modify a package’s
metadata on the Extended Attribute view.

Delete History—Permits user to delete a package’s history log (which
contains a record of any operation that materially changes a software
package or the data associated with it).
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Table 5-1 » AdminStudio Client Tools Permissions (cont.)

Category

Application Manager /
Conflict Solver

Other

Patch Impact Manager

Software Repository

Permission

Modify Tools Options Dialog—Permits user to open the Application
Manager/ConflictSolver Options dialog box and set options.

Change Application Catalog—Permits the user to connect to a different
Application Catalog by selecting Connect on the Catalog menu. Without
this permission, this selection is disabled.

Run Merge Wizard—Permits user to use the Merge Wizard to merge the
application data of a specified Application Catalog into the currently open
Application Catalog.

Run Validation—Permits user to use the Validation Wizard to validate a
Windows Installer package against custom actions written by Microsoft
which can be executed to determine if an installation package is built
according to Windows Installer standards.

Scan for Dependencies—Permits user to generates a list of all of a
package’s files that have dependencies with files used by other products or
operating systems in the Application Catalog.

Run Directory Monitoring—Permits user to use the Network Directory
option of Package Auto Import to monitor a directory location on the
network (or a local directory) and automatically import or re-import packages
in that directory at scheduled intervals.

Run Best Practices—Permits user to use the Conflict Wizard or the
ConflictSolver Process Assistant to evaluate source packages to see if they
meet Windows Installer best practices rules.

Import Patch—Permits user to use OS Security Patch Wizard to import
Windows operating system patches into the Application Catalog.

Run Analysis—Permits user to use the ConflictSolver Patch Impact
Analysis Wizard to analyze the impact of installing an OS Security patch on
user machines.

Overwrite—Permits user to import a duplicate package into the Software
Repository, overwriting the existing version.
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AdminStudio Enterprise Server Tools Permissions

The AdminStudio Enterprise Server tools have the following permissions:

Table 5-2 * AdminStudio Enterprise Server Tools Permissions

Category Permission
People e View—Permits user to see the Administration/Users & Groups tab.
e Add—Permits user to add new users and import a users list from Active
Directory.
e Edit—Permits user to modify existing users.
® Delete—Permits user to delete existing or newly created users.
Roles ® View—Permits user to see the Administration/Roles tab.
e Add—Permits user to add new Roles.
e Copy—Permits user to copy an existing Role.
e Edit—Permits user to modify an existing Role.
e Email Notify Enabled—Not currently in use.
Directory Services e View—Permits user to see the Administration/Directory Services tab and
view the Directory Services page, the Directory Services List page, and the
Directory Services Attributes Administration page.
® Add—Permits user to add a new Directory Service.
e Edit—Permits user to edit an existing Directory Service.
e Delete—Permits user to delete existing or newly created Directory Services.
System Settings ® View—Permits user to open the Administration/System Settings tab.
o Edit—Permits user to edit the fields on the Administration/System Settings

tab: AdminStudio Enterprise Server User Account and the Workflow Manager/
AdminStudio Enterprise Server Serial Numbers.
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Table 5-2 « AdminStudio Enterprise Server Tools Permissions (cont.)

Category

Job Manager

Permission

View—Permits user to see the Job Manager tab only if that user also has at
least one of the following Job Manager permissions: Manage Jobs, Manage
Templates, or Configuration.

If you only have the Job Manager View permission (and none of the other Job
Manager permissions), you will not be able to view the Job Manager tab or any
of its subtabs.

Manage Templates—Permits user to see the Job Manager/Manage
Templates tab, view the list of Templates on the Job Template List page, and
view the details of an existing Template on the Edit Template page.

Users with only the View and Manage Templates permission cannot create a
new Template or edit an existing Template.

When a Role is assigned the Manage Templates permission, the View
permission is automatically selected.

Manage Jobs—Permits user to see the Job Manager/Manage Jobs tab,
view the list of Jobs on the Jobs Queue page, and view the details of a Job that
they created on the Edit Job page.

Users with only the View and Manage Jobs permission cannot create a new
Job or edit an existing Job.

When a Role is assigned this permission, the View permission is automatically
selected.

Manage Jobs for All Owners—Adds the Show All Jobs check box option to
the Jobs Queue page, which enables this user to see a list of Jobs created by
all users. For users without this permission, only those Jobs that they created
are listed.

Configuration—Permits the user to view the list of conflict detection rules that
are selected on the Conflict Detection Options page. However, if this user
does not also have the Edit permission, this user will not be able to make any
changes to this list.

When a Role is assigned this permission, the View permission is automatically
selected.

Edit—If a user also has the Manage Templates and/or Manage Jobs
permissions, this permission allows the user to create new Templates and Jobs,
and also to edit existing Templates and Jobs. If this user has this permission and
also has the Configuration permission, this user can modify the selections on
the Conflict Detection Options page.
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Table 5-2 « AdminStudio Enterprise Server Tools Permissions (cont.)

Package Reports

Software Distribution e

Category Permission
Report Center / o Add—Permits user to click Add on the All Reports page and create a new
All Reports Custom Report using the Report Wizard.
e Edit—Permits user to edit an existing Custom Report.
e Delete—Permits user to delete an existing Custom Report.
Report Center / e View—Permits user to see the Package Reports tab and view Package

Reports.

Operate—Permits user to use Configuration Manager Web Console (the
Distribute tab of AdminStudio Enterprise Server) to configure package
distribution options and distribute setup packages without going to
Configuration Manager Server.

Workflow Manager Permissions

Workflow Manager has the following permissions:

Table 5-3 * Workflow Manager Permissions

Application Request °
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Category Permission

View—Permits user to view the Properties and Issues tabs on the
Application Progress page of existing Application Requests.

Add—Permits user to create a new Application Request.
Edit—Permits user to edit an existing Application Request.
Copy—Permits user to copy an existing Application Request.
Delete—Permits user to delete an existing Application Request.

Monitor Application Progress—Permits user to see the Application
Progress, Uploaded Files, and Downloadable Files tabs of the
Application Progress page. Also permits user to complete Workflow Steps.

View Related Applications—Permits user to view the Related Applications
tab of the Application Progress page.

Add Related Applications—Permits user to link one Application Request to
another on the Related Applications tab.

Delete Related Application Links—Permits user to delete Related
Application links.

Edit Application Due Period—Permits user to edit the Application Due
Period field on the Properties tab of the Application Progress page.
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Table 5-3 « Workflow Manager Permissions (cont.)

Category Permission
Application Status ® View—Permits user to view the Application Status Administration page and
Management to view (but not update) Application Status details on the Edit Application
Status view.
e Add—Permits user to add a new Application Status.
e Edit—Permits user to update Application Status details on the Edit
Application Status view.
e Delete—Permits user to delete an existing Application Status
Calendar Settings e View—Permits user to view the Calendar Settings Administration page.
e Edit—Permits user to edit the settings on the Calendar Settings
Administration page.
Issues e View—Permits user to view the Issues tab of the Application Progress page
and to view the issue details.
e Add—Permits user to create a new E-mail or Knowledge Base issue .
® Respond—Permits user to respond to an existing issue.
e Close—Permits user to close an E-mail or Knowledge Base issue.
e Add/Close Critical Issue—Permits user to create and close Critical issues.
My Notifications e View—Permits user to view the My Notifications pages: My Default Project
Notifications and My Application Notifications.
e Edit—Permits user to edit the settings on the My Notifications pages: My
Default Project Notifications and My Application Notifications.
Project Permissions e View—Permits user to view (but not edit) the permission and email settings on
the Project Permission and Notification Settings view.
e Edit—Permits user to edit the permission and email settings on the Project
Permission and Notification Settings view.
Projects e View—Permits user to view the Project Administration page and view (but
not update) Project details on the Project Details view.
e Add—Permits user to create a new Project.
e Edit—Permits user to edit the details of an existing Project.
o Delete—Permits user to delete a Project.
Requestor Company e View—Permits user to view a list of existing Requestor companies and view
Requestor company details.
® Add—Permits user to add new Requestor companies.
e Edit—Permits user to update Requestor company details.
® Delete—Permits user to delete an existing Requestor company.
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Table 5-3 « Workflow Manager Permissions (cont.)

Category Permission

Search e Simple Search—Permits user to enter keywords in the Application Search
box on the Workflow Manager Home page to search for an Application
Request by name.

e Advanced Search—Permits user to search for Application Requests by
multiple criteria on the Application Search page.

Servicer Company ® View—Permits user to view a list of existing Servicer companies, view Servicer
company details, and update those details.

e Add—Permits user to create new Servicer companies.

Templates ® View—Permits user to view the Template Administration page and view
Template details on the Template Details page. Also gives you permission to add
an external data source on the External Data Sources subtab of the
Administration tab.

e Add—Permits user to edit an existing Template and create a new Template.
e Copy—Permits user to copy an existing Template.

Terminology ® View—Permits user to view and modify AdminStudio Enterprise Server system
terminology.

Work Assignment ® View—Permits user to view the Working Queue View and Work Assignment
Listing pages to see a list of existing work assignments.

e Assign—Permits user to assign work on the Assignment Details page.

Global Email e View—Permits user to view the Email Settings Administration and External

Administration Email Address Administration pages.

e Edit—Permits user to edit the settings on the Email Settings Administration
and External Email Address Administration pages.

Deployment Sites e View—Permits user to see the Deployment Site Administration page.

e Add—Permits user to add a new Deployment Site.
e Edit—Permits user to edit an existing Deployment Site.
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System Roles

AdminStudio and Workflow Manager come with default System Roles which cannot be modified. These Roles
were created based upon the needs of typical AdminStudio and Workflow Manager users, providing each Role
with only the permissions a user would need to perform their required tasks. You can either assign these System
Roles to users, or you can copy System Roles and then modify them to customize them for your organization.

Copied System Roles or new Roles that you create have a Role Type of User (User Roles), while default Roles
created during installation have a Role Type of System (System Roles). A Role’s Role Type is listed on the Role
Administration page and cannot be changed.

Information about System Roles is organized in the following sections:
® Superuser Role: AMSSuper
® Default System Roles

e Default System Users

Superuser Role: AMSSuper

192

When AdminStudio Enterprise Server and Workflow Manager are installed, the following user is created and is
assigned the AMSSuper Role:

e User Name: suams
e Password: suams

A user assigned the AMSSuper Role can create Servicer companies and customize terminology. All other tasks
should be performed by a Service Company administrator or by accounts created by a Service Company
administrator.

E

Note « The AMSSuper Role is not listed on the Role Administration page unless you are logged on using the
suams account.
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Default System Roles

When AdminStudio Enterprise Server and Workflow Manager are installed, the following System Roles are created:

Role Mame Campary Marme Rale Description

Select  Application User Requester Application User For Requestor Company Sy sbem
Seleck Project Manager Fequester Project Manager for Requeskor Company Swskem
Seleck Project Manager Servicer Project Manager Role Swskem
Select  Repackager Servicer Application Repackager Role System
Select  SCAdmin Servicer Syskem Administrator Role System
Select  Tech Lead SEFvicer Tech Lead Role Sy sbem
Seleck & Tester Requester I=er Acceptance tester for Requestor Company Swskem

Figure 5-1: Default System Roles

E

Note - Ifyou did not purchase Workflow Manager, the Roles associated with the Requester company are not listed:
Application User, Project Manager, and QA Tester.

E

Note - If you are connected to an Application Catalog that has been upgraded from AMS 2.5, all Roles will have a
Role Type of User.

The following table lists the default System Roles:

Table 5-4  Default System Roles

Role Name Company Name @ Description

Project Manager @ Servicer Project Manager for Servicer Company

Repackager Servicer Application Repackager for Servicer Company

SCAdmin Servicer System Administrator for Servicer Company

Tech Lead Servicer Tech Lead for Servicer Company

Application User = Requester (Workflow Manager only) Application User for Requester Company

Project Manager Requester (Workflow Manager only) Project Manager for Requester Company

UA Tester Requester (Workflow Manager only) User Acceptance Tester for Requester
Company
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You can view the permissions of each of these Roles by selecting the Role on the Role Administration page, and
then expanding the Role Permissions list.
Default System Users

When AdminStudio Enterprise Server and Workflow Manager are installed, a User Account is created for each of
these System Roles:

User MName COmpany

Select | admin@servicer.com SCAdmin Servicer
Select pro@requesker, com Project Manager Requester
Select pr@serwicer ., cam Project Manager Servicer
Select repackageri@servicer.com Repackager Servicer
Select techlead@servicer,com Tech Lead Servicer
Select Lester@requeskter.cam & Tester Requester
Select Useri@requester, com Application User Requester

Figure 5-2: Default System Users

To see what functionality is available for one of these default System users, you could log on as that user and then
observe what features are available. You could also select the System user’s associated Role on the Role
Administration page, and then expand the Role Permissions list.

E

Note ° By default, the password for each of these default System Users is the same as the text prior to the @ sign
(such as techlead for techlead@servicer.com), except the password for pm@requester.com and
pm@servicer.com is projectmanager.
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Creating a New Role

o

Task:

To create a new Role, perform the following steps.

To create a new Role:

g

o o o

On the Administration tab, click Roles. The Role Administration page opens.

Click the Add button. The Role Details View opens.

Enter a name in the Role Name field to uniquely identify this Role.

From the Role Company list, select the name of the Company whose users can be assigned this Role.
In the Role Description text box, describe the purpose of this new Role.

In the Role Permissions list, select the permissions you want to assign to this Role. For a detailed list of the
available permissions, see Role Permission Lists.

Click the Update button. The new Role now appears in the list on the Role Administration page.

Editing an Existing User Role

o

You can edit all Roles with a Role Type of User, but System Roles cannot be modified.

Task:

To edit an existing User Role:

1.

2.

On the Administration tab, click Roles. The Role Administration page opens.
Select the Role that you want to edit. The Role Details View opens.

Make edits to the Role Name and Role Description fields, if desired.

E

Note - It is not recommended that you change a Role’s Role Company.
In the Role Permissions List, edit the permissions assigned to this Role.

Click the Update button. You are returned to the Role Administration page.
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Copying an Existing Role

You can make a copy of an existing User or System Role using a new Role Name. You can then modify it to
customize it for your organization. You cannot modify a System Role. You can also copy an existing Role from one
Company to another.

To copy an existing Role, perform the following steps.

Task: To copy an existing Role:

1.

»

o o s o

8.

9.

On the Administration tab, click Roles. The Role Administration page opens.

Click the Copy button. The Copy Role View opens.

From the Copy from Company list, select the name of the Company whose Role you want to copy.
From the Copy from Role list, select the Role that you want to copy.

From the Copy to Company list, select the Company that you are creating this new Role for.

Enter a name in the New Role Name field to uniquely identify this Role.

E

Note ° You are not permitted to have two Roles in the same Company with the same name. You are permitted
to use the same Role name in more than one Company.

From the Role Company list, select the name of the Company whose users can be assigned this Role.
In the Role Description text box, enter a description for the Role.

In the Role Permissions List, edit the permissions that were previously assigned to this Role.

10. Click the Update button. The new Role now appears in the Role list on the Role Administration page.

Deleting a Role

You can delete all Roles with a Role Type of User, but System Roles cannot be deleted.

o

Task: To delete an existing User Role:

1.

2.

196

On the Administration tab, click Roles. The Role Administration page opens.
Select the user-defined Role that you want to delete. The Role Details View opens.
Click Delete. You are prompted to confirm the deletion.

Click OK. The Role Details View closes and the Role you deleted is no longer listed on the Role
Administration page.
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Roles Reference

Reference information for Roles is presented in the following sections:

® Role Administration Page

e Copy Role View

® Role Details View

Role Administration Page

The Role Administration page lists all defined Roles on the system. From this view, you can edit existing Roles or
add new ones. The following options are available:

Table 5-5 * Role Administration Page

Option

Select

Role Name

Description

Click to access the Role Details View, where you can edit this Role.

Name of Role.

Role Company
Role Description

Role Type

Name of company that this Role was defined for.
Description of the purpose of this Role.

Identifies this role as one of the following:

e System—Role was created during installation and cannot be deleted or modified.
However, it can be copied and modified to create a User Role.

e User—Role created by an administrator either by copying an existing System Role
or by creating a new Role.

For more information, see System Roles.

Add

Click to access the Role Details View, where you can add a new Role.

Copy

Click to access the Copy Role View, where you can copy an existing Role.
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Copy Role View

On the Copy Role view of the Role Administration page you can copy an existing System or User Role.

Table 5-6 * Role Administration Page / Copy Role View Options

Option Description

Copy from Select the name of the Company that has a Role that you want to copy.

Company

Copy from Role Select the name of the Role that you want to copy. You can copy either System or User
Roles.

Copy to Company Select the name of the Company that this new Role is being created for.

New Role Name Enter a name to identify this new Role.
Copy Click to create this new Role and close the Copy Role view.
Cancel Click to exit this view without creating a new Role.
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Permissions are assigned to Roles, and Roles are assigned to users. Therefore, all permissions in AdminStudio
and Workflow Manager are controlled by Roles.

On the Role Details view, you can enter or edit information to identify a Role and set the Role Permissions. You can
also delete a user-defined Role.

Table 5-7 * Role Administration Page / Role Details View Options

Option

Role Name
Role Company

Role Description

Description

Enter a name to uniquely identify this Role
Select the Company whose employees can be assigned the Role.

Enter text to identify the purpose of this Role.

Role Permissions
List

Update

Delete

Cancel

Select the specific functionality permissions that you want to assign to this Role. For
more information, see Role Permission Lists and System Roles.

Click to save your entries and close the Role Details view.

Click to delete this user-defined Role.

E

Note - If you are editing a System Role, the Delete button will be disabled.

Click to exit this view without saving your entries.
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Databases

A

A

Edition * Application Manager is included with AdminStudio Professional and Enterprise Editions.

You use Application Manager to manage Application Catalog databases. Tasks you perform using the Application
Manager include importing packages, merging application catalogs, setting up automatic package import,
organizing packages into groups, and viewing a package’s extended attributes, files/components, INI file changes,
registry entries, shortcuts, merge modules, history, and tables.

Information about using Application Catalogs is organized into the following sections:

Table 6-1 ¢ Topics Regarding Using Application Catalogs

Section Description
Application Manager Describes the functionality available using Application Manager and how it differs
and ConflictSolver from ConflictSolver.

Managing Application Explains how to create, connect to, search for, organize, view information about,
Catalogs and delete packages from.

Importing Data Explains how to import Windows Installer packages (.msi) with any associated
transforms (.mst) or patches (.msp), merge modules (.msm), OS snapshots (.osc),
Marimba NCP files (.ncp), and other setup types.
i

Edition * Import support for Marimba Native Channel Packager (.ncp) files is available in
AdminStudio Enterprise Edition.

Using the Software Explains how to manage a software package’s associated installation files using
Repository the Software Repository.
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Table 6-1 « Topics Regarding Using Application Catalogs (cont.)

Section Description
Sharing Application Describes the three methods for sharing Application Catalog data in your
Catalog Data enterprise: merge, auto-import, and replication.

Taking OS Snapshots Explains how to create OS Snapshots using the OS Snapshot Wizard.

Reference Describes every view, dialog box, and Wizard available in Application Manager.

Application Manager and ConflictSolver

Application Manager and ConflictSolver are closely related tools. Both provide a comprehensive view of the
Application Catalog. However, the tasks you can perform using each of these tools differ:

e ConflictSolver is used to perform conflict detection and resolution.

e Application Manager is used for importing and storing packages in a database, and organizing those
packages.

This section compares these tools and includes the following topics:
e Functionality Comparison

® Accessing the Tools

e Displaying ConflictSolver Options in Application Manager

e Creating and Connecting to Application Catalogs in Application Manager and ConflictSolver
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Application Manager and ConflictSolver

This table compares the functionality included in Application Manager and ConflictSolver.

Table 6-2 « Comparison of ConflictSolver and Application Manager Functionality

View

Application
Manager

=

AdminStudio 9.5 User Guide

Major Functionality

Use to perform the following tasks

Import packages—Import packages into the
Application Catalog.

Manage packages—Organize packages into Groups,
rename packages, and delete packages.

Merge Wizard—Merge data from a source Application
Catalog into the currently open Application Catalog.
Package Auto Import—Set up the automatic import
of packages.

Software Repository—Import packages into and
check in and check out packages from the Software
Repository.

Associate a package with a Workflow Manager
package

Launch applications—Launch Predeployment Test
Preparation Wizard, InstallShield Editor, and
Distribution Wizard.

Reports—View Package, File, and Registry reports.

ADS-0950-UG00

Package Sub-Nodes

B Thustrator 10 (v6.22)
E%! Extended Attributes
d FilesiComponents
& INIFile Changes
ﬁ’ Reqistry
Kl Shortcuks
G Merge Modules
@ History

ﬂ Tables

203



Chapter 6: Managing Application Catalog Databases
Application Manager and ConflictSolver

Table 6-2 « Comparison of ConflictSolver and Application Manager Functionality

View Major Functionality Package Sub-Nodes

ConflictSolv | Use ConflictSolver to perform the following tasks: 5 MathPlot (v1,20,0000)
er % Conflicts

e Conflict Analysis and Resolution—Check one or Yalidation
more packages for conflicts against others in the ;E’ith"fsu'tst
i . . atch Impacks
w Application Catalog, and resolve those conflicts. % Dependzndies

e Validation—Validate Windows Installer package g ?::lz';iated Patches
against Microsoft ICEs (Internal Consistency
Evaluators),

o Test Results—View PackageExpert test results.

e Patch Impact Analysis Wizard—Launch Patch
Impact Analysis Wizard for selected package.

e Dependency Scan—Generate a list of all of a
package’s files that have dependencies with files used
by other products or operating systems in the
Application Catalog.

e Associated Patches—View a list of imported patches
that, if installed, would update the selected product.

e Reports—View Package, File, and Registry reports.

For information on using ConflictSolver, see Identifying and
Resolving Application Conflicts Using ConflictSolver.

Accessing the Tools

Both Application Manager and ConflictSolver can be opened from the Start Page, the Tools Gallery, or from a menu

shortcut.
i Application
ConflickSokver Manager

You can toggle between Application Manager, ConflictSolver, and ConflictSolver Process Assistant by clicking a
button in the toolbar:

Ld & &

L Process Assistant
CaonflickSaker

Application Manager
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When the ConflictSolver or Application Manager is active, ConflictSolver or Application Manager is listed in the
Title bar and also in the top right corner of the interface.

Displaying ConflictSolver Options in Application
Manager

By default, all functionality for interacting with the Application Catalog, including conflict detection and resolution, is
available in Application Manager.

To turn off the display of conflict detection and resolution options in Application Manager, select the check box in
the Application Manager Display Options area of the General tab of the ConflictSolver and Application
Manager Options dialog box.

Application Manager Display Options

Turn off dizplay of conflict detection and resolution options in Application
Manager.

Creating and Connecting to Application Catalogs in
Application Manager and ConflictSolver

You can connect to Application Catalogs from both Application Manager and ConflictSolver as described in
Connecting to an Existing Application Catalog. However, you use the AdminStudio interface to create new
application catalogs. See Creating New Application Catalogs.

Managing Application Catalogs

Package information is stored in Application Catalogs. When you use Application Manager, you will either
automatically be logged into an Application Catalog, or you will have to connect to an existing catalog. Once you
have connected to a catalog, you can manipulate data in Application Manager, including creating and organizing
groups and entering extended attribute data.

The following topics relate to Application Catalog management:
e About AdminStudio Application Catalogs

e Using the AdminStudio Quick Start Evaluation Experience
e Connecting to an Existing Application Catalog

e (Creating New Application Catalogs

e Specifying a Default AdminStudio Application Catalog

® Searching an Application Catalog

e Disconnecting from an Application Catalog
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e Upgrading an Existing Application Catalog

e Organizing Your Application Catalog Using Groups
e Viewing and Editing Package Extended Attributes
e Viewing Package History

e Deleting Packages

About AdminStudio Application Catalogs

This section provides the following information:
e Overview of Application Catalogs

e Standalone Application Catalog vs. the AdminStudio Enterprise Server Application Catalog

Overview of Application Catalogs
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To perform enterprise level data checking, it is very efficient if the data can be consolidated into a single database.
The AdminStudio Application Catalog database consolidates data from many installation packages in a single
location.

Application Catalogs can contain the complete contents of Windows Installer (.msi) packages, Merge Module
(.msm) packages, and OS snapshots (.osc). Depending upon the import options that are set, an Application
Catalog can also include binary records. Application Catalogs can also store application, workflow, permissions,
Predeployment Test, Microsoft Patch, PackageExpert, and Workflow Manager data.

You can use ConflictSolver and PackageExpert to test packages in the Application Catalog:

e ConflictSolver—You can use ConflictSolver’'s MSI ICEs (internal consistency evaluators) to evaluate specific
packages, and can use ConflictSolver ACEs (application conflict evaluators) to extend the ICEs and evaluate
data across packages.

e PackageExpert—You can use PackageExpert to analyze the integrity of packages in the Application Catalog
and also identify and resolve any issues packages would have when deployed on the Windows Vista
operating system.

Sharing Application Catalogs

In multi-user environments, the AdminStudio Application Catalog is typically shared. The AdminStudio
Administrator can make a shared catalog the default catalog, which results in all AdminStudio users who use the
same shared location using the same shared Application Catalog. If the shared Application Catalog is changed,
users will automatically open up the new shared Application Catalog. For more information, see Specifying a
Default AdminStudio Application Catalog.
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Sharing Application Catalog Data

There are three methods for sharing Application Catalog data in your enterprise:

e Merge Wizard—Use to merge data from a source Application Catalog into the currently open Application
Catalog.

e Package Auto Import Wizard—Offers two methods of automatically importing Windows Installer packages
into your Application Catalog and keeping them updated.

e Application Catalog Replication— Enables you to distribute an Application Catalog database where it is
needed across a large enterprise or multi-national corporation.

See Sharing Application Catalog Data for detailed information.

Standalone Application Catalog vs. the AdminStudio Enterprise Server
Application Catalog

Edition * AdminStudio Enterprise Server Tools are included with AdminStudio Enterprise Edition.

You can connect to any standalone SQL Server Application Catalog, or you can connect to the AdminStudio
Enterprise Server Application Catalog:

e Standalone—A Standalone Application Catalog is not associated with the Enterprise Server tools. The
AdminStudio client tools connect directly to the database server hosting the standalone Application Catalog.

e AdminStudio Enterprise Server—All of the AdminStudio Enterprise Server tools—Security Console, Report
Center, Job Manager, and Workflow Manager—are connected to the AdminStudio Enterprise Server
Application Catalog. AdminStudio client tools can also connect to this Application Catalog, allowing you to
store all data generated on a package in the same location, and to link packages in this Application Catalog to
Workflow Manager Application Requests.

E

Note * AdminStudio Enterprise Tools are always connected to the AdminStudio Enterprise Server database.
For more information on using Application Catalogs, see the following:
e Connecting AdminStudio Client Tools to a Standalone Application Catalog

e Connecting AdminStudio Client Tools to the AdminStudio Enterprise Server Application Catalog
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Using the AdminStudio Quick Start Evaluation
Experience

When you initially open AdminStudio, because a default Application Catalog has not yet been set, the Default
Application Catalog dialog box opens, prompting you to open an Application Catalog.

Default Application Catalog @

Adminstudio has detected that no default application catalog exists. You can set up a SQL server and create a new default application
catalog, create and connect to a new default application catalog on an existing server, or simply connect ko an existing application
catalag. ¥ou will have the option of including sample application data when creating a new application catalag.

(%) Quick Start
Select this option if no database server exists, Microsoft SQL Server 2005 Express will be installed on this machine then the
Iew Application Catalog 'Wizard will guide you through creating a new application catalog.
Strong password For new 'sa’ account: | |

) Create a new Application Catalog
If vou have access to an existing database server, select this option ko start the process of creating a new AdminStudio
application catalog.

) Connect ko an existing Application Catalog

If an Adminstudio application catalog you want to use already exists, select this option,

Cancel J l Help

Figure 6-1: Default Application Catalog Dialog Box

To quickly get started using AdminStudio, select one of the following options:

e [f you do not have access to a database server, but you want to quickly start using AdminStudio, select
the Quick Start option. Microsoft SQL Server 2005 Express will be installed on your machine first, then you
will have the option to create a new Application Catalog database on that server that is populated with sample

data.

e |f you do have access to a database server, but just do not have any sample data in it, select the Create
a new Application Catalog option, and choose to populate this new Application Catalog with sample data
by selecting the Include Sample Data in New Catalog option on the Create Application Catalog dialog

box.

Connecting to an Existing Application Catalog

208

Edition * AdminStudio Enterprise Server Tools are included with AdminStudio Enterprise Edition.

From AdminStudio and the AdminStudio client tools, you usually connect to an Application Catalog by selecting

Connect on the Catalog menu. AdminStudio supports SQL Server databases.

E

Note - Starting with AdminStudio 9.01, Oracle databases are not supported.
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You can choose to connect to a standalone Application Catalog database or the AdminStudio Enterprise Server
Application Catalog database.

e Connecting AdminStudio Client Tools to a Standalone Application Catalog

e Connecting AdminStudio Client Tools to the AdminStudio Enterprise Server Application Catalog

E

Note * See Standalone Application Catalog vs. the AdminStudio Enterprise Server Application Catalog for more

information.

E

Note  AdminStudio Enterprise Tools are always connected to the AdminStudio Enterprise Server database.

Connecting AdminStudio Client Tools to a Standalone Application
Catalog

To connect to an existing Standalone Application Catalog from an AdminStudio client tool (Application Manager,
ConflictSolver, or PackageExpert), perform the following steps.

o

Task: To connect to an existing Standalone Application Catalog from the AdminStudio client tools:
1. Perform one of the following:
e Application Manager and ConflictSolver—On the Catalog menu, click Connect.
e PackageExpert—Select the Application Catalog node and select Connect from the context menu.

The Connect Application Catalog dialog box opens, displaying three tabs: Enterprise Server,
Standalone, and Recent.

2. Click the Standalone tab. The Standalone tab opens, prompting you to enter database connection
information.

3. If you want this Application Catalog to be the default shared Application Catalog used in your organization,
select the corresponding option at the bottom of the dialog box.

4. Select the Server where the Application Catalog is stored.

5. Specify how the database server should verify the authenticity of the login—either using Windows
Authentication or Server Authentication. If you selected Server Authentication, enter the appropriate
Login ID and Password.

6. Inthe Catalog box, enter the name of the Application Catalog you want to open.
7. Click Test to test the connection to the database.

8. Click OK.
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Connecting AdminStudio Client Tools to the AdminStudio Enterprise
Server Application Catalog

Edition * AdminStudio Enterprise Server Tools are included with AdminStudio Enterprise Edition.

The AdminStudio Enterprise tools (Report Center, Job Manager, and Workflow Manager) are configured during
installation to connect to an Application Catalog, which is referred to as the Enterprise Server Application Catalog.

You can also connect the AdminStudio client tools to the Enterprise Server Application Catalog. This allows you to
have all of the client and enterprise tools reference the same database.

To connect to the AdminStudio Enterprise Server application catalog from an AdminStudio client tool, perform the
following steps.

Task: To connect to the AdminStudio Enterprise Server Application Catalog:

1.

210

Perform one of the following:
e Application Manager and ConflictSolver—On the Catalog menu, click Connect.
e PackageExpert—Select the Application Catalog node and select Connect from the context menu.

The Connect Application Catalog dialog box opens, displaying three tabs: Enterprise Server,
Standalone, and Recent.

Open the Enterprise Server tab.

The URL to the AdminStudio Enterprise Server is listed above the Authentication field. If the AdminStudio
Enterprise Server has not yet been configured with the AdminStudio client tools (such as when it is set to its
default value of http://Tocalhost), click the URL link to open the Select AdminStudio Enterprise Server
URL dialog box, and enter the URL for location of the AdminStudio Enterprise Server associated with this
installation of AdminStudio.

From the Authentication list, select either AdminStudio Enterprise Server User or Windows
Authentication.

0

Important « When using AdminStudio Enterprise Server User authentication, if Anonymous

authentication is turned off in IIS, both the user’s machine and the AdminStudio Enterprise Server need to be on
the same domain in order for login to succeed.

If you selected AdminStudio Enterprise Server User, enter your AdminStudio Enterprise Server User
Name and Password (provided by your System Administrator).

Click Login. After a successful login, the Provider, Server, and Catalog name of the Enterprise Server
database is listed.

Click OK.
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Login Troubleshooting

If you are using a Web Portal with custom security zone settings, your AdminStudio Enterprise Server URL is using
an IP address, and you receive Error 0xX800A1518 when you attempt to login, change the AdminStudio Enterprise
Server URL to the NetBios equivalent and then try again. For example, if you are connecting to http://
120.12.1.15, the NetBios equivalent would be http://wfmportal.

Creating New Application Catalogs

You can create new Application Catalogs using the AdminStudio interface, or using scripts. This section includes
the following topics:

Creating New Application Catalogs Using the AdminStudio Interface

Creating New Application Catalogs Using Scripts

Creating New Application Catalogs Using the AdminStudio Interface

To create a new SQL Server application catalog database, perform the following steps.

&

Task: To create a new standalone Application Catalog:

1.

On the AdminStudio Catalog menu, click Create. The Welcome panel of the Application Catalog Wizard
opens.

If you want to include a few sample packages in this new Application Catalog, select the Include Sample
Data in New Catalog option.

Click Next. The Specify Database Information panel opens.
Enter or select the name of the Server where this Application Catalog will be stored.

Specify how the database server should verify the authenticity of the login—either using Windows
Authentication or Server Authentication. If you selected Server Authentication, enter the appropriate
Login ID and Password.

In the Catalog box, enter the name of the Application Catalog you are creating.

If you are creating a new SQL Server database which is intended for use as a Subscriber for Application
Catalog Replication, select the Create catalog as a subscriber option. If you do not intend to use the
Replication functionality that AdminStudio provides for SQL Server, do not select this option. For more
information, see About Creating a Catalog as a Subscriber and Replicating Application Catalogs.

Click Test to test the connection to the database.

Click Next. The Select Software Repository Location panel opens, prompting you to select the location
where the Software Repository will store imported packages and their associated files. For more information,
see Using the Software Repository.
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10. If you want to store data associated with this Application Catalog’s packages in the Software Repository,
choose the Enable the Software Repository option, select a Software Repository Location, and enter a
Login ID and Password of the Proxy Account that must be used to access this Repository.

11. Click Next. The Creating Application Catalog panel opens and reports on the creation progress. When the
Application Catalog has been created, a message appears stating that the creation was successful.

12. Click Finish. The new Application Catalog now opens in AdminStudio.

About Creating a Catalog as a Subscriber

Please note the following about creating a Subscriber Application Catalog for Application Catalog Replication:
® You cannot create a Publication in a Subscriber database.

e [fyou choose the Create catalog as a subscriber option, making it a Subscriber database, the
Subscription Manager option under Replication on the Catalog menu is enabled.

e If you do not choose this option, making it a Publisher database, the Publication Manager option under
Replication on the Catalog menu is enabled.

e Once you have created a database, you cannot go back and edit the choice you made on this option.

e Just because you select this option does not mean that this database must contain subscribed data or that all
of its data must be subscribed. It can contain all local data or both local and subscribed data.

For more information, see Replicating Application Catalogs.

Tip  The first time AdminStudio is run, anyone can create an SQL Server database (providing they have access to
aN SQL Server and database creation rights). However, once an AdminStudio Application catalog has been created,
the database creator becomes the Application Catalog administrator, and security rights are in place in
AdminStudio.

Creating New Application Catalogs Using Scripts

Typically, users with administrative privileges in AdminStudio use Create on the Catalog menu to create a new
Application Catalog.

However, because of security concerns, some Database Administrators may be hesitant to grant the database
creation rights that are necessary to create an Application Catalog database using SQL Server to AdminStudio
users. Consequently, the Database Administrator must manually create the database using scripts and provide the
necessary read and write access for users to that database.
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AdminStudio is shipped with database creation SQL scripts to make it easy for Database Administrators to create
new Application Catalogs:

Table 6-3 * Scripts to Create Application Catalog Databases on SQL Server

Script File Description
AMS_System_Schema. SQL Primary Workflow Manager tables
AMSCreateIndex.SQL Indexes for Workflow Manager tables

AMS_SamplePackagingTemplate.SQL Sample Workflow Manager template data
AS_Schema. SQL Primary AdminStudio client tools data

CustomReportWizard.SQL Report Center data

These SQL scripts are located in the following directory:
AdminStudio Installation Directory\Support\SQL_Scripts

To create an Application Catalog database on SQL Server, perform the following steps:

Task: To use scripts to create an AdminStudio Application Catalog on SQL Server
1. Log onto your SQL Server.
2. Launch the Enterprise Manager and Query Analyzer.

3. In Query Analyzer, execute a CREATE DATABASE command to create and identify the new Application Catalog
database.

4. Select the newly created database in Query Analyzer.
5. Execute the following scripts in order:

AMS_System_Schema.SQL

a
b. AMSCreateIndex.SQL

o

AMS_SamplePackagingTemplate.SQL

a

AS_Schema.SQL

e. CustomReportWizard.SQL
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Specifying a Default AdminStudio Application Catalog

214

You can specify a default Application Catalog so that each time you open AdminStudio, you will be prompted to
login to the same Application Catalog database.

You can also configure your enterprise so that all of the users at your enterprise will be prompted to login to the
same Application Catalog each time they open AdminStudio.

Setting a Default Application Catalog for Yourself

Whenever you connect to an Application Catalog, you can designate it as the default Application Catalog by
selecting the Make this the shared default Application Catalog option on the Connect Application Catalog
dialog box.

Connect Application Catalog !|

Enterprise Server | Standalane | Recent
Provider:

SCOL Server L
Dt ails:
Server: SZHOLHOWEPEPMSQLEXPRESS b
Authentication: | server A ithentication s
Login I0: sa
Password: TTITIT ]
Catalog: hd

[ M ake this the default shared Application Catalog

[ Ok, ][ Cancel ][ Help ]

Figure 6-2: Default Shared Application Catalog Option on the Connect Application Catalog Dialog Box

Setting the Default Application Catalog for Your Enterprise

To configure your enterprise so that all of the users at your enterprise will be prompted to login to the same
Application Catalog each time they open AdminStudio, all users need to be connected to the same AdminStudio
Shared.ini file that is stored in a shared network location that is available to all users.

Methods to Set the Default Application Catalog for Your Enterprise
You can set a default Application Catalog for all AdminStudio users in your enterprise in two ways:
e Using the AdminStudio Interface

or

e Editing the Shared AdminStudio.ini File
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Using the AdminStudio Interface

To use the AdminStudio interface to set a default Application Catalog for all AdminStudio users at your enterprise,
perform the following steps.

o

Task: To specify the default Application Catalog:

1. First, the AdminStudio System Administrator needs to perform the following steps to set the default Application
Catalog for the enterprise:

a.

b.

f.

Locate and copy the following file on the machine where you installed AdminStudio:
C:\AdminStudio Shared\Shared AdminStudio.ini

Copy this file to a shared network location that is accessible to all of the users in your enterprise.
Launch AdminStudio.

On the Tools menu, click Options. The AdminStudio Options dialog box opens.

Open the Locations tab.

Set the AdminStudio Shared Location to the network location where you copied the
Shared AdminStudio.1ini file, such as:

\\servername\AdminStudio Shared

Open the Application Catalog tab.

Click Change next to the Shared AdminStudio Application Catalog field. The Select Application
Catalog dialog box opens.

Select the Application Catalog database that you want to be set as the default, following the instructions in
Connecting to an Existing Application Catalog.

After you connect to the database, that database name is listed in the Shared AdminStudio
Application Catalog field.

Click OK to close the Options dialog box.

2. Next, each AdminStudio user in the enterprise needs to perform the following steps to set the location of their
AdminStudio Shared directory to the same shared network directory that the System Administrator
configured.

b.

Launch AdminStudio.
On the Tools menu, click Options. The AdminStudio Options dialog box opens.
Open the Locations tab.

Set the AdminStudio Shared Location to the shared network location provided by your System
Administrator.
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A

Caution - If a user is not assigned to a Role that has the Modify AdminStudio Tools Options Dialog

permission, they cannot change the location of the AdminStudio Shared directory on the Options dialog. In
this situation, the location of the AdminStudio Shared directory would be set during installation.

Editing the Shared AdminStudio.ini File

W

Task:

216

To set a default Application Catalog for all AdminStudio users at your enterprise by editing the Shared
AdminStudio.ini file, perform the following steps.

To specify the default Application Catalog by editing the Shared AdminStudio.ini file:

1.

E

First, the AdminStudio System Administrator needs to perform the following steps to set the default Application
Catalog for the enterprise:

a. Locate and copy the following file on the machine where you installed AdminStudio:
C:\AdminStudio Shared\Shared AdminStudio.ini

b. Copy this file to a shared network location that is accessible to all of the users in your enterprise.

c. Open the Shared AdminStudio.ini file that you just copied to a shared network location.

Insert the following in the [Database Settings] section of the Shared AdminStudio.ini file:

[Database Settings]
DefaultDatabase=Provider=SQLOLEDB.1;User ID=userid; PWD=password;Initial
Catalog=nameofdatabase;Data Source=nameofsqiserver;

Next, each AdminStudio user in the enterprise needs to perform the following steps to set the location of their
AdminStudio Shared Location directory to the same shared network directory that the System
Administrator configured.

a. Launch AdminStudio.
b. On the Tools menu, click Options. The AdminStudio Options dialog box opens.
a. Open the Locations tab.

b. Setthe AdminStudio Shared Location to the shared network location provided by your System
Administrator.

AN

Caution - If a user is not assigned to a Role that has the Modify AdminStudio Tools Options Dialog

permission, they cannot change the location of the AdminStudio Shared folder on the Options dialog. In
this situation, the location of the AdminStudio Shared location would be set during installation.

Note * The Roles assigned to a user determine that user’'s permissions:
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e The Create and Connect options on the Catalog menu on the AdminStudio Interface are disabled for use
that are not assigned to a Role that has permission to perform those actions.

® Users that are assigned to Roles that have the Modify AdminStudio Tools Options Dialog permission ¢
change the location of the AdminStudio Shared folder on the Options dialog (accessed by selecting

ogs

rs

an

Options on the Tools menu from the AdminStudio Interface). For those users who do not have that permission,

Options on the Tools menu is disabled, so they are unable to change the location of the AdminStudio
Shared folder.

Searching an Application Catalog

You can search for data in Application Catalog tables by using Find on the Edit menu. You can search all tables in

all packages in a group, or just search one column in one table of one package.

E

Note - This search is limited to string type columns.

The tables that are searched depend upon what is selected when the Find dialog box is opened:

Table 6-4  Application Catalog Search Options

If you select... and specify these options... this will be searched
Application All Tables and All Columns All tables and all columns in all of the packages in
Catalog the Application Catalog.
Group All Tables and All Columns All tables and all columns in all of the packages in

the selected group.

Package All Tables and All Columns All tables and all columns in the selected package.

Package A table and All Columns All columns of a specific table in the selected
package.

Package A table and a column A specific column in a specific table in the selected
package.

To search the Application Catalog:
1. Open an Application Catalog in Application Manager or ConflictSolver.

2. Select the node in the tree (Application Catalog, Groups, a specific group, a specific package, an OS
snapshot, etc.) that you want to search.

3. On the Edit menu, click Find. The Find dialog box opens.
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You could also click the Find button ( .~ ) on the toolbar, use Ctrl + F, or choose Find from the selected
package or group’s context menu.

In the Find What text box, enter the text that you want to search for.

E

Note - This search is limited to string type columns.

On the Look In Table list, select the table that you would like to search, or select <All Tables>. When you
select a table from this list, the Look In Columns list is populated with all of the columns in that table.

If you selected a table from the Look in Table list, all of the columns in that table are listed. Select the column
that you would like to search, or select <All Columns>.

If you want to search for a partial match rather than an exact match, select the Partial Match option.

e If this option is not selected, Application Manager will search for an exact match of the text you
entered in the Find What text box. The search will be case sensitive.

e If this option is selected, then Application Manager will use appropriate wild card characters so that a
partial data match is performed. The search will be case insensitive

Click Find to initiate the search.

The Find dialog box will close, and the data that is found is displayed in the Search Results tab of the Output
Window, in the following format:

= Package Mame Table Name Column Mame | Column Data 25
DemnPlayer camsifctionText Action AppSearch
Morton Antivirus Corporate Edition  csmsifctionText Action AppSearch
Micrasoft Carporation_Orca csmsifckionText Action AppSearch
DemaPlayer csmsisys_Yalidation Table AppSearch
DemaPlayer csmsisys_Yalidation Table AppSearch
Morton Antivirus Corporate Edition  csmsisys_Yalidation Table AppSearch
MNorton Ankivirus Corporate Edition  csmsisys_Yalidation Table AappSearch v
[ATFTPT output Ay Import A validate A Conflicts A Patch Impact ji Package Auto Impart Ay Search Resuks /
15 occurrenceds) of 'AppSearch’ have been Found.

If you double click on the data displayed in the Output Window, Application Manager will navigate to the
appropriate record in the Tables View, and that record will be highlighted in red.

Disconnecting from an Application Catalog

218

To disconnect from the currently open Application Catalog, select Disconnect from the Catalog menu. You can
disconnect from an Application Catalog while you are in ConflictSolver, Application Manager, PackageExpert, and
also when you are in the AdminStudio Interface.

When you have disconnected from an Application Catalog in ConflictSolver or Application Manager, the following
message appears:

ConflictSolver requires a connection to the AdminStudio Application Catalog. Select Connect from the

Catalog menu to establish a connection.
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Upgrading an Existing Application Catalog
When you attempt to open an AdminStudio 5.0, 5.5, 6.0, 7.0, or 7.5 Application Catalog in AdminStudio 9.5, you
are prompted to upgrade it to use the AdminStudio 9.5 schema.
Log files for the upgrade are created in the following directory:

AdminStudio Shared Directory\ConflictSolver\Logs

E

Note « Note the following regarding upgrading an existing Application Catalog:

The upgrade of AdminStudio 3.0, 3.01, and 3.5 databases is not supported by AdminStudio 7.0 or later.
Starting with AdminStudio 8.0, Microsoft Access databases are not supported.
Starting with AdminStudio 9.01, Oracle databases are not supported.

When an SQL Server Application Catalog database is upgraded, the old tables are not dropped from the
Application Catalog.

Upgrading Pre-AdminStudio 5.0 Application Catalogs

Pre-AdminStudio 5.0 Application Catalogs cannot be upgraded automatically by AdminStudio 7.0 or later.
However, you can upgrade them using the Legacy Upgrade Wizard, a standalone utility that was included with
AdminStudio 7.0 and 7.5. The Legacy Upgrade Wizard utility is installed in the following directory:

C:\Program Files\InstallShield\AdminStudio\7.x\Common\LegacyUpgradeWizard.exe

If you do not have a copy of AdminStudio 7.0 or 7.5 available to you, contact Technical Support.

Organizing Your Application Catalog Using Groups

Within Application Manager and ConflictSolver, you can create groups to organize your products, patches, and OS
Snapshot images in the Application Catalog. This is especially useful for organizing your Application Catalog in
ways consistent with how your company is organized.

For example, you could create a group representing a certain department’s base image including the proper
operating system and necessary applications. When you perform conflict analysis on new packages you are
integrating into your environment, you can run only the relevant comparisons—saving you the time it would take to
run the analysis against all packages in the Application Catalog, or the effort of manually determining the set of
packages against which you want to run the analysis each time.
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Tasks relating to groups include:
e Adding Groups
e Organizing Products in Application Manager
e Deleting Application Manager Groups
e Editing Group Properties
e Copying Packages to Multiple Groups

® Moving Products, OS Snapshots, and Groups

Adding Groups

To add additional groups or subgroups to an Application Catalog, perform the following steps.

%

Task: To add a group to Application Manager:

1. Inthe Application Manager Product View, right-click on the group to which the new group should belong
and select New Group.

2. Provide a name for the new group.

3. Press Enter.

Organizing Products in Application Manager

To move products or groups into different groups, perform the following steps:
Task: To organize individual packages and groups of packages in Application Manager:

1. From the Application Manager Product View, select a product or group you want to move.

2. Drag the product or group onto a new group.

E

Note - The following rules apply to drag and drop operations in the Application Manager Product View:

® You cannot drop a node on itself.
® You cannot drop a node on its parent. It is already a child of the parent.
® You cannot drop a group on its child groups.
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Deleting Application Manager Groups

To delete a group from an Application Catalog, perform the following steps:

o

Task: To delete a Application Manager group:

1. Right-click the group you want to delete in the Application Manager Product View and select Delete from
the context menu.

2. From the resulting message box, confirm the deletion.

AN

Caution * When you delete a group, all subgroups and packages within that group are also removed from the
Application Manager.

Editing Group Properties

For each group, you can modify its name, and add a description or other comments. To edit this information,
perform the following steps.

Task: To edit group properties:

1. Right-click on the group from the Application Manager Product View and select Properties from the
context menu. The Group Properties dialog box opens, displaying the group Name, Description, and
Comments.

2. Make any desired edits.

3. Click OK.

Copying Packages to Multiple Groups

More than one copy of the same package can exist in an Application Catalog. You can copy a package from one
group into another group.

o

Task: To copy a package to multiple groups:

1. Select the package from the Application Manager Product View.

2. While holding down the Ctrl key, drag the package to the group into which you want it copied.

E

Note  You can also right-click on a package and use the copy and paste commands to copy the item.
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Moving Products, OS Snapshots, and Groups

o

In addition to copying OS Snapshots or Products to multiple groups, you can also move OS Snapshots, Products,
or Groups into other groups.

Task:

To move a product, OS Snapshot, or group:
1. Select the product, OS Snapshot, or group you want to move in the Application Manager Product View.

2. Drag the item into a new group.

E

Note  You can also right-click on a product, OS Snapshot, or group and use the cut, copy, and paste
commands to move or copy the item.

Viewing and Editing Package Extended Attributes

222

Extended attributes are optional attributes for packages, defined by an Extended Attribute Description File (in XML
format). Because you can manually create the description file, you have the flexibility to include information about
each package that may be specific to your organization—such as the users or business groups that receive the
package.

Extended attributes can be edited in the Extended Attributes view on a package-by-package basis.
The following tasks and concepts relate to extended attributes:

e Using Extended Attributes

e Extended Attribute Description File

e |Integrating Package Extended Attribute Data with an Application Request

E

Note * You can also edit a package’s extended attributes in the ConflictSolver Process Assistant. See Extended
Attributes Page.
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Using Extended Attributes

Assuming you have created an extended attribute description file (or are using the default provided file), you can
configure Application Manager to use it with the current Application Catalog.

o

Task: To use extended attributes in Application Manager:

1. With Application Manager open, click Options on the Tools menu. The ConflictSolver and Application
Manager Options Dialog Box opens.

2. Click the Extended Attributes tab.

3. Specify or browse to the extended attribute description file (.xm1) containing the extended attributes you want
to use for Application Manager.

4. Click OK.

The Extended Attributes View is available under each package in Application Manager.

AN

Caution « The default Extended Attribute description file is named EA_Default.xml, and is installed in the
AdminStudio Shared folder. You can modify the data displayed in the Extended Attributes view, but to do this, do
not edit the EA_Default.xml file. Instead, copy the EA_Default.xml file, rename it, make your edits to the new file, and
then enter the new file name and location in the Extended Attribute Description File field on the Extended
Attributes tab of the ConflictSolver and Application Manager Options dialog box.

Extended Attribute Description File

Application Manager uses an XML file to describe the data that appears in the Extended Attributes view. The
name and location of this XML file can be specified from the Extended Attributes tab in the ConflictSolver and
Application Manager Options dialog box.

AN

Caution + The default Extended Attribute description file is named EA_Default.xml, and is installed in the
AdminStudio Shared folder. You can modify the data displayed in the Extended Attributes view, but to do this, do
not edit the EA_Default.xml file. Instead, copy the EA_Default.xml file, rename it, make your edits to the new file, and
then enter the new file name and location in the Extended Attribute Description File field on the Extended
Attributes tab of the ConflictSolver and Application Manager Options dialog box.
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Description File Properties

The description file, which is in XML format, contains tags for each extended attribute (up to a limit of 400
attributes). It supports text or file values. The following list explains each tag available in the description file.

Table 6-5 ¢ Description File Tags

Attribute Description

Uniqueldentifier This value, which Application Manager uses to validate that the XML file is for
extended attributes, must be set to ISASEA40.

Name The name of the attribute as it appears in the Extended Attributes view. This cannot
exceed 255 characters.

Type The extended attribute type. This can be Text, File, or Selection. If no type is
specified, then Application Manager defaults the attribute to text.

DefaultValue This tag, available only for Text types, provides the default value for the attribute.
This optional value cannot exceed 512 characters.

DefaultFileExtension This tag, available only for File types, provides the default file extension when you
browse for the file. Examples of this could be *.txt, *.bmp, *.doc, or *.*
(representing all files).

FileFilter Provide the file types to populate the File type filter in the Browse dialog box. These
must be in pairs, and in the format Longname (*.ext) | *.ext. Before the closing </
FileFilter> tag, you must have two pipe symbols (| |).

For example, to include filters for text files, bitmaps, and all files, use the following
line:

<FileFilter>Text Document (*.txt)|*.txt|Bitmap (*.bmp)|*.bmp|A11 Files
C.®) | *.%| |</FileFilter>

This value cannot exceed 255 characters.

Caption The caption for the Browse dialog box when using File types. This cannot exceed
255 characters.

Values Used only for Selection types, this is a semicolon-delimited list of possible values
for the selection. These will appear in a drop-down list for the extended attribute.
The first value is used as the default. The total number of characters of all the
values and necessary semicolons cannot exceed 255 characters.

HelpText Text that appears below the value field for either Text or Selection attributes. You
can use it to provide additional information to help users know what to input. This
cannot exceed 512 characters.
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Description File Format
An example of an extended attribute description file follows:

<Extended_Attribute Uniqueldentifier="ISASEA40">

<AttributeDetails>
<Name>Owner</Name>
<Type>Text</Type>
<DefaultValue></DefaultValue>
<HelpText>Provide the name of the package's owner.
</HelpText>

</AttributeDetails>

<AttributeDetails>
<Name>Test Script</Name>
<Type>File</Type>
<DefaultFileExtension>*.*</DefaultFileExtension>
<FileFiTter>A11 Files (*.*)|*.*||</FileFilter>
<Caption>Test Script Files</Caption>

</AttributeDetails>

<AttributeDetails>
<Name>Program Type</Name>
<Type>Selection</Type>
<Values>0ffice Application;Utility;
Graphic Application;Programming Application;Game;Other
</Values>
<HelpText>Select the type of application from the
above 1ist.
</HelpText>

</AttributeDetails>

</Extended_Attribute>

Integrating Package Extended Attribute Data with an Application Request

E

Note * AdminStudio Workflow Manager is a Web-based application management system that has integrated
functionality with AdminStudio.

Application Manager allows you to integrate extended attributes with AdminStudio Workflow Manager. This option
is enabled by selecting the Integrate with Workflow Manager option on the Extended Attributes of the
ConflictSolver and Application Manager Options dialog box.

When the Integrate with Workflow Manager option is selected, you can associate extended attribute data for
packages in Application Manager with Application Requests in Workflow Manager. This is accomplished by right-
clicking on the package name in the Application Manager Product View and selecting Associate with Workflow
Manager Application from the context menu.
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W

Task:

To associate a package with a Workflow Manager Application Request:

1. Open Application Manager.

2. Connect to the AdminStudio Enterprise Server Application Catalog. See Connecting AdminStudio Client Tools
to the AdminStudio Enterprise Server Application Catalog.

3. On the Tools menu, click Options. The Options dialog box opens.
4. On the Extended Attributes tab, confirm that the Integrate with Workflow Manager option is selected.

5. Inthe Application Manager Product View, select the product that you want to link to Workflow Manager and
select Associate with Workflow Manager Application from the context menu.

The Associate with Workflow Manager Application dialog box opens.
6. Pick the application in Workflow Manager with which you want to associate this product.

Assuming that Workflow Manager is configured to use the same extended attributes file, if you enter new data into
the Extended Attributes view in Application Manager, Workflow Manager automatically detects it; if changes are
made in Workflow Manager, they are automatically reflected in Application Manager.

By design, extended attributes data in Application Manager and Workflow Manager data have a one-to-one
relationship. You can only associate one Workflow Manager application with a product in Application Manager;
once the application is associated, it is no longer available for association with other Application Manager
products.

E

Note ° Another integration feature between AdminStudio and Workflow Manager is that when you associate a
package with a Workflow Manager Application Request and then view that Application Request’s Application
Report, there is a link to open the Package Report of its associated package. There is also a link on the Package
Report to open the Application Report of its associated Application Request.

Viewing Package History

226

The tracking of change history is a critical operation within the Enterprise environment. Maintaining this
information, displaying it, and allowing it to be a filter will gives you the information you need to monitor and
maintain the integrity of your software packages.

In AdminStudio, any operation that materially changes a software package or the data associated with the package
is tracked, and can be viewed in the Application Manager History view.
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Task: To view a package’s history:

1. Open Application Manager.

2. Inthe Application Manager Product View, expand a package’s tree and select the History node. The
History View opens, displaying the following information:

Item

Maximum History
Log Per Package

Description

Enter the maximum number of History Log entries you want to store for each
package. When the number of log entries exceeds this amount, the oldest entry
will be deleted.

Action Name of the event which was logged:
® Import/Reimport
e Validation
e Conflict Detection
e Conflict Resolution
e Extended Attribute Modification
e Package Description Modification
e Package Move/Copy
e Patch Impact Analysis
E
Note ° You can specify which events you want to be listed on the History View by making
selections on the History Tab of the ConflictSolver and Application Manager Options Dialog
Box. You can choose which events you want to log and which events you want to display in
the History View.
Date Date and time logged event occurred.
User User who performed the logged event.

Description

E

Description providing details of the logged event.

Note - If a package was replicated into another Application Catalog, its history data would not be replicated.
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Task:

Deleting Package History

To delete all of the entries in a package’s History Log File, perform the following steps:

To delete package history:
1. Open Application Manager.
2. Select the package and right-click to open the context menu.

3. On the context menu, point to Delete and click History Log Information.

Deleting Packages

%

You can delete packages that have been imported into the Application Catalog.

Task:

To delete a package from Application Manager:

1. Right-click on the package in the Application Manager Product View, point to Delete on the context menu,
and click Package (to delete the package from the selected Group) or Package from all Groups (to delete
the package from all Groups in the Application Catalog).

2. Confirm the deletion.

Importing Data

228

You can use the Import Wizard to import the following types of data into the Application Catalog:

Importing Windows Installer Packages, Transforms, and Patches

You use the Application Manager Import Wizard to import Windows Installer packages (.msi) with any associated
transforms (.mst) and patches (.msp) into the Application Catalog. See Importing Windows Installer Packages,
Transforms, and Patches.

Ad-Hoc Import

You can also import transform files and patch files after the package that they are associated with has already been
imported into the Application Catalog. This is referred to as an ad-hoc import. The imported transform or patch file
is then stored in the Software Repository along with the rest of the imported package’s associated files. See Using
the Software Repository and Performing an Ad-Hoc Import of Transform Files or Patch Files.

[]

Important « You can only perform an ad-hoc import if you are connected to a Software Repository-enabled
Application Catalog.
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Importing Virtual Packages

You can import Microsoft App-V, VMware ThinApp, and Citrix virtual packages into the Application Catalog. You
have several options in how to import a virtual package:

® During the import of the Windows Installer package—During the import of a Windows Installer package,
if the Import Wizard searches for and finds a virtual package created by AdminStudio, you are prompted to
also import that virtual package. See Importing a Virtual Package During the Import of its Source Windows
Installer Package.

e After the import of the Windows Installer package—If you import an AdminStudio-created virtual
package into an Application Catalog that already contains the virtual package’s source Windows Installer
package, you are prompted to associate the virtual package with the Windows Installer package. See
Importing a Virtual Package After the Import of its Source Windows Installer Package.

e By itself—You can use the Import Wizard to import a virtual package directly into the Application Catalog.
Then you can use the Associate Package function to associate the virtual package with its source package.
See Importing a Virtual Package Without Its Source Windows Installer Package and Manually Associating a
Virtual Package with a Windows Installer Package.

Importing Merge Modules

A merge module (.msm) is a package containing all of the logic and files needed to install distinct pieces of
application functionality such as run-time .d11 files and virtual machines. Merge modules are built once and can be
added to any installation project. Merge modules, which are imported into the Application Catalog using the Import
Wizard, are used primarily during conflict detection.

For optimal performance, Merge modules should be imported into an Application Catalog database prior to
importing Windows Installer packages. This ensures that conflicts resulting from not using available merge
modules are correctly identified. For more information, see Importing Merge Modules.

Additional Data

Additionally, you can use the Import Wizard to import OS snapshots (.osc), Marimba Native Channel Packager
(.ncp) files and other non-MSI based setup programs. See Importing OS Snapshots, Importing Marimba NCP
Files, and Importing Other Setup Types.

Importing Windows Installer Packages, Transforms, and
Patches

You can import a Windows Installer package with all of its associated transform files and patches into the
Application Catalog at the same time. The transform files and patches are immediately associated with the
Windows Installer package.

Tasks associated with importing Windows Installer packages, transforms, and patches include:
® |mporting Windows Installer Packages
® Using Duplicate Package Identifiers

e Performing an Ad-Hoc Import of Transform Files or Patch Files
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Once you import these files, they become available for conflict identification.

E

Note * Although you can identify conflicts between an external package and packages already in the Application
Catalog, it is strongly recommended you import the package first and perform conflict identification after import.
Conflict information is only persisted for the last conflict identification performed between an external package and
packages in the Application Catalog, and performance is better when performing conflict identification between
internal packages. See Conflict Persistence for more information.

Importing Windows Installer Packages

Task:

230

You can use the Import Wizard to import Windows Installer packages with all of its associated transform and patch
files.

Application Manager stores imported Windows Installer (.ms1) packages for further conflict analysis. When you
import a package into an Application Catalog, you can automatically run validation and conflict identification
features, if configured through the ConflictSolver and Application Manager Options dialog box.

To import a Windows Installer package with any associated Transform and Patch files into an
Application Catalog:

1. On the Catalog menu, click Import Package. The Import Wizard Welcome panel opens.
2. Click Next. The File Selection panel opens.
3. Click Browse and select the Windows Installer package that you want to import.

4. If you want to add the selected package to the Software Repository, select Add the file(s) to the Software
Repository option. After you select this option, if AdminStudio determines that there are other files in that
directory that could be associated with the selected file, the Additional Dependencies of the Import File
list appears, enabling you to select any additional files to be managed by the Software Repository.

5. When you are finished making selections on the File Selection panel, click Next. The MST Source
Information panel opens, where you may optionally select any additional transform (.mst) files to be
imported along with the Windows Installer package.

E

Note » When the MST Source Information panel opens, all of the .mst files that are in the same directory as
the Windows Installer file you are importing are automatically listed in the Transform Files (.mst) list, but only
those .mst files that AdminStudio determines are probably applicable to this Windows Installer package are
selected to be included in the import. If you do not want to import a selected .mst file, clear the selection.

6. Should the package require transforms, click the New button (i) in the Transforms area to browse to the
location of the transform. If the package requires multiple transforms, you can repeat the procedure as
necessary. The order in which transforms are applied can be changed by selecting a transform and clicking
the Move Up and Move Down buttons. If you need to delete a transform you have added, select the
transform and click the Delete button.
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7. When you have finished adding transforms, click Next. The MSP Source Information panel opens, where
you may optionally select any additional patch (.msp or .exe) files to be imported along with the Windows
Installer package.

8. Should the package require patches, click the New button (i) in the Patches area to browse to the location
of the patch. If the package requires multiple patches, you can repeat the procedure as necessary. The order
in which patches are applied can be changed by selecting a patch and clicking the Move Up and Move
Down buttons. If you need to delete a patch you have added, select the patch and click the Delete button.

9. When you have finished adding patches, click Next. If the package that you are importing includes some
custom tables, the Import Options panel opens, prompting you to specify whether you want to import these
tables.

10. To add one of the listed tables to the Ignore Tables list on the Import tab of the ConflictSolver and
Application Manager Options dialog box (so that it will not be imported into the Application Catalog during
any import), select the table name and click Add to Ignore List.

11. Click Next. The Destination Group panel opens.

E

Note - If you opened the Import Wizard by selecting a Group in the Application Catalog and then selecting
Import Package from the context menu, the package will be imported into the selected group, and this panel
will not appeatr.

12. Select one or more destination groups into which your package will be imported. You can also click New to
create a new Group. When you click Next, the Summary panel opens.

13. Review the information in the Summary panel. If you are satisfied with the import options, click Finish to start
the import.

A report of the import process appears on the Import tab of the Output window. Depending on whether
options have been set from the General tab of the ConflictSolver and Application Manager Options dialog
box (available from the Tools menu), validation and conflict checking may be performed during import.

The Windows Installer package appears in the Application Manager Product View under the selected
group.

About Importing Windows Installer Packages

Regarding importing Windows Installer packages, note the following:

e If you specify an update.exe patch file that was created by Developer/DevStudio/InstallShield Editor,
Application Manager will extract the .msp file in the Temp folder and then perform the import.

e For patches to be applied to an MSI package, it is necessary to perform an Administrative install of the MSI
package and then perform an Administrative install of each patch package one by one. This way, the content
of each patch package is appended to the MSI package at the Administrative install location.

e You can also import a Windows Installer package by right-clicking the group into which you want to import the
package and selecting Import Package from the context menu. The MSI Source Information panel is
displayed in the Import Wizard, and you can proceed with the steps above. However, since you have already
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specified the group into which you want to import the package, the Destination Group panel does not
appear.

e Although not required, it is recommended that you import only Windows Installer packages that have passed
the Full MSI Validation Suite validation into the Application Catalog.

About Windows Installer Packages (.msi)

Application Manager supports the import of Windows Installer packages (.msi). A Windows Installer package
contains all of the information that the Windows Installer requires to install or uninstall an application or product
and to run the setup user interface. The .msi file can also contain one or more transform files (.mst) and one or
more patches (.msp).

A Windows Installer package is organized around the concepts of components and features:
e Afeature is a part of the application’s total functionality that a user may decide to install independently.
e A component is a piece of the application or product to be installed.

The Windows Installer always installs or removes a component from a user’s computer as a coherent piece.
Components are usually hidden from the user. When a user selects a feature for installation, the installer
determines which components must be installed to provide that feature.

Using Duplicate Package Identifiers

232

When you import a package into an Application Catalog database, Application Manager checks specific identifiers
that are selected on the Duplicate Package tab of the ConflictSolver and Application Manager Options dialog
box to determine if that package has already been imported (PackageCode, ProductCode, Product Language,
ProductVersion, List of Transform Files, or—if no identifiers are selected—Product Name).

If Application Manager determines that you are attempting to import a duplicate package (based upon the selected
identifiers), you are given the opportunity to enter a name of your choosing to identify the duplicate package before
the package is imported. If the package is stored in the Software Repository, you can also choose to overwrite the
existing version or treat it as a new version of an existing package.

Business Case for Importing a Package Multiple Times

You might encounter this situation if you are importing the same package into the same Application Catalog
database multiple times, each time with a different set of transforms. One common reason why you might want to
import the same package into your Application Catalog database more than once would be if you wanted to use
Tuner to create custom installation SKUs of a common MSI package to distribute to different departments in your
organization, each installation including certain features that are appropriate for the department and excluding
certain features that are not appropriate. For example, if you were distributing a copy of Microsoft Office, you could
add transforms to the Microsoft Office MSI package so that:

® Accounting’s installation would include only Word and Excel
e Marketing’s installation would include only Word and PowerPoint, and

® Development’s installation would include only Word and Access.
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Therefore, you might want to import the same package into your database more than once, each time with a
different set of transformations. What happens when you import the package the second time depends upon the
identifiers you selected on the Duplicate Package Tab. In this example:

e [fyou select the List of Transform Files and ProductCode identifiers on the Duplicate Package tab of the
ConflictSolver and Application Manager Options dialog box, Application Manager will not identify these two
packages as duplicate, even though they have the same ProductCode, because they have a different set of
transformations. Therefore, the package will be imported with the same display name as the first package.

e [fyou only select the ProductCode identifier on the Duplicate Package tab of the ConflictSolver and
Application Manager Options dialog box, Application Manager will identify the second package as a duplicate
because the two packages have the same ProductCode.

Duplicate Product Name Conventions

When it identifies a duplicate package, by default Application Manager generates a new name for that package by
pre-pending the Product Name with the Manufacturer’s name and, if necessary, appending the Product Name with
numbers:

e 1st Package: PowerPoint
e 2nd Package: Microsoft Corporation_PowerPoint

You can edit the Duplicate Package Naming Syntax on the Duplicate Package tab of the Options dialog box.

When Duplicate Packages are Identified During Bulk Import

If Application Manager is performing a bulk import or reimport, it still identifies duplicate packages using the user-
specified criterion. Application Manager will generate a unique displayed product name and allow the import to
proceed without prompting the user.

Application Manager identifies duplicate packages based upon the identifiers that you selected on the Duplicate
Package tab of the ConflictSolver and Application Manager Options dialog box. See Using Duplicate Package
Identifiers for more information.

Identifying Duplicate Package Identifiers

To identify duplicate package identifiers, perform the following steps.

Task:

To identify duplicate package identifiers:
1. Select Options from the Tools menu. The ConflictSolver and Application Manager Options dialog box opens
2. Click the Duplicate Package tab.

3. Select the identifiers that you would like to use for product imports by selecting one or more of the following
options:

e PackageCode Property— Identifier of the package the product was installed from. No two non-identical
.msi files should ever have the same package code.
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e ProductCode Property—Unique identifier for the particular product release, represented as a string
GUID, for example:

{12345678-1234-1234-1234-123456789012}

e Product Language—The language the installer should use for any strings in the user interface that are
not authored into the database.

e ProductVersion—Version of the product in string format. The format of the string is: major.minor.build.
e List of Transform Files—A list of the transformations associated with this package.

e [None Selected]—If you do not select any of these five identifiers, Application Manager checks the
Product Name identifier to determine if a package is a duplicate.

4. Click OKto save your changes and exit the Options dialog box

5. Proceed with the package import, as described in Importing Windows Installer Packages.

E

Note - If Application Manager is performing a bulk import or reimport, it still identifies duplicate packages using the
user-specified criterion. Application Manager will generate a unique displayed product name and allow the import to
proceed without prompting the user.

E

Note ° The options that you select on the Duplicate Package tab of the ConflictSolver and Application Manager
Options dialog box apply globally to all packages that you attempt to import; you cannot apply different identifiers
to different packages. Also, since these options are saved in the AdminStudio Shared Directory, everyone using
AdminStudio at your organization will share the same Duplicate Package options.

Performing an Ad-Hoc Import of Transform Files or Patch Files

Edition * You can only perform an ad-hoc import if you are connected to a Software Repository-enabled

Application Catalog. The Software Repository feature is included in AdminStudio Enterprise Edition.

In a large enterprise, transform and patch files are created frequently to modify packages for different situations in
their organization. For example, to localize a software application, a transform file is often created for each
language supported by that application. Systems Administrators in these large enterprises have to keep track of
which software package each file is supposed to be applied to.

You cannot tell which package a transform or patch file is associated with by just looking at the file. However, you
can use the Import Wizard to perform an ad-hoc import of these loose transform and patch files into your
Application Catalog. Then, Application Manager will:

e Determine which of the packages in the Application Catalog the transform or patch file is associated with, and

e Store the files in the Software Repository along with that package’s other associated files.
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E

Note ° You can only perform an ad-hoc import if you are connected to a Software Repository-enabled Application
Catalog. See Using the Software Repository for more information.

E

Note - To perform an ad-hoc import of a transform file or patch file, the package that the file is associated with must
exist in the Application Catalog. If no associated package exists, the file cannot be imported.

Task: To perform an ad-hoc import of a transform or patch file:
1. Open Application Manager.
2. Connect to a Software Repository-enabled Application Catalog.
3. On the Catalog menu, click Import Package. The Welcome panel opens.
4

Click Next. The File Selection panel opens.

o

Select the transform or patch file that you want to import.
6. Select the Add the file(s) to the Software Repository option.

After you select this option, the Additional Dependencies of the Import File list appears, enabling you to
select any dependencies of the file you are importing. For example, a dependency might be a file that the
transform file references that is stored externally in a separate CAB file.

7. Select dependencies, if desired, and click Next.

8. The Target Package Information panel opens and lists the package that Application Manager has
determined is associated with this file.

E

Note - For transforms and patches, if Application Manager determines that there are no packages associated
with this file, you cannot proceed with the import.

9. Select the file’s associated package.

10. If you want to reimport a new version of this package along with the file you are importing, select the
Reimport new version of the package with this file change option. If you do not select this option, the
package will not be reimported.

11. Click Next. The Summary panel opens, listing the Adhoc file to import, the Destination Packages for
the file, and whether you chose to reimport the package.

12. Review the information in the Summary panel. If you are satisfied with the import options, click Finish to start
the import. Progress messages appear in the Output Window.
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About Transforms (.mst)

Application Manager supports the import of Windows Installer packages (.ms1i) with associated transforms (.mst).
A transform is a collection of changes applied to an installation. By applying a transform to a base installation
package, the installer can add or replace data in the installation database. The installer can only apply transforms
during an installation.

The installer registers a list of transforms required by the product during the installation. The installer must apply
these transforms to the product’s installation package when configuring or installing the product.

A transform can modify information that is in any persistent table in the installer database. A transform can also add
or remove persistent tables in the installer database. Transforms cannot modify any part of an installation package
that is not in a database table, such as information in the summary information stream, information in substorages,
information in nested installations, or files in embedded cabinets.

About Patches (.msp)

AdminStudio supports the import of Windows Installer packages (.ms1i) with associated patches (.msp). A Windows
Installer patch (.msp file) is a file used to deliver updates to Windows Installer applications. A patch is a self-
contained package that contains all the information required to update an application.

A patch package contains the actual updates to the application and describes which versions of the application
can receive the patch. A patch package does not include a database like a regular installation package (.msi1 file).
Patches contain at minimum two database transforms. One transform updates the information in the installation
database of the application. The other transform adds information that the installer uses for patching files.

Importing Virtual Packages

236

Edition * Support for importing Microsoft App-V applications, ThinApp applications, and Citrix profiles into the
Application Catalog is included in the AdminStudio Virtualization Pack.

You can import Microsoft App-V, VMware ThinApp, and Citrix virtual packages into the Application Catalog and
associate them with their source Windows Installer package.

Virtual packages are self-contained entities which ordinarily cannot be modified after they are created. By
associating a virtual package with the Windows Installer package which originated it, you have the convenience of
being able to easily locate the virtual package’s originating Windows Installer package, modify the original
Windows Installer package, and then regenerate the virtual package.

You have several options in how to import a virtual package:

e During the import of the Windows Installer package—During the import of a Windows Installer package,
if the Import Wizard searches for and finds a virtual package created by AdminStudio, you are prompted to
also import that virtual package. See Importing a Virtual Package During the Import of its Source Windows
Installer Package.
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o After the import of the Windows Installer package—If you import an AdminStudio-created virtual
package into an Application Catalog that already contains the virtual package’s source Windows Installer
package, you are prompted to associate the virtual package with the Windows Installer package. See
Importing a Virtual Package After the Import of its Source Windows Installer Package.

e By itself—You can use the Import Wizard to import a virtual package directly into the Application Catalog.
Then you can use the Associate Package function to associate the virtual package with its source package.
See Importing a Virtual Package Without Its Source Windows Installer Package and Manually Associating a
Virtual Package with a Windows Installer Package.

E

Note « Application Manager does not perform a duplicate package check when importing virtual packages.
Therefore, it is possible to have two or more copies of the same virtual package and/or name in the same
Application Manager Group.

Importing a Virtual Package During the Import of its Source Windows
Installer Package

When you are importing a Windows Installer package, if the Import Wizard finds a virtual package created by
AdminStudio in a subdirectory of the directory containing that Windows Installer package, you are prompted to
also import that virtual package.

[

Important « During virtual package conversion, AdminStudio 9.0 and later creates an XML file, metadata.xml, that

contains metadata that identifies the original Windows Installer package that was used to create the virtual package.
If a virtual package was created by a method other than the AdminStudio 9.x conversion process, this metadata file
will not have been created, and therefore, the Import Wizard will not prompt you to import that virtual package even
if it exists in a subdirectory of the directory containing a Windows Installer package that you are importing. Instead,
you can perform the steps in Importing a Virtual Package After the Import of its Source Windows Installer Package
and then Manually Associating a Virtual Package with a Windows Installer Package.

Task: To import a virtual package during the import of a Windows Installer package:
1. Open Application Manager.
2. Connect to your chosen Application Catalog.
3. On the Catalog menu, select Import Package. The Welcome panel of the Import Wizard opens.
4. Click Next. The File Selection panel opens.

5. Click Browse and select the Windows Installer package that has associated virtual packages that you want to
import.
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10.

]

Important * The Import Wizard will only prompt you to import a Windows Installer package’s associated virtual
packages if those virtual packages are in a subdirectory of the directory containing the Windows Installer
package.

Click Next. The MST Source Information panel opens.

Include any desired transform files, as described in Importing Windows Installer Packages, and click Next.
The MSP Source Information panel opens.

Include any desired patch files, as described in Importing Windows Installer Packages, and click Next. The
Virtual Package Import panel opens.

Import Wizard @
¥irtual Package Import
Choose additional wirtual packages to import, m’a

The ‘Windows |nstaller Package [.msi] appears to have azsociated virtual packages. Specify
whether you want to include these virtual packages in the import process.

[ Import Microsoft &pp package from:

C:A\AdminStudio SharedyhS1s\0rcah2 AT hindppPackagetOrca EXE

Import Citrix package from:
C:\AdminStudio SharedyhS1s\Orcah2 D8CitixProfilelorcaorca. profile

< Back ” Mewt » ][ Cancel ] [ Help

E

Note - This panel only opens if the Import Wizard finds a virtual package created by AdminStudio in a
subdirectory of the directory containing the Windows Installer package you have selected to import.

If a Windows Installer package’s virtual package is not in that location, you can use the Import Wizard to import
the virtual package separately, as described in Importing a Virtual Package After the Import of its Source
Windows Installer Package, and then manually associate the two packages in Application Manager, as
described in Manually Associating a Virtual Package with a Windows Installer Package.

Select the virtual package(s) you want to import and click Next. The Destination Group panel opens.

E

Note - If you opened the Import Wizard by selecting a group folder and then selecting Import from the context
menu, the Destination Group panel will not open.

Select the group or groups where you want to import this package, as described in Importing Windows
Installer Packages, and click Next. The Summary panel opens.
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11. Click Finish to begin the import. The packages are imported. When import is complete, both the Windows
Installer and the virtual package(s) are listed in the Application Catalog in the destination group you selected.

12. In Application Manager, select the virtual package that you have just imported. The Virtual Package view
opens, displaying a list of all Windows Installer packages that are associated with that virtual package.

IB Application Manager - June2 EIE'E'
Catalog Edit Wew Conflicts Reports Tools Help
o |(|[REE 3T e e
= {j Application Catalog Wirtual Packa e Appllcatlon Manager
=I5 Groups Cibriz
o g EFUUDE File ‘ischfileriscratchiPatHowe! CitrixProfiletorcatorca, profile
roup:
" m Imported On Wednesday, June 04, 2008 - 19:33
(5 Orca (v3.0,3790.0000) Groups Only the current group references this product,
Associated L
packages Marme Description
Orca Cantact: Yaour local administrator
Description A Citrix Profile
. -
Products |¢ Merge Modules E] Fatches ] 7 | | LH
Ready

E

Note * Application Manager does not perform a duplicate package check when importing virtual packages.
Therefore, it is possible to have two or more copies of the same virtual package and/or package name in the same
Application Manager Group.

Importing a Virtual Package After the Import of its Source Windows
Installer Package

During the import of an AdminStudio-created virtual package into an Application Catalog that already contains the
virtual package’s source Windows Installer package, the Associate Virtual to MSI Packages panel opens and
you are prompted to associate the virtual package with the Windows Installer package.

If this source Windows Installer package has been imported into more than one location in the Application Catalog,
multiple packages are listed.

[]

Important « During virtual package conversion, AdminStudio 9.0 and later creates an XML file, metadata.xml, that
contains metadata that identifies the original Windows Installer package that was used to create the virtual package.
If a virtual package was created by a method other than the AdminStudio 9.x conversion process, this metadata file
will not have been created. Therefore, when importing this type of virtual package, the Import Wizard will not prompt
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you to associate it with a Windows Installer package in the Application Catalog. Instead, you can perform the steps
in Manually Associating a Virtual Package with a Windows Installer Package.

&

Task: To import a virtual package after the import of its source Windows Installer package:

1. Open Application Manager.

2. Connect to your chosen Application Catalog.

3. Onthe Catalog menu, select Import Package. The Welcome panel of the Import Wizard opens.

4. Click Next. The File Selection panel opens.

5. Click Browse and select the virtual package that you want to import:
e Microsoft App-V application—Select the App-V file with an .osd extension, such as MyApp.osd.
e VMware ThinApp application—Select the ThinApp file with an . exe extension, such as MyApp.exe.
e Citrix profile—Select the Citrix file with a .profile extension, such as MyApp.profile.

6. Click Next. The Associate Virtual to MSI Packages panel opens, prompting you to associate this virtual
package with its source Windows Installer package.

7. Select the Windows Installer package and click Next. The Summary panel opens.

8. Click Finish to begin the import. The virtual package is imported. When import is complete, it is listed in the
Application Catalog in the destination group you selected.

9. In Application Manager, select the virtual package that you have just imported. The Virtual Package view

240

opens, and the associated Windows Installer package is listed in the Associated Packages list.

s Application Manager - June2 E|E|g|
Catalog Edit Wew Conflicts Reports Tools Help
o |(|[REE 3T e e
= {j Application Catalog Wirtual Package Wiew Appllcatlon Manager
=I5 Groups Cibriz
o g EFDUDE File ‘ischfileriscratchiPatHowe! CitrixProfiletorcatorca, profile
roup:
Imported On Wednesday, June 04, 2008 - 19:33
Orca (v3.0,3790,0000) Groups Only the current group references this product,
Associated L
packages Marme Description
Orca Cantact: Yaour local administrator
Description A Citrix Profile
1= . I
Products |¢ Merge Modules @Patches] 7 | | 5
Ready
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Importing a Virtual Package Without Its Source Windows Installer
Package

You can import a virtual package into the Application Catalog even if you have not yet imported its source Windows

Installer package. If you then import the virtual package’s source Windows Installer package at a later date, you
can use the Associate Package function in Application Manager to manually associate them.

Task: To import a virtual package by itself:

-t
.

Open Application Manager.
Connect to your chosen Application Catalog.
On the Catalog menu, select Import Package. The Welcome panel of the Import Wizard opens.

Click Next. The File Selection panel opens.

g & w0 b

Click Browse and select the virtual package that you want to import:

e Microsoft App-V application—Select the App-V file with an .osd extension, such as MyApp.osd.

e VMware ThinApp application—Select the ThinApp file with an . exe extension, such as MyApp.exe.
e Citrix profile—Select the Citrix file with a .profile extension, such as MyApp.profile.

6. Click Next. The Summary panel opens.

7. Click Finish to begin the import. The virtual package is imported and it will not have an association to a
Windows Installer package in the Application Catalog.

Manually Associating a Virtual Package with a Windows Installer Package

You can use the Import Wizard to import a virtual package directly into the Application Catalog even if you have not
yet imported its source Windows Installer package. If you then import the virtual package’s source Windows
Installer package at a later date, you can use the Associate Package function in Application Manager to manually
associate the virtual package with its source package.

AN

Caution * After you have imported a virtual package into the Application Catalog, you are permitted to use the
Associate Package function to associate it with any Windows Installer package in the Application Catalog, even
one that is not its source package. Therefore, it is preferable to use the Import Wizard to import both the Windows
Installer and virtual packages at the same time so that AdminStudio can create the proper associations.

AdminStudio 9.5 User Guide ADS-0950-UG00 241



Chapter 6: Managing Application Catalog Databases

Importing Data

W

Task: To manually associate a virtual package with a Windows Installer package:

1.

2.

Open Application Manager

Click on the virtual package you want to make an association for, and select Associate Package from the
context menu. The Virtual Package Association dialog box opens, listing Windows Installer packages in the
Application Catalog.

Select a Windows Installer package and click OK. The virtual package is now associated with the selected
Windows Installer package.

Deleting a Virtual Package Association

You can delete a virtual package’s association with a Windows Installer package by performing the following steps:

W

Task: To delete a virtual package association:

1.

2.

Open Application Manager.

Right-click on a virtual package, point to Delete and click Package Association on the context menu. The
Delete Virtual Package Association dialog box opens, prompting you to confirm the deletion.

Select the association that you want to delete and click OK. The association is deleted.

Importing Merge Modules

For optimal performance, Merge Modules should be imported into an Application Catalog database prior to
importing Windows Installer packages. This ensures that conflicts resulting from not using available merge
modules are correctly identified.

Task: To import Merge Modules:

1.

2.

242

Open Application Manager.
Open the Merge Modules tab.

Select the root Merge Module or one of the imported Merge Modules and select Import Merge Module from
the context menu. The MSM Source Information panel of the Import Wizard opens.

Click the Browse ([#"]) button in the Merge Modules area and select the merge module file that you want to
import.

To import multiple patches, you can repeat the procedure as necessary.

The order in which merge modules are applied can be changed by selecting a merge module in the list and
clicking the Move Up and Move Down arrows.
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7. If you need to delete a merge module you have added, clear its check box.

8. If you want to store this merge module in the Software Repository, select the Add the file(s) to the Software
Repository option.

9. Click Next. The Summary panel opens.
10. Click Finish to accept these options and begin the import.

A report of the import process appears on the Import tab in the Output window.

E

Note ° You can also import a Merge Module into the Application Catalog by selecting Import Package on the
Catalog menu. However, using that method, only one Merge Module can be imported at a time.

About Merge Modules (.msm)

Application Manager supports the import of merge modules (.msm). Merge modules are essentially simplified
Windows Installer .ms1 files.

A merge module cannot be installed alone because its lacks some vital database tables that are present in an
installation database. Merge modules also contain additional tables that are unique to themselves. To install the
information delivered by a merge module with an application, the module must first be merged into the
application’s .msi file.

Importing OS Snapshots

Task:

You can import OS Snapshot (.osc) files into the Application Catalog to use to determine conflicts between an
operating system and a package. OS Snapshoit files are files representing a particular computer system’s contents.
To generate an OS snapshot file, use the OS Snapshot Wizard to scan a computer’s operating system and record
the files, INI files, shortcuts, and registry entries present.

AN

Caution » The OS Snapshot Wizard saves OS Snapshot information in two files: an .osc file (a collection of file type
information) and an associated .nir file (registry information). The .nir file must be present in the same directory as
the .osc file in order for import to be successful.

To import an OS Snapshot into an Application Catalog:

1. Open Application Manager.

2. On the Catalog menu, click Import Package. The Welcome panel opens.
3. Click Next. The File Selection panel opens.

4. Select the OS Snapshot (.osc) file that you want to import
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5. Click Browse and select the file that you want to import.

6. If you want to add this OS Snapshot to the Software Repository, so that it stores the OS Snapshot’s associated
.nir file, select Add the file(s) to the Software Repository option.

7. Click Next. The Destination Group panel opens.

E

Note - If you opened the Import Wizard by selecting a Group in the Application Catalog and then selecting
Import Package from the context menu, the OS Snapshot will be imported into the selected group, and this
panel will not appear.

8. Select one or more destination groups into which your OS snapshot will be imported. Click Next. The
Summary panel opens.

9. Click Finish to accept these options and begin the import.

A report of the import process appears on the Import tab in the Output window.

About OS Snapshots (.osc)

244

Application Manager supports the import of OS Snapshot (.osc) files, which are files representing a particular
computer system’s contents. To generate an OS snapshot file, use the OS Snapshot Wizard to scan a computer’s
operating system and record the files, INI files, shortcuts, and registry entries present. The Wizard saves this

information in an .osc file (a collection of file type information) and an associated .nir file (registry information).

When an OS Snapshoit file is imported into Application Manager, it can be used as a reference point for conflict
identification. See Taking OS Snapshots for more information.

To provide maximum flexibility during the OS Snapshot process, you can use the Exclusions Editor to create an
exclusion list that identifies files, INI files, shortcuts, and registry entries that the OS Snapshot Wizard should
disregard during the scan. Using this list, you can eliminate unnecessary files, shortcuts, or registry entries, and
reduce the time it takes to perform the OS Snapshot. See Configuring Exclusions Using the Exclusions Editor for
more information.

AN

Caution » OS Snapshots should only be used for comparison in Application Manager. You should never attempt to
convert an OS Snapshot into an MSI package.
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Importing Marimba NCP Files

Edition * Import support for Marimba Native Channel Packager (.ncp) files is available in AdminStudio Enterprise
Edition.

You can import Marimba NCP files into the Application Catalog. See About Marimba Native Channel Packager Files
(.ncp) for more information.

To import Marimba NCP files into an Application Catalog, perform the following steps.

Task:

To import a Marimba NCP file into an Application Catalog:

1. Open Application Manager.

2. On the Catalog menu, click Import Package. The Welcome panel opens.
3. Click Next. The File Selection panel opens.
4

Select a Marimba NCP File (.ncp) and click Next. The Destination Group panel opens.

E

Note - If you opened the Import Wizard by selecting a Group in the Application Catalog and then selecting
Import Package from the context menu, the NCP File will be imported into the selected group, and this panel
will not appeatr.

5. Select one or more destination groups into which your package will be imported and click Next. The
Summary panel opens.

6. Review the information in the Summary panel . If you are satisfied with the import options, click Finish to start
the import.

A report of the import process appears on the Import tab of the Output window. The Marimba NCP file
package appears under the specified group in the Application Manager Product View.

AN

Caution * The Marimba NCP file that should be imported into an Application Catalog is always named
manifest.ncp. If you attempt to import another file with an .ncp extension into an Application Catalog, the import will
fail.
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About Marimba Native Channel Packager Files (.ncp)

246

Marimba NCP (Native Channel Packager) files are used to describe software components, their versions, their
underlying structures, and their dependence on other components. Marimba’s NCP file is derived from an OSD
(Open Software Description) file and is currently used by Marimba'’s Castanet family of products.

Clients, such as Marimba Castanet Tuners, can use an NCP file to learn what files constitute a software package for
particular software for a particular client platform and particular user preferences. Just as an HTML file can contain
links to other HTML or media files, so can an OSD file contain links to other NCP files. These linked NCP files
represent sub-packages or dependencies.

The following is an example of a very simple NCP file:

<SOFTPKG NAME=com.Installshield.www.AdminStudio"
VERSION="1,0,0,0">

<TITLE>Solitaire></TITLE>

<ABSTRACT>AdminStudio by InstallShield Corporation</ABSTRACT>

<LICENSE HREF=http://www.installshield.com/AdminStudio
Ticense.html/>

<IMPLEMENTATION>

<0S VALUE-"WinNT">

<OSVERSION VALUE-"4,0,0,0"/></0S>

<0S VALUE-"Win95">

<PROCESSOR VALUE="x86"/>

<LANGUAGE VALUE="en"/>

<CODEBASE HREF=http://www.installshield.com/AdminStudio.cab/>

</IMPLEMENTATION>

</SOFTPKG>

Application Manager supports the import of Marimba NCP Version 4.7.2 files into the AdminStudio Application
Catalog, making them available for conflict identification and resolution. Please note the following:

® The Marimba NCP file that should be imported into Application Manager is always named manifest.ncp. If you
attempt to import another file with an .NCP extension into Application Manager, the import will fail.

e Information from NCP files is stored in OS Snapshot specific tables within the Application Catalog.

® An NCP file can be selected as a source and a target package for Conflict detection, using ACE23 and ACE24.
However, reporting, validation, and conflict resolution are not supported for the NCP package type.

e Extended attributes are supported for NCP packages.

® You can import NCP files from the command line.
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Importing Other Setup Types

AdminStudio supports the import of wide variety of other (i.e., non-MSI) setup formats into the Application Catalog.
See About Other Setup Types for a description of those setup types.

To import a setup in one of these formats into an Application Catalog, perform the following steps:

AN

Caution * Package Auto Import, Application Catalog Replication, reporting, validation, conflict detection, and thus

conflict persistence are not supported by the Other Setup Types package type. However, the Merge process does
support this package type. See Merging Application Catalogs Using the Merge Wizard for more information.

Task: To import Other Setup Types into an Application Catalog:
1. Open Application Manager.
2. Onthe Catalog menu, click Import Package. The Welcome panel opens.
3. Click Next. The File Selection panel opens.

4. Select the non-MSI package that you want to import and click Next. The Additional non-MSI Import
Options panel opens, where you can enter a name for the package and the base directory for the package
(where all of its installation files are located).

5. Enter a Product Name to identify this package.

6. Click the Explore button and select the base Directory of this package where all of its associated files can be
found.

7. If you want to import all the files in the specified directory folder and all of its subfolders, select the Include
entire directory hierarchy check box. If you want to import only the files in the root of the specified directory
folder, do not select this option.

8. Click Next. The Destination Group panel opens.

E

Note - If you opened the Import Wizard by selecting a Group in the Application Catalog and then selecting
Import Package from the context menu, the file will be imported into the selected group, and this panel will
not appear.

9. Select one or more destination groups into which this package will be imported and click Next. The
Summary panel opens.

10. Review the information in the Summary panel. If you are satisfied with the import options, click Finish to start
the import.

A report of the import process appears on the Import tab of the Output window. The Other Setup Type
package appears under the specified group in the Application Manager Product View.
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About Other Setup Types

A wide variety of other (i.e., non-MSI) setup formats exist. Application Manager supports the import of non-MSI
setup types (such as InstallShield Professional or ISMP installations) into the Application Catalog. By importing
these other setup formats, you allow AdminStudio to manage these setups in a manner consistent with other MSI
based packages.

When importing one of these setup formats using the Import Wizard, you specify a directory or a directory
hierarchy, and Application Manager will scan any setup.exe or isetup.exe files for pertinent setup information.

E

Note * Package Auto Import, Application Catalog Replication, reporting, validation, conflict detection, and thus
conflict persistence are not supported by the Other Setup Types package type. However, the Merge process does
support this package type. See Merging Application Catalogs Using the Merge Wizard for more information.

Using the Software Repository

248

Edition * The Software Repository feature is available in AdminStudio Enterprise Edition.

A Windows Installer package is made up of many files that are executed when the setup is run. However, only the
.msi file is imported into the Application Catalog database. To safeguard these additional files against alteration or
being misplaced, you can choose to manage these files using the Software Repository.

The Software Repository gives you a secure, transparent storage system for your AdminStudio data, especially
Windows Installer packages used in the enterprise.

The AdminStudio tools are tightly integrated into the Software Repository, particularly Application Manager and
InstallShield Editor. Certain concepts within AdminStudio itself require the Software Repository in order to operate:

e Package version management and history—You can store multiple versions of a package in the Software
Repository. Instead of reimporting a package that has changed, you can check out a package and then check
it back in either as a new package version or you can overwrite the existing version. When a package is
checked out, it cannot be modified by another user. You can also view version history and include it in reports.
See Using Version Management Features and Viewing Package History for more information.

e Ad-hoc import of transform and patch files—You can perform an ad-hoc import of transform and patch
files into the Application Catalog and Application manager will determine which software package in the
Application Catalog the transform or patch file is associated with. The file will then be stored in the Software
Repository along with that package’s other associated files. See Performing an Ad-Hoc Import of Transform
Files or Patch Files for more information.

When a package is managed within the Software Repository, the Windows Installer file and all of its associated files
and subfolders are imported into a subfolder of the Software Repository location identified for that Application
Catalog.
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Information on the AdminStudio Software Repository is presented in the following sections:
e Enabling the Software Repository in Application Catalogs
e Methods to Import Packages into the Software Repository
e I|dentifying Software Repository Packages in Application Manager
® Using Version Management Features

e Software Repository Integration into Other AdminStudio Tools

Enabling the Software Repository in Application
Catalogs
To be able to import packages into the Software Repository of an Application Catalog, the Application Catalog

must first have the Software Repository enabled. You can choose to enable the Software Repository feature when
you are creating a new Application Catalog, and you can also enable it in existing Application Catalogs.

When an Application Catalog is enabled for the Software Repository, a Software Repository directory location must
be specified.

When an Application Catalog has the Software Repository feature enabled, that does not mean that all of its
existing packages and all newly imported packages will be automatically added to the Software Repository. Each
time you import a package, you can choose whether you want to add it to the Software Repository.

E

Note - If a package is not added to the Software Repository when it is imported, the only way to add it to the
Software Repository after that is to import it again, and to choose to overwrite the existing package version.
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Enabling the Software Repository in a New Application Catalog

To enable the Software Repository in a new Application Catalog, perform the following steps.

&

Task: To enable the Software Repository in a new Application Catalog:

Create the new Application Catalog as described in Creating New Application Catalogs, but on the Select Software
Repository Location Panel, do the following:

1. Choose the Enable the Software Repository option.
2. Select a Software Repository Location.

3. Enter a Login ID and Password of the Proxy Account that will be used to access this location.

Application Catalog Wizard

Select Software Hepository Location
Select the location where the software repositary should store imported packages. E’ﬂ

Define a Software Fepository to allow AdminStudio to manage the files associated with the
inztallation of an application. Software Fepository requires a prosy account with the ability o
make modifications to the path specified az the Software Repository Location.

Enable Software Repositon

Software Repository Location;

|_\;;;ér-ve-r\so-ftw-arerepositol_l,l\marketing | D
Prowy Accout
Lagin ID: i.-f;-:ljl.:ompany\]oh_rﬁ_n:li.th |
Password: !..............l |
¢ Back “ Mest » ] [ Cancel ] [ Help

Enabling the Software Repository in an Existing Application Catalog

To enable the Software Repository feature in an existing Application Catalog, perform the following steps.

&

Task: To enable the Software Repository in an existing Application Catalog:

1. Open the Application Catalog to which you want add Software Repository support in AdminStudio,
ConflictSolver, or Application Manager.

2. Onthe Catalog menu, click Properties. The Application Catalog Properties dialog box opens.
3. Open the Software Repository tab.

4. Select the Enable Software Repository check box. The Software Repository Location option is enabled.
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Using the Software Repository
Browse to the location where you want to store the Software Repository for this Application Catalog.
Under Proxy Account, specify a Login ID and Password that will be used to access this location.

Click OK.

Methods to Import Packages into the Software
Repository

You can import packages into the Software Repository using the following methods:

Importing a Package into the Software Repository Using the Import Wizard
Adding a Package to the Software Repository Using the ConflictSolver Process Assistant
Adding a Package to the Software Repository by Overwriting Original Package

Software Repository Auto Import Method

Importing a Package into the Software Repository Using the Import

Wizard

When you import a package into the Software Repository, all of its associated installation files are stored in the
Software Repository location, not just the installation package itself.

To have the package and its associated files managed within the Software Repository, launch the Import Wizard as
described in Importing Data, and when the File Selection panel opens, select the Add the file(s) to the
Software Repository option. If you are importing Merge Modules on the Merge Modules tab, this option is on
the MSM Source Information panel.

File Selection

S pecify the file to import, IE’E

Select a MS1, MSH, MST, MSP, 05 Snapshot [05C), Marimba [MCP). or Exe file to import.

C:AI0AdminGtudio Shared OLDmsiAccessd7.msi :

Add the file(z] to the Software Repositony

<Back || Mest> |[ Cancel ] [ Help
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When you click Finish on the Import Wizard, the selected package is imported into the Application Catalog, and all
of that package’s associated files and subfolders are copied into the Software Repository location specified for the
Application Catalog. Progress messages are displayed in the Output Window stating that each file is being copied
into the Software Repository.

Adding a Package to the Software Repository Using the ConflictSolver
Process Assistant

When using the ConflictSolver Process Assistant to import a package, to add the package to the Software
Repository, select the Add package to the Software Repository option on the Organize Package page.

In order to select this option, you must be connected to an Application Catalog that has the Software Repository
enabled.

Adding a Package to the Software Repository by Overwriting Original
Package

Task:

252

If a package is not added to the Software Repository when it is imported, the only way to add it to the Software
Repository after that is to reimport it and overwrite the original package (assuming that the Application Catalog is
Software Repository-enabled).

To add a package to the Software Repository by overwriting the original package:

Reimport the package again by following the instructions in Importing Windows Installer Packages, but this time:

1. Choose the Add the file to the Software Repository option on the File Selection panel

2. Choose the The package should overwrite the existing package version option on the Target
Package Information panel:

Import Wizard P§|

Target Package Information

Specify the target packages. m’ﬂ

The zelected package appears to be already imported into the Application Catalog. S pecify how
you want to handle the import of this package.

Fackage Handling Options

() The package should be treated as a new version of an existing package:

() The package should be treated as a new package named:

(%) The package should ovenwite the existing package version:

Package Mame:
= [ Groups
Crystal Enterprise B

< Back ” Mext > ][ Cancel ][ Help ]
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Note * For more information on managing multiple versions of a package in the Software Repository, see Using
Version Management Features.

Software Repository Auto Import Method

Use the following command line options to perform a bulk import of Windows Installer packages into the Software

Repository:

[General]

ImportIntoTheSoftwareRepository=Y
SuppressDuplicatePackageImport=N

Identifying Software Repository Packages in Application

Manager

In Application Manager, packages that are managed within the Software Repository have a different icon than
those that are not:

Table 6-6 * Application Manager Product View Icons Identifying Software Repository

Icon

Description

Package is not managed within the Software Repository.

B

B

@

E

Package is managed within the Software Repository.

Package is managed within the Software Repository and is checked out.

Merge Module is managed within the Software Repository.

Note ° These icons are not displayed in when viewing these packages in ConflictSolver.
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Also, when a Software Repository package is selected in the Application Manager Product View, the statement
Managed within the Software Repository is listed for the File and Original File fields. Below is an example of a
Software Repository package in the Application Manager Product View:

'™ Application Manager - SoftwareRepository. EI@'E‘

O EREEFE S
]
= 1§ Application Catalog
EHE) Groups
ccess97 (va7)
rystal Enterpriss Report
Orca (v3.0.3790.0000)

Software Repository
Application Icon

< bd

Catalog Edt Vew Confiicts Reports Tooks Help

f)

Manufacturer
Subscribed
Conflict Results
Packags Code
Product Code
Upgrade Code:

Language

)

Application Manager

Wicrosoft Corporation

ot associated with any subscribed database.,

There is no canflict information persisted For this product,
{46D3A31 2-7859-4192-A2D4-076223BACHCCH

{6797 1FET-A1EF-437E-695F-621 0F3CCIDEA}
{1A4AD3E10-2819-11D2-B2EA-D0E097C 99860}

English {United States)

[File:

Managed within the Software Repositary |

Imparted On

Thursday, August 18, 2005 - 15:20

[original File  Managed within the Software Repasitary |

Transforms  Click here bo view the 3 bransform(s) associsked with this product.
Fatches Mo patches are associsted with this product.
Groups Oy the currenk group references this product.

Description | Contact: tour local administrator

" Birrod.. | Merg... | @lFat... &
Resdy =
s

Using Version Management Features

For those packages which are part of the Software Repository, you can store multiple versions of a package.
Instead of reimporting a package that has changed, you can check out a package and then check it back in either
as a New Package Version or you can Overwrite Existing Version.

The Software Repository version management features are described in the following topics:

® Checking-Out and Checking-In Packages

e Cancel Check Out

e Getting a Copy of the Latest Version of a Package

254
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Checking-Out and Checking-In Packages

For those packages which are part of the Software Repository, you can store multiple versions of a package.
Instead of reimporting a package that has changed, you can check out a package and then check it back in either
as a New Package Version or you can Overwrite Existing Version.

e Orca (5. ——
& Irnpork 3

Check In As
Cancel Check Out
Get Latest Version

Find... Chrl+F
Cuk Chrli
Copy Chrl+C

Edit with Installshield Editor...
Distribute Package. ..
Perform Pre-Deployment Testing. ..

Rename Fz
Delete 3

Reports 3

When you check out a package, AdminStudio makes a local copy of the package files into the following directory:
C:\Documents and Settings\UserName\My Documents\AdminStudio\PackageName_PackageVersion

When a package is checked out, an icon is displayed on the Application Manager Product View to indicate that the
package is checked out. If the current user is not the user who checked out the package, then the path portion of
the property is not displayed.

@ Checked  adminuser
Ok Monday, August 22, 2005 - 1925
C:\Documents and Settings) Johnsmith My Documents | adminStudiofathPlok

When you check in a package, it will be imported into the Application Catalog and either the new package will be
added as a new version of an existing package or the old package will be overwritten.

Cancel Check Out

If you checked out a package and then decide that you do not want to modify it, you can choose to cancel the
check out by selecting the package, and then selecting Cancel Check Out from the context menu.

Unless a user is assigned to a Role with advanced Software Repository permissions, only the user who checked
out the package will have the Cancel Check Out enabled. After the user confirms the operation, the local
package files are deleted.
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Getting a Copy of the Latest Version of a Package

If you want to get a copy of a package that is in the Software Repository, but you do not want to check it out, you
can get a copy of that package by selecting the package, and then selecting Get Latest Version from the context
menu. The package and all of its associated files will then be copied to the user’s profile directory:

C:\Documents and Settings\UserName\My Documents\AdminStudio\PackageName
For example:

C:\Documents and Settings\JohnSmith\My Documents\AdminStudio\Adobe Reader

E

Note ° The location where Software Repository files are copied to when you select Get Latest Version cannot be
changed. The files are always copied to a subdirectory of the current user’s My Documents directory.

Software Repository Integration into Other AdminStudio
Tools

The Software Repository feature is integrated into several other AdminStudio tools:

InstallShield Editor
e ConflictSolver

® PackageExpert

e Distribution Wizard

® Predeployment Test Preparation Wizard

InstallShield Editor
The Software Repository feature is integrated with InstallShield Editor in the following ways:
® You can launch InstallShield Editor from the Application Manager.

e From InstallShield Editor, you can browse for packages that are stored in the Software Repository and select
them for edit. You can either check a file out for edit or simply get the latest version of the file to edit. You can
also undo a check out from InstallShield Editor.

e From the InstallShield Editor, you can add a package to the Software Repository.
® You can add a package to the Software Repository via the InstallShield Editor build process.

For more information on InstallShield Editor’s integration with AdminStudio, see InstallShield Editor Integration with
Application Manager and the Software Repository.
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ConflictSolver

If you are performing conflict analysis on packages that are a part of the Software Repository, the resolution
process will only operate against Checked Out packages by the current user. If a package is not checked out, you
will be unable to automatically resolve any conflicts that are found or to modify the package in any way.

PackageExpert

If you are testing packages that are a part of the Software Repository, the resolution process will only operate
against Checked Out packages by the current user. If a package is not checked out, you will be unable to
automatically resolve any errors that are found or to modify the package in any way.

Distribution Wizard

You can launch the Distribution Wizard from Application Manager by selecting the package and then selecting
Distribute Package from the context menu. When you do this, the package name in the Windows Installer
Package (.msi) field of the Installation Package Information panel is already entered. The ability to edit this
entry depends upon whether the package you are distributing is managed by the Software Repository:

e Not in the Software Repository—The full name and path of the Windows Installer file is displayed, and you
can edit this entry or click Browse and select a different package.

e In the Software Repository—Only the name of the Windows Installer file is displayed (not the full path) and
this entry cannot be edited or changed.

Predeployment Test Preparation Wizard

You can launch the Predeployment Test Preparation Wizard from Application Manager by selecting the package
and then selecting Perform Predeployment Testing from the context menu. When you do this, the name in the
Source .MSI Package field of the Windows Installer File Selection panel is already entered. The ability to edit
this entry depends upon whether the package you are distributing is managed by the Software Repository:

® Not in the Software Repository—The full name and path of the Windows Installer file is displayed, and you
can edit this entry or click Browse and select a different package.

e In the Software Repository—Only the name of the Windows Installer file is displayed (not the full path) and
this entry cannot be edited or changed.

The Target .MSI Package field on the same panel is automatically populated with the name of the package
specified in the Source .MSI Package field with _analysis appended to the end of the name. You can edit the
name of this file, if desired. If the package is not in the Software Repository, the full name and path of the Target
.MSI Package is displayed, but if the package is in the Software Repository, only the name of the Target .MSI
Package is displayed (not the full path).
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Sharing Application Catalog Data
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The section describes the three methods for sharing Application Catalog data in your enterprise: merge, auto-
import, and replication.

Table 6-7 » Sharing Application Catalog Data Help Topics

Section

Merging Application
Catalogs Using the
Merge Wizard

Automatically
Importing Packages

Replicating
Application Catalogs

Using Microsoft SQL
Server to Perform

Merge Replication of
Application Catalogs

Description

You can use the Merge Wizard to merge data from a source Application Catalog
into the currently open Application Catalog.

You can use the Package Auto Import feature to link to MSI packages in a Remote
Application Catalog, import the data into your local Application Catalog, and
maintain consistency between the packages.

Using Application Catalog Replication simplifies software management by allowing
you to selectively distribute subsets of data from a master Application Catalog to
multiple IT groups at your organization.

AdminStudio supports merge replication of Application Catalog databases using
Microsoft SQL Server 2005. You can use merge replication to synchronize
Application Catalog databases distributed in multiple locations across a large
enterprise, ensuring that all databases are kept up-to-date.

AdminStudio provides three options for sharing Application Catalog Data:

Merging Application Catalog Information—Use the Merge Wizard to merge the source Application
Catalog’s data into the currently open Application Catalog. The merged data is not linked in any way to the
source Application Catalog.

Automatically Importing Packages—The Package Auto Import Wizard offers two methods of
automatically importing Windows Installer packages into your Application Catalog:

e Linking to Packages in a Remote Application Catalog—Using the Remote Application Catalog
option of the Package Auto Import Wizard, you can monitor Windows Installer packages in a Remote
Application Catalog, and automatically import or re-import those packages at scheduled intervals.
Application Manager can link to one or multiple Application Catalogs, and can link to one or multiple
packages within those Application Catalogs.

e Automatically Importing Packages from a Network Directory—Using the Network Directory option
of the Package Auto Import Wizard, you can automatically import or re-import all Windows Installer
packages in a specific folder into your Application Catalog at scheduled intervals.

Replicating Application Catalogs—Use Application Catalog Replication’s Publication and Subscription
Wizards to distribute an Application Catalog database where it is needed across a large enterprise or multi-
national corporation. Data is replicated between a Publisher Database Server and a Subscriber Database
Server, which do not need to be available on the same network.
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The following chart compares the three methods of sharing Application Catalog data:

Table 6-8 » Sharing Application Catalog Data Comparison Chart

Topic

AdminStudio
Edition

Configuration

How It Works

AdminStudio 9.5 User Guide

Merging (Merge Wizard)

Professional Edition

Connection between two
Application Catalog databases
on the same network/domain.

The source Application
Catalog’s data is merged into the
currently open Application
Catalog. This is a one-time-only
database merge. The merged
data is not linked in any way to
the source Application Catalog.

ADS-0950-UG00

Auto Import
Package Auto Import)

Professional Edition

Connection between two
Application Catalogs Databases
on the same network/domain or
between an Application Catalog
and a directory on the same
network/domain.

With the Remote Application
Catalog option, you link to
individual packages in a remote
Application Catalog, and these
packages are imported into your
local Application Catalog. When
the remote packages are
modified, the packages in your
local Application Catalog are
automatically re-imported.

When using the Network
Directory option, if a modified
version of a previously imported
package is placed in the
monitored Network Directory, the
package is automatically re-
imported.

Replicating
(Subscription and
Publication)

Enterprise Edition

Connection between: Publisher
and Publisher Database Server,
Publisher Database Server and
Subscriber Database Server, and
Subscriber and Subscriber
Database Server

An Application Catalog database
is distributed across a large
enterprise. Data is replicated
between the Publisher Database
Server and Subscriber Database
Server, which do not need to be
available on the same network.
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Table 6-8 * Sharing Application Catalog Data Comparison Chart (cont.)

Topic

Customers
Who Would
Use This

260

Merging (Merge Wizard)

Merging could be used in an
organization where multiple
people test packages. After the
packages have been tested, all
of the “tested” applications could
be consolidated into one
centralized Application Catalog.

Auto Import
Package Auto Import)

Package Auto Import could be
used to maintain consistency
between applications in various
Application Catalogs in
organizations where they are
satisfied with domain security
and have both source and target
Application Catalog databases
(or source directory and target
Application Catalog database)
on an accessible domain.

ADS-0950-UG00

Replicating
(Subscription and
Publication)

Replication could be used at
large enterprises that want to
maintain a central Application
Catalog, with smaller Application
Catalogs at individual offices
(such as New York, London,
etc.).

This method moves the data
closer to the user (which
improves performance), and
allows the user to subscribe to
only the data that they need
(which makes it easier to work
with).
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Table 6-8 * Sharing Application Catalog Data Comparison Chart (cont.)

Auto Import
Topic Merging (Merge Wizard) Package Auto Import)

Advantages Very simple. Can select the packages you

i in wi link to.
Data is merged in with the data want to link to

in the local Application Catalog. Linked applications can be

updated to match the source.

Automatically imported data
coexists with data in local
Application Catalog.
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Replicating
(Subscription and
Publication)

Replication provides optimal
security. Publisher Database
Server and Subscriber Database
Server do not need to be
available on the same network.
Operates within the SQL Server
Security Model, making it a very
secure way to replicate data—
because the subscriber need not
have access to the remote
database.

AdminStudio encapsulates
functionality from SQL Server to
support “Snapshot” type
replication. Using AdminStudio
to perform Snapshot replication
is easier than trying to perform it
using SQL Server Enterprise
Manager.

Can select individual packages
in a Publication to subscribe to.

Replication is very efficient. It
operates within the SQL Server
Job Refresh Model, which
means that the replication/
subscription process is run
automatically.

Automatically imported data
coexists with data in the local
Application Catalog.
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Topic

Disadvantages

Table 6-8 * Sharing Application Catalog Data Comparison Chart (cont.)

Replicating
Auto Import (Subscription and

Merging (Merge Wizard) Package Auto Import) Publication)
Local user needs a physical When using the Remote You can subscribe to multiple
connection to the database and Application Catalog option, the subscriptions, but only one
has to have permissions on that | local user needs a physical subscription can be active at any
remote database. This could connection to the database and one time.
allow the user performing the has to have permissions on that
merge to modify the source remote database. This could
database. This could cause a allow the user performing the
Security issue. link to modify the source

database. This could cause a

This is a one time merge with no o
Security issue.

link to the source data and no
updating.

Merging Application Catalogs Using the Merge Wizard

In some circumstances, you may need to merge data from two Application Catalogs. The reasons for this can vary,
but usually involve increasing the number of packages available for conflict identification or the necessity of having
the same data available in multiple geographic locations.

Task:

262

To merge data from two Application Catalogs:

1.

2
3.
4

5
6.
7
8

E

Open Application Manager and connect to the Application Catalog that is to contain the combined data.
On the Catalog menu, click Merge to open the Merge Wizard. The Welcome panel opens.

Click Next. The Source Application Catalog panel opens.

Select the Application Catalog that contains the data that you want to merge.

If the Application Catalog that you select requires additional authentication, the Select Application Catalog
dialog box opens. Connect to that catalog as described in Connecting to an Existing Application Catalog.

Click Next to advance to the Groups panel.
Select the groups you want to merge. You can also select to Replace duplicate application data.
Click Next. The Progress panel opens, where you can view the merge progress.

Click Finish to exit the Wizard.

Note ° For a comparison of the three methods for sharing Application Catalog Data in AdminStudio, see Sharing
Application Catalog Data.
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Automatically Importing Packages
E

Note - To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.

For a large distributed enterprise, accurate and synchronized data is required for shared Windows Installer MSI
packages. If a corporate level team maintains a database of packages used throughout the corporation in New
York, then all the regional offices should be able to link to the corporate level MSI packages and get the different
pieces of data.

Package Auto Import offers two methods of automatically importing Windows Installer packages into your
Application Catalog and keeping them updated:

Table 6-9 * Package Auto Import Methods

Method Description

Automatically Importing Using the Remote Application Catalog option of the Package Auto Import
Packages in a Remote Wizard, you can monitor Windows Installer packages in a Remote Application
Application Catalog Catalog, and automatically import or re-import those packages at scheduled
intervals. Application Manager can link to one or multiple Application Catalogs,
and can link to one or multiple packages within those Application Catalogs.

Automatically Importing Using the Network Directory option of the Package Auto Import Wizard, you
Packages from a can automatically import or re-import all Windows Installer packages in a
Network Directory specific Network Directory into your Application Catalog at scheduled intervals.

AN

Caution » When automatically importing or re-importing packages from a Remote Application Catalog or a Network
Directory using Package Auto Import, validation will not be performed even if the Check for Validation Errors option
on the Import tab of the ConflictSolver or Application Manager Options dialog box is selected. If validation was
performed during automatic import and if a package failed validation, it would not be imported into the Application
Catalog, which would disrupt the automatic import process. Instead, you can perform validation after the package
has been imported. See Validating After Import.

Tip * When you link to a package in a Remote Application Catalog, Application Manager connects to the Remote
Application Catalog and imports an MSI file into the local Application Catalog. In order for Package Auto Import to
work properly, both the Remote Application Catalog and the Remote MSI file must be accessible to the linked users
at all times. In other words, both the Remote Application Catalog and all of the MSl files that have been imported into
it must be able to be accessed by linked users via a shared network drive.
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E

Note « For a comparison of the different methods for sharing Application Catalog Data in AdminStudio, see Sharing
Application Catalog Data.

Automatically Importing Packages in a Remote Application Catalog

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.

Using the Remote Application Catalog option of Package Auto Import, you can monitor Windows Installer
packages in a Remote Application Catalog, and automatically import or re-import those packages at scheduled
intervals.

The following topics are included in this section:

e Linking to a Remote Application Catalog

e Editing a Link to a Remote Application Catalog
e Manually Updating a Linked Package

e Deleting a Link to a Remote Application Catalog

e Viewing Remote Package Links on the Application Manager Product View

Linking to a Remote Application Catalog

Task:
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Using the Remote Application Catalog option of Package Auto Import, you can monitor Windows Installer
packages in a Remote Application Catalog, and automatically import or re-import those packages at scheduled
intervals. Follow these procedures to configure a link to a Remote Application Catalog.

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.

To link to a Remote Application Catalog:

-k
.

Open Application Manager.
On the Catalog menu, select Package Auto Import. The Package Auto Import dialog box opens.

Click Add. The Package Auto Import Wizard Welcome panel opens.

0 ® Db

Click Next. The Package Auto Import Type Selection panel opens, prompting you to specify whether you
want to monitor packages in a Remote Application Catalog or monitor a Network Directory.
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14.

15.

16.
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Select Remote Application Catalog and click Next. The Remote Link Application Catalog panel opens
and lists Application Catalogs that you have recently accessed.

From the Catalogs list, select the Application Catalog you want to link to or click Browse to open the Select
Application Catalog dialog box.

Connect to the selected catalog as described in Connecting to an Existing Application Catalog.
Click Next. The Groups panel opens, listing all of the packages in the selected Application Catalog.
Select the packages within the Application Catalog that you want to link to.

Click Next. The Schedule panel opens.

To enable automatic import of the linked packages at scheduled intervals, select the Schedule AdminStudio
to update the changed packages option. The scheduling fields are enabled.

From the Run the process list, select Daily or Weekly.

Select the time of day that you want the automatic import to occur by selecting the hour, minutes, seconds, or
AM/PM setting and then clicking the up and down arrows to adjust the setting.

From the Starting on list, click on the arrow to open the Calendar and then select the first day that you want
automatic importing to begin.

Click Next. The Summary panel opens.

Review the summary of the options that were selected in the previous panels of the Wizard and click Finish.
You are returned to the Package Auto Import dialog box and the new Remote Application Catalog link is
now listed.

E

Note * Note that on the Package Auto Import dialog box, the Start button is disabled when this new
Remote Application Catalog link is selected. This button is disabled until the linked packages have been
imported into the local Application Catalog for the first time. The first automatic import of linked packages in a
Remote Application Catalog is initiated when you click the Close button to exit the Package Auto Import dialog
box.

Click Close to close the Package Auto Import dialog box.

Initial and Subsequent Automatic Imports

Import is initiated automatically when you set up the Remote Application Catalog connection, and then subsequent
imports occur automatically at the scheduled date and time.
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Initial Automatic Import

When you initially set up a connection to a Remote Application Catalog, automatic import is initiated when you
click Close to exit the Package Auto Import dialog box. Import results are displayed in the Output window. The
packages are imported into the Package Auto Import Group of the Application Catalog:

= |58 Groups

% adobe Photoshop (w5500

Adobe Systems_Adobe Acrobat 6,0 Professional {+00&,000,000)
% sdobe Systemns_Adobe Acrobat 6,0 Professionall (006,000,000}

+

Marketing
% Microsoft Corporation_Crcal ©w1,50,2600,0000)
[ oOrca (v1.50.2600,0000)
- _E'_-_Eu:l:.-an;le Auto Immport Group

Adobe Systems_Adobe Acrobat 6.0 Professional? (v006,000,000)

= Developer Art (v1,00,0000)
Installshield Developer (v8.01,016)
Installshield Software Corporation_PackageForTheWweb 4 (v4.0.00
Microsaft Corporation_CrcaZ (1,50, 2600,0000)
% PackageForTheeb < (w4.0.00
Paint Shop Pro 7 anniversary Edition (v7.0.4,0000)
[ Setup (v4.11.0)

o o O
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Figure 6-3: Package Auto Import Group of an Application Catalog

Subsequent Automatic Imports

After a package has been imported into the Application Catalog, an update check will be performed:

e Atthe scheduled interval (if the Schedule AdminStudio to update the changed packages option is
selected), and

e Whenever you click Start on the Package Auto Import dialog box.

Preferred Authentication Modes
AdminStudio has preferred authentication modes when connecting to SQL Server Application Catalogs.

When you open AdminStudio, by default AdminStudio will attempt to connect to your SQL Server Application
Catalog using NT authentication mode. If that fails, AdminStudio will display a login dialog box with the Server,
Login ID, and Database fields pre-populated with your last selection.

If you use SQL Server Authentication Mode to login to your SQL Server Application Catalog, AdminStudio will not
save SQL login information. Therefore, each time you want to refresh the data from this Application Catalog, you
will have to supply AdminStudio with the login information. Therefore, it is recommended that you use NT
authentication mode to login to SQL Server Application Catalogs.
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Editing a Link to a Remote Application Catalog

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other

users, the Package Auto Import options will be disabled.

On the Groups tab of the Package Auto Import Properties (Remote Application Catalog) Dialog Box, you can link or
unlink to different packages within an Application Catalog, and on the Options tab, you can modify update options
and adjust the scheduled update interval.

Task: To edit a Remote Application Catalog link:
1. On the Catalog menu, select Package Auto Import. The Package Auto Import dialog box opens.
2. Select the Remote Application Catalog link that you would like to edit and click Properties.

The Groups tab of the Package Auto Import Properties (Remote Application Catalog) dialog box
opens, displaying all of the groups and packages in the selected Remote Application Catalog that you can link
to. Any package that you have already linked to is already selected.

3. Select or deselect check boxes to link or unlink to packages within this Remote Application Catalog.

4. If you want to specify options that directly affect the way the linked packages will be updated, select the
Options tab.

5. On the Options tab, select one or more of the following Refresh Options:
e Update package when its source is modified
e Delete package when the source package is deleted
See Manually Updating a Linked Package for a detailed explanation of these two options.

6. To enable automatic import of the linked packages at scheduled intervals, select the Schedule option. The
scheduling fields are enabled.

If you want to disable automatic importing of this package if it is modified in its Remote Application Catalog,
leave the Schedule option unselected. With this option unselected, the only way that this package can be
updated is to select the Application Catalog link on the Package Auto Import dialog box and then click
Start to force an update.

7. From the Run the process list, select Daily or Weekly.

8. Select the time of day that you want the automatic import to occur by selecting the hour, minutes, seconds, or
AM/PM setting and then clicking the up and down arrows to adjust the setting.

9. From the Starting on list, click on the arrow to open the Calendar and then select the first day that you want
automatic importing to begin.

10. Click OK to close the Package Auto Import Properties dialog box and then click Close to close the
Package Auto Import dialog box.
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Manually Updating a Linked Package

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other

users, the Package Auto Import options will be disabled.

If you select the Remote Application Catalog link on the Package Auto Import dialog box and then click the Start
button, the linked packages in the local Application Catalog are updated with the same packages in the remote
Application Catalog. When you click on Start, how the packages are refreshed depends upon which options you
have selected on the Package Auto Import Properties (Remote Application Catalog) Dialog Box:

Table 6-10 * Import Options

Option

Description

Update package when its
source is modified

Delete package when the
source package is
deleted

If you have selected this option:

Application Manager will go and check if any of the linked packages have been
modified in the Application Catalog.

e [f the linked package has been modified, then the local Application
Catalog database is updated to reflect the changes.

e |f the linked package has not been modified, you receive a message
stating that “No refresh is necessary”.

If you have not selected this option:

Application Manager will still check to see if any of the linked packages have
been modified:

e [f the linked package has been modified, Application Manager will
inform you that the source package has been modified but that it will not
update the local Application Catalog database because this option is not
selected.

e If the linked package has not been modified, you receive a message
stating that “No refresh is necessary”.

If you have selected this option, Application Manager will delete any linked
data in the local database if the data is deleted from the remote database.

If you have not selected this option, even if the source package is deleted in
the remote database, your copy of the package will not be deleted.

As the linked packages are being re-imported, output messages will be displayed in the Package Auto Import tab
of the Application Manager Output window.

268

ADS-0950-UG00 AdminStudio 9.5 User Guide




Chapter 6: Managing Application Catalog Databases
Sharing Application Catalog Data

Deleting a Link to a Remote Application Catalog

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.

Task: To delete a link to a Remote Application Catalog:
1. On the Catalog menu, select Package Auto Import. The Package Auto Import dialog box appears.

2. Select the Remote Application Catalog link that you would like to delete and click Remove.

Viewing Remote Package Links on the Application Manager Product View

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.

The Application Manager Product View shows all the groups and packages present in an Application Catalog. The
groups and packages that have been linked to using the Remote Application Catalog method of the Package Auto
Import Wizard are displayed using a special icon, as shown below:

Catalog Edit Wiew Conflicks Reports Tools Help

=Ne=coResREERE A= APS A e
= | Groups

+ % CemoPlayer (v1,00,0000)

+ % Installshield Developer (v&.01.016)

+ % lasc Software Inc_Paint Shop Pro 7 Anniversary Edition (w7.0.4,0000)

+ % Morton Antivirus Corporate Edition («7.5.0.00

+ Orca (v1.50.2600,0000)

+ PackageFarTheWweb 4 (v4,0.00

+- M windovessp

If a linked product in the local Application Catalog has been updated in the Remote Application Catalog and needs
to be re-imported, an exclamation point is displayed on the icon (&).
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Automatically Importing Packages from a Network Directory

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.

Using the Network Directory option of Package Auto Import, you can monitor a directory location on the network
(or a local directory) and automatically import or re-import packages in that directory at scheduled intervals.

The following topics are included in this section:

e Linking to a Network Directory

e Editing a Link to a Network Directory

e Forcing an Import of Packages in a Network Directory

e Deleting a Link to a Network Directory

Linking to a Network Directory

Task:

270

Using the Network Directory option of Package Auto Import, you can monitor a directory location on the
network (or a local directory) and automatically import or re-import packages in that directory at scheduled
intervals. Follow these procedures to configure a link to a network directory.

To link to a network directory:
1. On the Catalog menu, select Package Auto Import. The Package Auto Import dialog box opens.
2. Click Add. The Package Auto Import Wizard Welcome panel opens.

3. Click Next. The Package Auto Import Type Selection panel opens, prompting you to specify whether you
want to monitor packages in a Remote Application Catalog or monitor a Network Directory.

4. Select Network Directory and click Next. The Folder panel opens.

5. Use the Browse button to select the network directory Folder that you want to monitor.

E

Note * While you are permitted to enter a local directory (rather than a network directory) as the monitored

directory, this might cause problems if a person monitoring this directory has the same directory on his local
machine. For example, if a directory named C:\MyAppCatalogs is chosen to be the monitored directory, and a
person who choose to monitor this directory also has a directory on his local machine named
C:\MyAppCatalogs, Application Manager would monitor that person's local directory rather than the directory
that was chosen to be the monitored directory.
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To also monitor the selected directory’s sub-directories, select the Also include sub-directories option.

If you select this option, when packages in subdirectories are imported into your Application Catalog, they will
be placed in groups that maintain the directory hierarchy. For example, if you are monitoring a directory
named Marketing, and that directory has a subdirectory named Graphics that contains packages, when
those packages are imported into your Application Catalog, they will be placed in the Graphics subgroup of
the destination group.

Click Next. The Destination Group panel opens, prompting you to select the Application Catalog group into
which the packages will be imported.

Select a destination group and click Next. The Schedule panel opens.

To enable automatic import of the linked packages at scheduled intervals, select the Schedule AdminStudio
to update the changed packages option. The scheduling fields are enabled.

If you do not select this option, packages will only be imported when you select this entry on the Package Auto
Import dialog box and then click Start.

From the Run the process list, select Daily or Weekly.

Select the time of day that you want the automatic import to occur by selecting the hour, minutes, seconds, or
AM/PM setting and then clicking the up and down arrows to adjust the setting.

From the Starting on list, click on the arrow to open the Calendar and then select the first day that you want
automatic importing to begin.

Click Next. The Summary panel opens.

Review the summary of the options that were selected in the previous panels of the Wizard and click Finish.
You are returned to the Package Auto Import dialog box and the new Network Directory link is now listed
as a monitored activity.

To force an import of the packages in the monitored Network Directory, select the Network Directory entry
and click Start. Import results will be displayed in the Output window. The packages will be imported into the
specified Group in the Application Catalog:

Note - If you do not choose to perform a forced import, packages in the monitored Network Directory will be
imported at the next scheduled interval.

E

Note - To modify Network Directory link settings, select the link on the Package Auto Import Dialog Box and click
Properties. See Editing a Link to a Remote Application Catalog.
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Editing a Link to a Network Directory

Task:

272

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other

users, the Package Auto Import options will be disabled.

On the Groups tab of the Package Auto Import Properties (Network Directory) dialog box, you can choose
to monitor subdirectories and can adjust the scheduled update interval.

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.

To edit a link to a Network Directory:
1. On the Catalog menu, select Package Auto Import. The Package Auto Import dialog box opens.

2. Select the Network Directory link that you would like to edit and click Properties. The Package Auto
Import Properties (Network Directory) dialog box opens.

3. To choose to monitor the selected folder’s subfolders, select the Also include sub-directories option.

If you select this option, when packages in subdirectories are imported into your Application Catalog, they will
be placed in groups that maintain the directory hierarchy. For example, if you are monitoring a directory
named Marketing, and that directory has a subdirectory named Graph1ics that contains packages, when those
packages are imported into your Application Catalog, they will be placed in the Graphics subgroup of the
destination group.

4. Click Next. The Destination Group panel opens, prompting you to select the Application Catalog group into
which the packages will be imported.

5. Select a destination group and click Next. The Schedule panel opens.

6. To enable automatic import of the packages in the Network Directory at scheduled intervals, select the
Schedule option. The scheduling fields are enabled.

If you want to disable automatic importing of packages in the Network Directory, leave the Schedule option
unselected. With this option unselected, the only way that packages in that directory will be imported into the
Application Catalog is to select the Network Directory link on the Package Auto Import dialog box and
then click Start to force an import.

7. From the Run the process list, select Daily or Weekly.

8. Select the time of day that you want the automatic import to occur by selecting the hour, minutes, seconds, or
AM/PM setting and then clicking the up and down arrows to adjust the setting.

9. From the Starting on list, click on the arrow to open the Calendar and then select the first day that you want
automatic importing to begin.
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10. Click OK to close the Package Auto Import Properties dialog box and then click Close to close the
Package Auto Import dialog box.

Forcing an Import of Packages in a Network Directory

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.

Select a monitored Network Directory on the Package Auto Import dialog box and then click the Start button to
force an import of the packages in that Network Directory. As the packages are being imported (or re-imported if
they have been modified), output messages are displayed in the Package Auto Import tab of the Application
Manager Output Window.

Deleting a Link to a Network Directory

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.

Task:

To delete a link to a remote package:
1. On the Catalog menu, click Package Auto Import. The Package Auto Import dialog box appears.
2. Select the monitored Network Directory that you would like to delete and click Remove.

The packages that have already been imported into your Application Catalog from this Network Directory will
remain, but they will no longer be updated if a modified version of the package is placed in the Network
Directory that they were imported from.

Package Auto Import and Duplicate Package Names

E

Note ° To use the Package Auto Import feature, you must have AdminStudio Administrator permission. For all other
users, the Package Auto Import options will be disabled.

During manual importing of packages, if you are attempting to import a package that has been identified as a
duplicate to a package already in the Application Catalog—based upon the identifiers you have selected on the
Duplicate Package tab of the ConflictSolver and Application Manager Options Dialog Box (PackageCode,
ProductCode, Product Language, ProductVersion or List of Transform Files), the Target Package Information Panel
opens, proposing an automatically generated new name for the package and prompting you to accept the new
name or enter one of your choosing.
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However, if AdminStudio encounters a duplicate package name during auto import, the package you are importing
will be automatically renamed by pre-pending the Product Name with the Manufacturer’s name and, if necessary,
appending the Product Name with numbers:

e 1ist Package: Application 2004
e 2nd Package: ABC Corporation_Application 2004
The import is allowed to proceed without prompting the user.

You can edit the Duplicate Package Naming Syntax on the Duplicate Package tab of the Options dialog box.

Replicating Application Catalogs

Edition * Application Catalog replication is available in AdminStudio Enterprise Edition.

AdminStudio Application Catalog Replication makes it possible to distribute an AdminStudio Application Catalog
database where it is needed across a large enterprise or multi-national corporation. One location can publish
software packages to IT teams at other sites, keeping all teams current while enabling each to manage their
software independently.

The following topics are included in this section:
Table 6-11 « Application Catalog Replication Topics
Topic Description

About Application Catalog | The benefits of using Replication, an overview of creating and managing
Replication Publisher and Subscriber Application Catalogs, and how to configure the
AdminStudio Shared Location for Replication.

Publication/Subscription Diagram illustrating how Application Catalogs are replicated.

Lifecycle

Specialized User Describes how to subscribe to more than one Publication at a time, override

Scenarios the scheduled update day and time, and replicate Application Catalogs in
controlled SQL database environments.

Creating and Managing Describes how to create, edit, publish, and delete a Publication. This section

Publications also explains how to set a Publication schedule and how to edit a Publication
access list.

Creating and Managing Describes how to create, enable/disable, manually update, and delete a

Subscriptions Subscription.
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E

Note * Only AdminStudio users who have been assigned sysadmin privileges to the currently connected SQL
database server through the SQL Enterprise Manager can create Publications or set up Subscriptions using that
database. For all other users, the Application Catalog Replication options are disabled.

About Application Catalog Replication

This section lists the benefits of using Replication, provides an overview of creating and managing Publisher and
Subscriber Application Catalogs, and explains how to configure the AdminStudio Shared Location for Replication.

e Benefits of Using Application Catalog Replication
e Creating and Managing Publisher and Subscriber Application Catalogs
e Configuring the AdminStudio Shared Location for Replication

e [nitial Configuration Checklist

Benefits of Using Application Catalog Replication

The benefits of using Application Catalog replication include the following:
e Simplifies Software Package Management

e Allows You to Distribute Work Geographically Across the World

® Provides Optimal Security

e Automatically Performs SQL Server Snapshot Replication

Simplifies Software Package Management

Using Application Catalog Replication simplifies software management by allowing you to selectively distribute
subsets of data from a master Application Catalog to multiple IT groups at your organization.

One organization could have hundreds of applications, which would require multiple IT groups using AdminStudio
to perform conflict detection, customization, repackaging, and testing. It would be unwieldy and confusing for all of
those AdminStudio users to connect to the same Application Catalog.

In this situation, it would be very beneficial for one AdminStudio user to maintain a master Application Catalog in a
central location, and then to replicate (distribute) subsets of the data to the other IT groups. By allowing an IT
group to work with just the data that they need, performance and efficiency is improved.

Allows You to Distribute Work Geographically Across the World

For large multi-national enterprises, using Application Catalog Replication allows you to distribute work
geographically across the world. A large enterprise could maintain a central Application Catalog that is updated as
applications are generated and verified by multiple remote IT groups on local Application Catalogs. The verified
applications could then be distributed globally from the master Application Catalog to all the distributed work
groups of the enterprise.
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Provides Optimal Security

Because the Publisher Database Server and Subscriber Database Server do not need to be available on the same
network, Application Catalog Replication provides optimal security. Replication operates within the SQL Server
Security Model, making it a very secure way to replicate data—because the Subscriber need not have any access
to the remote database. To configure the Replication feature, the user must be assigned (using SQL Enterprise
Manager) sysadmin privileges to the database server.

Automatically Performs SQL Server Snapshot Replication

AdminStudio Application Catalog Replication uses SQL Server Snapshot replication method. Snapshot replication
operates within the SQL Server Job Refresh model, which means that the replication/refresh process is run
automatically. Using AdminStudio to perform Snapshot replication is much easier than performing it using SQL
Server Enterprise Manager.

E

Note * For more information on Snapshot Replication, see the Snapshot Replication topic on the Microsoft MSDN
Web site.

Creating and Managing Publisher and Subscriber Application Catalogs

276

When you create an Application Catalog, it is designated as either a Publisher or a Subscriber catalog, and
Application Manager is used to manage those subscriptions and publications.

e Creating Publisher and Subscriber Application Catalogs

e Managing Publisher and Subscriber Application Catalogs

Creating Publisher and Subscriber Application Catalogs

When creating a new SQL Server Application Catalog, you must choose (by selecting a check box) whether to
define the Application Catalog as a Subscriber.
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Application Catalog Wizard
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Figure 6-4: Create Database as a Subscriber Option

When this option is not selected, or when an existing database is upgraded, the Application Catalog is defined as a
Publisher. The AdminStudio interface selectively enables/disables the Replication menu items based upon the type
of Application Catalog that is currently opened.

E

Note ° You can review your distributor properties in SQL Server Enterprise Manager on the Replication tab of the
SQL Server Properties dialog box.

Managing Publisher and Subscriber Application Catalogs

In AdminStudio Application Catalog Replication, data is replicated between Publisher and Subscriber databases.
You manage the Publisher and Subscriber databases using the following two dialog boxes:

e Publication Manager dialog box—Use to create and manage publications created on an AdminStudio
Application Catalog database that is configured as a Publisher. See Managing Publications.

e Subscription Manager dialog box—Use to create and manage Subscriptions to Publications on an
AdminStudio Application Catalog configured as a Subscriber. See Managing Subscriptions.

To see a diagram illustrating how data is replicated from the Publisher database to the Subscriber database, see
Publication/Subscription Lifecycle.
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E

Note * The Publication Manager and Subscription Manager options under Replication on the AdminStudio
Catalog menu are only enabled when a user with sysadmin privileges on an SQL Server database server connects
to a database on that server.

® [fthat database was defined as a Publisher when it was created, the Publication Manager option is
enabled.

® [fthat database was defined as a Subscriber when it was created, the Subscription Manager option is
enabled.

See Application Catalog Wizard for information on how to identify databases as Subscribers or Publishers.

AN

Caution * You can create as many Subscriptions or Publications as you want to, but because any previously
replicated data is deleted whenever new Subscription data is received, the Subscriber should have only one
Subscription active at any one time. If you want to have more than one Subscription set up at one time and switch
between them, see Using the “Disable” Feature to Subscribe to More Than One Publication for more information.

Configuring the AdminStudio Shared Location for Replication

When Publishing data using Application Catalog Replication, the Publication Server needs access to two script
files that are installed in the AdminStudio Shared Directory Location. Therefore, the AdminStudio Shared directory
location should refer to a network folder, making it accessible to the Publication Server. See Specifying the Shared
AdminStudio Application Catalog.

Initial Configuration Checklist

Task:

278

Before you can use Application Catalog Replication, you need to perform the following steps to configure the
Subscriber and Distributor databases at your organization. If the Subscriber and Distributor databases are not
configured in this manner, Replication will fail.

E

Note * The Publisher server is often configured as its own Distributor server.

To configure the Subscriber and Distributor servers:

1. Check the SQL Server Agent logins configured on the Subscriber and Distributor databases, and make sure
that the SQL Server Agent on the Subscriber database can login to the Distributor database via the Distributor
SQL Server Agent using the distributor_admin login.

2. Configure a Distributor database for the servers that are publishing data.
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Publication/Subscription Lifecycle

The Application Catalog database replication process is detailed in the diagram and notes below, including
creating and publishing a Publication, and subscribing to that Publication.

¥Rt Publication Schedule
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Figure 6-5: Application Catalog Database Replication Process

The following steps are included in the Application Catalog Database Replication Process:

Table 6-12 « Application Catalog Database Replication Process

Step

Publisher Steps

Step 1: Create Publication

Step 2: Define Update
Schedule

Description

The Publisher—an AdminStudio user who wants to make part of his
Application Catalog available for Publication—creates a Publication on
the local Publisher Database Server. The Publisher must have been
assigned sysadmin privileges in SQL Enterprise Manager on the Publisher
Database Server.

The Publisher defines the automatic update schedule for the Publication.
At the specified date and time, the Publisher Database Server will check
the Application Catalog to see if any published data has changed. If
newer data exists, the Publication will be updated.

Step 3: Publish Publication
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Table 6-12 « Application Catalog Database Replication Process (cont.)

Step Description

Subscriber Steps

Step 4: Subscribe to The Subscriber—an AdminStudio user who wants to receive data from
Publication the Publisher’s Application Catalog—creates a Subscription to that

Publication. The Subscriber must have been assigned sysadmin
privileges in SQL Enterprise Manager on the Subscriber Database Server.

Step 5: Define Update The Subscriber defines the automatic update schedule for the
Schedule Subscription. At the specified date and time, the Subscriber Database
Server will check to see if the Subscription on the Publisher Database
Server has been updated. If it has been updated, the Subscription on the
Subscriber Database Server will be updated.

Step 6: Data is Copied to The subscribed Publication is copied to the Subscriber Database Server,
Application Catalog and is listed under the Replication group in the Subscriber’s Application
Catalog (when viewed in the Application Manager Product View).

Terminology Review

The following terminology was used in this diagram and is used throughout the Application Catalog Replication
help topics:

Table 6-13 ¢ Application Catalog Replication Terminology
Term Definition

Publisher Person who creates the Publication.

Local Publisher Database Server A Database Server making data available for replication.

Publication The actual data made available for replication.
Subscriber Person who subscribes to a publication.
Subscriber Database Server A Database Server that receives the replicated data.
Subscription A request to receive a Publication from a Distributor.
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Specialized User Scenarios

The following topics explain how to use the Application Catalog Database Replication feature to best meet your
organization’s needs. The following topics are included:

® Using the “Disable” Feature to Subscribe to More Than One Publication
e Overriding the Scheduled Update Day and Time

e Replicating Application Catalogs in Controlled SQL Database Environments

Using the “Disable” Feature to Subscribe to More Than One Publication

At your organization, it could be beneficial to have more than one Subscription configured in the Subscription
Manager, allowing you to switch from one Subscription to another, even though only one Subscription can be
active and listed in your Application Catalog at any one time: the one that has been executed (updated) the most
recently.

You might want to set up multiple Subscriptions in a situation where an IT group wants to work on a specific group
of applications at a time. For example, an IT group might want to perform conflict analysis on Accounting
applications one week and on Marketing applications the next week. When the IT group finishes work on the
Accounting applications, the “Accounting” Subscription would be disabled and the “Marketing” Subscription
would be enabled. By having multiple Subscriptions configured, local users can quickly switch between tasks.

On the Subscription Manager dialog box, Subscriptions that are enabled are preceded by a check mark (v),
while disabled Subscriptions are preceded by a red X (x).

E

Note - You use the Enable/Disable button on the Subscription Manager dialog box to set the status of each
Subscription to be either Enabled or Disabled. When you disable a Subscription, you are turning off its automatic
update feature. Since Subscriptions are updated automatically, and since all of the currently active Subscription's
data is replaced when a Subscription is updated, if you have multiple Subscriptions, it is to your advantage to
disable all except the one you are currently using. This allows you to work on one set of data and control when that
data is changed. If you have more than one Subscription enabled at a time, when the second enabled Subscription
is automatically updated at its scheduled time, it will replace the data of the Subscription you were currently using.

Overriding the Scheduled Update Day and Time

If you want to manually update either Publication data or Subscription data before its scheduled update time, you
can use the Run button on the Subscription Manager and Publication Manager dialog boxes. Using the Run button
forces the selected Publication or Subscription to refresh itself.

Replicating Application Catalogs in Controlled SQL Database Environments

Some companies that have a controlled SQL database environment prefer to have their database administrators
make major changes to their databases. In this case, you could select the Generate publication as script option on
the Publication Summary Panel of the Publication Wizard or the Generate subscription as script option on the
Subscription Summary Panel of the Subscription Wizard so that the Wizard would generate an SQL script of the
code necessary to create this Publication or Subscription rather than actually create it.
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When this option is selected, the script is the only output of the Wizard and the new item is not listed on the
Publication Manager or Subscription Manager. The Database Administrator could then run this script to create the
Publication or Subscription.

To create Publications and Subscriptions using SQL Server Enterprise Manager, perform the following steps:

To create publications and subscriptions using SQL Server Enterprise Manager:

1. Use the Publication Wizard or Subscription Wizard to generate an SQL script by selecting the Generate
as script option on the Summary panel.

2. Copy the script to your server.

3. Open Query Analyzer.

4. Select the database you want to work with.

5. Open the script file that was generated, and examine the sp_addpubTication stored procedure to make sure

that the PreReplication.sql and PostReplication.sql scripts are accessible from the system running
Enterprise Manager. If they are not accessible, copy the scripts to an accessible location, and update the
sp_addpubTlication stored procedure with the revised path names.

6. Execute the script.
7. Return to SQL Server Enterprise Manager.

8. If you created a Publication, open the database that you just generated the publication for and publish it.

Creating and Managing Publications

282

A Publication describes a subset of a database that you want to copy to a specific location to make it available to
Subscribers. When a Publication is published, the data is copied to that accessible location. You create
Publications to meet the needs of your subscribers. The Publication can be a partial Application Catalog—perhaps
containing only 10 out of the 200 applications in your Application Catalog—or it can be an exact replica of your
Application Catalog.

This section describes how to create, edit, publish, and delete a Publication, and also how to set a Publication
schedule and edit a Publication access list. This section covers the following tasks:

e Managing Publications

e (Creating a New Publication

® Publishing a Publication

® Setting a Publication Schedule
e Editing a Publication

e Editing a Publication Access List

® Deleting a Publication

ADS-0950-UG00 AdminStudio 9.5 Us